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ALMOST EVERY DAY we read about money going
missing from some poor soul’s bank account. You can
bet that for every case you hear about, there are 10
more that stay unreported to the media. Then there
are those who are just too ashamed to admit that
they fell for an Internet scam, or a phishing attack.

I am reminded about my induction into the
world of cyber crime—a few years ago, a consign-
ment of books landed up at my doorstep, and
although I hadn’t ordered any, I was overjoyed to get
them. While I was still trying to figure out which
charitable friend had decided to buy me a carton of
expensive books, I received my credit card bill.
According to the statement, I had bought $4,000
worth of books from Amazon.com!

Several abusive calls to the credit card company
later, I realised that although I was a customer, I cer-
tainly wasn’t king! Apparently the fine print states
that outstanding bills of $4,000 void you of your right
to justice. I was told that I shouldn’t have accepted the
courier. Perhaps I shouldn’t have been naive enough to
think that one of my many friends could have sent me
books as a gift. Maybe I shouldn’t have accepted the
credit card from that pushy sales lady... perhaps it was
my fault for being born in the first place!

I ran from pillar to post, first lodging a police com-
plaint, then going through the ordeal of filling forms
in triplicate, and some in quadruplet. Finally, after
six months, my debt was wiped clean, and I returned
the books to Amazon. I was lucky that the hacker only
used my card to send stuff to me, and not himself—he
was probably just using my credit information to
hone his skills. how he got it, I still don’t know!

Then there was this time in early 2007 when I
received news that a leading Indian bank site was being
successfully phished. We quickly got to work, trying to
trace the owner of the phishing site. Two hours later,
we traced the owner of the site back to an ISP in Czecho-
slovakia, and promptly informed the Delhi Police - Eco-
nomics and Offences Wing. We also informed the
bank, and the offensive site was closed for good.

Although the bank’s servers themselves were not
compromised, just by creating a look-alike site and

a very similar domain name, the phisher was able to
get hundreds of customer login details. We were
assured that no money was lost, and that the
phisher was probably using the Indian bank as a
guinea pig, training for a much fatter international
bank. The bottom line is that we, the customer, need
to make sure we don’t fall for phishing, pharming
and other social-hacks.

Awareness is the need of the day, and I should
say that it’s heartening that most Indian banks reg-
ularly send out warnings to all their customers, and
are trying to educate them. However, we need to
realise that using technology (like driving), is a priv-
ilege, not a right. And the only casualty is always
going to be you! 

editor@thinkdigit.com

Editorial

Sujay Nair Editorial Director

Dirty Rotten
Scoundrels!

“I realised that although I was a
customer, I certainly wasn’t king!”
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3 Incredibly Useful Sites
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Learn more about 3 really helpful Web sites where you can—hold
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educational media online
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Read more to know of exciting graphic
cards, hard drives, PCs and PMPs
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drives, motherboards, PCs, PMPs
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FREE
An Untitled Story

An Untitled Story gives you a
massive Knytt-like world where the
exploration of those games are
mixed in with the platform jumping
madness of Jumper! 

Blip And Blop

Blip and Blop is a great 2D shooter
game. Along your adventure you will
come accross some weird creatures
you will have to kill, as well as some
creatures that resemble other well
known characters. There are six
weapons available, from a simple
shotgun to some hi tech weaponry.

MapleStory
MapleStory is an entire online world
of games all bundled into one. Each
scene of this game features very
appealing, picturesque 2D graphics. 

DEMOS
Hard to Be a God
Hard to Be a God
is a 3D RPG
medieval story
with active
combat system,
weapons, and
more.

MOVIES
Sweeney
Todd: The
Demon
Barber of
Fleet Street
(1936)
A Fleet Street
barber recounts
the story of
Sweeney Todd, a notorious barber
who in the last century murdered
many customers for their money.

The Gorilla (1939)

When a wealthy man is threatened
by a killer known as The Gorilla, he
hires the Ritz Brothers to
investigate. A real escaped gorilla
shows up at the mansion just as the
investigators arrive.

MUSIC
The Jazz Farm by
Oprachina

■ Nangilima by Doc
■ Religionnaire I by Religionnaire
■ Tanz der Lemons by ieatpants

PERSONAL
Total Commander
Ultima Prime

This is an extended version
of Total Commander 7 by
Christian Ghisler. It
contains extended main
menu and toolbar, other
programs, numerous
plugins, changed layout
and other elements.

Insight Contact
Management Pro 
Track prospects and keep
history of activity using
this customizable multi-
user program. Create e-
mail merges, labels,

envelopes, and reports.
List, sort, and search
contacts with any
combination of fields.
Perform SQL query to
create dynamic lists of
contacts. Each contact
has unlimited notes,
phone numbers, e-mail
addresses, and links.
■ Adobe Reader Lite 8.1.2
■ Word Finder 1.0

DEVELOPERS
Visual Studio 2008
Express Edition All-
in-One DVD
This DVD contains all the
Express products as well

as optional components in
a single image (ISO) file.

Stylus Studio 2008
XML Home Edition
Stylus Studio 2008 XML
Home Edition is an XML
tool for experts to new
comers who work with

XML in a non-
commercial setting. It's a
must-have XML tool for
anyone trying to learn
XML for the first time.
View and load large XML
files with ease.

MULTIMEDIA
Adobe After Effects CS3
Design vector graphics,
create more organic
movements, and
expedite delivery with
new integration and
collaboration features.

DAZ Studio 2
DAZ Studio is a
feature rich 3D
figure posing
and animation
tool that enables

users of any skill level to easily create
stunning digital imagery. Whether youre a
3D newbie or an avid 3D artist, you'll find
DAZ Studio is the perfect tool for designing
unique digital art and animation with
virtual people, animals, props, vehicles,
backgrounds and more. Experience total
creative freedom with DAZ Studio and
express yourself in 3D like never before.

Sweet Home 3D 1.2.1 (Linux)
Sweet Home 3D is an interior design Java
application for quickly choosing and

placing furniture
on a house 2D
plan drawn by
the end-user,
with a final 3D
preview.

■ aTunes
■ AutoMKV 0.95a
■ MediaTomb (Linux)
■ Photoshop CS3 Extended Plug-In for
Google 3D Warehouse
■ Corel Painter X
■ DigiRostrum 2.4
■ VJDirector 1.5.0115.0

INTERNET
Microsoft Internet Explorer 8
for XP Beta 1
Internet Explorer 8 takes the Web
experience beyond the page and
introduces a new way to seamlessly

experience the power of
the Web whether you are
a Web developer writing
to standards, or an end
user discovering a new
online service. This beta

release is available to everyone, but is
primarily for Web developers and
designers to test the new tools, layout
engine, and programming
enhancements.

■ Gogrok 1
■ Microsoft Internet Explorer 8 for Vista
8.0 Beta 1
■ WebcamMax 4.2.5.6

LINUX AND MORE
andLinux (KDE Version)

andLinux is a complete Ubuntu Linux
system running seamlessly in Windows
2000 based systems (2000, XP, 2003,
Vista; 32-bit versions only). 

FreeBSD 7.0
FreeBSD is an advanced operating
system for x86 compatible (including
Pentium and Athlon), amd64 compatible

(including Opteron,
Athlon64, and EM64T),
UltraSPARC, IA-64, PC-98
and ARM architectures. It
is derived from BSD, the
version of UNIX
developed at the University of California,
Berkeley. Burn the three ISO images to
CDs and boot from Disc 1 to install.

PCLinuxOS
PCLinuxOS is an English only live CD
initially based on Mandrake Linux that
runs entirely from a bootable CD. Data
on the CD is decompressed on the fly,
allowing up to 2GB of programs on one
CD including a complete X server, KDE
desktop, OpenOffice.org and many more
applications all ready to use. In addition
to the live CD, you can also install
PCLinuxOS to your hard drive with an
easy-to-use livecd-installer. Additional
applications can be added or removed
from your hard
drive using a
friendly apt-get
front end via
Synaptic.

Gaming

Contents Interactive
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Tools

Entertainment

MOVIE
OF THE
MONTH

“The Jazz Farm to me is an album of
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tradition with a lot of 70ies
influences”
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PERSONAL
MB Free Subliminal
Message Software 1.30

MB Free
Subliminal
Message
Software is a
free, useful and
advanced
subliminal

message-displaying program. This
software reaches out to the
subconscious mind and sends positive
affirmations to the mind, thus
helping you develop a positive
mindset.

U&I Information
Management System 3.1

U&I Information
Management
System is a
customisable
personalised
information

management system

■ Scientific Author 1
■ Power Tab Editor 1.7 build 80
■ Ro3n 4.1.1
■ VirtMus 1.03
■ WordFlashReader
■ Archivarius 3000 4.00
■ AutoIntern 2.0.122.0
■ ENUFF PC 8.03
■ e-Speaking Voice and Speech
Recognition 3.8.12
■ iCal4OL 2.3.1
■ LockXLS 3.5.1
■ NextUp Talker 1.019
■ Painless Schedule 2.0.29.103
■ Personal Numerologist 5.0.3
■ Rapid-Pi 2.01
■ Turbo Type 1.38.003

FREE
Phun

Phun is meant to be
a playground where
people can be
creative. It can also
be used as an

educational tool to learn about physics
concepts such as restitution and friction.

Karoshi
A short, but
puzzling platformer
where the object is
to kill yourself in
every level.

Nelly Cootalot: Spoonbeaks
Ahoy!
Beginning not unlike many adventure
games, a hero (Nelly) finds herself
cast on a quest which she knows little

about: It
seems only
one island is
inhabited by
the
Spoonbeaks

and suddenly they've all disappeared.
Through careful sleuthing, analysing
events and collecting of seemingly
random objects, Nelly attempts to
solve this mystery.

DEMOS
Snood
Snood is a fun
puzzle game that
tests your
intellect rather
than your
reflexes. The application has many
new features and a new Armageddon
level. There is also a play timer and a
panic button (to keep others from
knowing you're playing Snood). Your
goal is to free all the trapped Snoods
by launching other Snoods at them. If
you connect three or more Snoods,
they will disappear.

ESSENTIALS
■ .net Framework 2.0
■ µTorrent 1.7.7
■ Avast Home Edition 4.7
■ Avast Update
■ Comodo Firewall Pro 3
■ Digit Software Archive 2006 Beta
■ DirectX Redistributable 9.0c March
2008
■ Foxit Reader
■ Free Download Manager 2.5
■ Irfan View 4.10
■ Irfan View 4.10 Plugins
■ Java(TM) 2 Runtime
■ K-Lite Mega Codec Pack 3.8.0
■ Microsoft XNA Framework
Redistributable 1.0 Refresh
■ Opera 9.26
■ Silverlight
■ Spybot Search and Destroy 1.52
■ Spybot Search and Detection updates
■ VLC Player 0.8.6c
■ WinRAR 3.71

MULTIMEDIA
Guitar Studio 4.8

Guitar Studio is a
powerful tool set
for the musicians
playing guitar and
related intru-
ments. With Guitar

Studio you can easily improve your playing
skills, edit tablatures and play audio and
video files.

Andrea AudioCommander
5.0.32.3

AudioCommander is an
audio mixer program
similar in functionality
to the system Volume
Control program. Using
the system Volume
Control to adjust the set-

tings necessary to make a microphone can
be very confusing. This application also
makes it easy to get the right settings for
the microphone.

Free Audio Editor

Free Audio Editor, as the title foretells, is a
multi featured audio file editing applica-
tion. You can use it for audio file recording
and conversion, file mixing, text to speech
conversion and so on.

■ AV MP3 Player - Morpher 4.0.61
■ CineGobs Keyer 1.6.0.7
■ Noiseware Community Edition
Standalone 2.6
■ The KMPlayer 2.9.3.1430 beta
■ AutoQ3D Standard 3
■ H264 WebCam 2.28

■ MorphBuster 8.6
■ Organ 3.0.2
■ Plato DVD Copy 7.81

SYSTEM
Ashampoo® UnInstaller
Platinum 2

Free for Digit readers!
The Ashampoo UnInstaller
series has always been
the best and simplest way
to keep your computer
free of old program
garbage. Now it's better
than ever, with a whole

range of powerful new functions, a slick
new user interface and context-sensi-
tive help that gives you the answers
you need fast.

USB Over Network 3.3.8
USB devices other
than printers are
difficult to share
over a network.
USB Over Network
is a revolutionary
software solution

from FabulaTech. No need to move devices
from one computer to another,  and no
need  to buy expensive hardware switches.
You can access any USB device connected
to a remote computer from your computer
via a LAN or the Internet as if it were phys-
ically plugged into your own PC.

Image for Windows 2.06
Image for
Windows is an
affordable and
reliable drive
image backup and
restore utility that

you can use to create a backup of all
your hard drive data to other media or
external drives (such as USB or 1394)
and easily perform a bare-metal
restore for efficient disaster recovery.

■ Cobian Backup 9.0.0.149 Beta
■ Crash Pickup 2.18
■ DMEXBar 12
■ Limagito Lite 6.34
■ Local Cooling 2.0
■ LogonStudio 1.01
■ Napalm 1.0
■ ProcessScanner 1.1
■ Video Card Stability Test 1.0.0.3
■ 007 DVD Maker 3.84
■ Aarons Advanced Cliker 3.04
■ iFreeMem 2.5 (Mac OS X)

INTERNET
ALToolbar v1.13

More than a
toolbar
gadget,
ALToolbar is
a real appli-

cation to help you surf the web faster,
safer, and easier

Tools

Productivity Gaming

GAME DEMO
Spandex Force
Spandex Force is a puzzle / RPG /
adventure game that lets the player
create his or her own hero to clean
up Vigilance Valley. The game
features many different kinds of
puzzles, including match-3 battles in
which common crooks and wacky
supervillains must be defeated. 

Featured



Digit Reader Poll

By Demand
You get to choose what goes
on Digit Interactive. This
month, you chose:

Adobe After Effects CS3
Size: 837 MB

Visual Studio 2008
Express Edition
Size: 894 MB

taste technology at www.thinkdigit.com

This Month’s Question                                                 Vote at www.thinkdigit.com

Which feature of newer cellphones appeal to you the most?

Large screens or Touch function
Good music quality and storage capacity
Video playback
Digicam-quality cameras

Subscribe
No more snail-mail! No need to visit
post offices! All you have to do is log
on to www.thinkdigit.com/subscribe
and use your Credit Card to make
sure you never miss another issue of
your favourite magazine!

How processors go from
idea to your PC
(Log on to
www.thinkdigit.com)

Web Special
Under The DIE 

Last Month’s Question

Online

FEATURED REVIEW FROM THE DIGIT FORUM ((wwwwww..tthhiinnkkddiiggiitt..ccoomm//ffoorruumm))
This month we feature a member review from the forum.

So, finally, after giving it a lot of thought, I decided to
go for the EEE PC.
As the black one didn’t appeal much to me, I went for
the Pearl White one. 
It looks damn cool and sleek.
After getting it, I was waiting to reach home and start
some RnD on it. Got it for 16.7k in Mumbai.

Specs
Model Name—Eee PC 4G 
Price (INR)—16,700
Memory (RAM) 512 MB (DDR2 SO-DIMM)
Solid-State Drive—4 GB (soldered)
Built-in Webcam-VGA (640×480) @ 30 fps 
Battery—4 Cells: 5200 mAh, 3~3.5hrs* 
Storage Expansion—External MMC(plus)/SD(HC) slot 
Display—7”; WVGA (800×480) @ 133.3 PPI 
CPU—900 MHz Intel Celeron M ULV 353 @ 630 MHz 
Operating System—Custom Linux OS (Xandros
Wired Networking—10/100 Mbps Ethernet 
Wireless Networking—802.11b/g Wi-Fi (PCIe) 

Internal Modem—External RJ-11 connector present
but internal MDC board not populated 
USB Ports—3 external
External Display—VGA D-SUB (up to 1600×1280) 
Audio—High Definition Audio with built-in stereo
speakers and built-in microphone 
...

PROS:
Very Portable
Cheapest Functional Laptop
Shock-Resistant
Sleek and Sexy

CONS:
4GB SSD Size
630mhz proccy 

For more visit:
http://www.thinkdigit.com/forum/showthread.
php?t=83185

21-03-2008, 
01:54 PM

Pathik
Google Bot

Join Date: Aug
2005
Posts: 8,061

AAssuuss EEEEEE PPCC RReevviieeww

What Web applications do you use most besides mail and chat?

File
Storage

18.58%

Massively
Multiplayer

Online
Games

8.79%

Blogging,
wikis,

discussion
forums

36.88%

Multimedia
streaming
streaming
(Video and
audio)
35.74%
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offering the PCs based on
the open source Linux
operating system together
with Red Hat software
distributor VDEL of Austria,
and Polish distributor and
services firm LX Polska in
response to demand from
Russian IT chiefs. Russia,
with rapid infrastructure
growth has many large
corporations and public-
service organisations that
are now in the process of
building large computer
systems, and is fast
emerging as a key
battleground between
Microsoft and rivals offering
open-source alternatives. 

IBM, which had earlier
sold its PC business to
China’s Lenovo, said that
partners of VDEL and LX
Polska would make the
hardware for the PCs. IBM
said the Linux PC line
christened ‘Open Referent’
that it would offer with
these partners, would cut
desktop computing costs by
nearly half for buyers. It
said CIOs from Russian
organisations, including the
Ministry of Defence, airline
Aeroflot and the private
Alfa Bank, among several
others, have requested an
open-source PC.

In this Microsoft
dominant market, every

other company seems to
come up with an
alternative to Microsoft’s
products. Initially, it was
Google with their online
office suite, then the Open
source movement. Now,
PCs already coming pre-
loaded with Linux seem to
be yet another blow 
for Microsoft.

GLOBAL OUTSOURCING

India Losing
Its Offshoring
Advantage

According to the
latest analysis of the
Indian labour

market by Pierre Audoin
Consultants (PAC), out of
the 21 centres opened
since January 2007 by the
20 largest UK companies,
only two were in India,
while four were in China,
three in Eastern Europe
and Morocco, respectively.
Nick Mayes, senior
consultant at PAC said that
in the short term, there
was no “serious threat” to
India’s outsourcing
dominance. However, he
added that companies are
on the verge of reducing
their dependence on

“India’s heated labour
market”.

China’s emergence as a
global sourcing hub has
traditionally been slow but
the report found that BT
Global Services, EDS, IBM
and Tata Consultancy
Services (TCS) have all
started sourcing facilities
in the country over the
past 18 months.

The two facilities
launched in India were both
outside the traditional

Quad-core Goes
Affordable
You’ve got to
hand it to Intel
for this: we’d
never have

thought that we could have
four whole cores on our
desktops, and still have
money left over to buy food
and clothes!

So?
Precisely. Unless
you use 3D or
math-intensive
applications a lot,
chances are you’re
not going to be able to tell the
difference between two and
four cores. Even games have
been slow to exploit all that
extra processing power, but
hey, at least they’ve started.
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Corel’s setting up shop in India,
and we caught up with Gavin
Watson to talk about Corel’s
plans for our fabled land

What do you aim to accomplish
with your presence in India?
Firstly, and most importantly, we
intend to create awareness
about Corel and our product
line-up. In addition, we aim to
strengthen our software
distribution channel to give
potential customers greater
access to our products. We also
have a number of non-compliant
users (read pirates) of Corel
software here—we want to
convert them into compliant
users too. 

How do you plan on doing that?
Throw them all in jail! (laughs)
But on a serious note, we want
to do so with awareness. We
plan on getting people exposed
to, and learn our software
through training institutes, and
once they start earning from
their training, we hope they’ll
invest in the software for their
professional use. 

Have you tied up with anyone
to provide education?
Yes, we have tied up with a
number of training centres to
provide courses on Corel
software. In addition, some
state governments have added
CorelDRAW to their syllabi as
well. Finally, there’s the Corel
Academy in Chennai, which will
train students in our software. 

How will Corel Users in India
avail of software support?
The first line of support will be
your reseller, followed by Corel
Sales and online support. We
also have a tech support centre
in Manila. Finally, there’s the
CorelDRAW community, which
has a number of active Indian
users. Increasingly, we’re finding
that more people are turning to
the community for solutions to
their problems. Users identify
with each other, and solutions
sometimes come faster than
even tech support!

Mozilla CEO Cries Over Apple Auto-update
John Lilly, CEO of Mozilla says Apple’s latest decision to
bundle their Safari browser with Apple auto-update is
unethical. Lilly claims this move causes the customer to
download software unawares. His opinions are met with
mixed reactions throughout the industry.

Glasses For The Absent-minded
Japanese researchers at the Tokyo University
School of Information Science have developed
glasses fitted with a camera. Aimed at amnesiacs,
the camera scans the regions you view as you
travel around, and help you get to the place later.

Of late, Thai officials
have been urging
Buddhist monks to

avoid using social
networking sites to woo
women. This comes after a
social advocacy group found
this to be the best past time
for many Buddhist monks.
All the hype around this
story comes on the heels of
alleged rape allegations by a
teenager from north-eastern
Thailand. The police have
since arrested a 23-year-old
monk. It is alleged that the
monk befriended the
teenager on Hi5 and then
lured her to meet him in
his room, where he
apparently tried to rape her.

Jakrapob Penkair, a
junior minister, in an
official statement urged Hi5

users to tell the monks to
leave the site if they were
using it. It seems that
Thailand, known for high
rate of prostitution, intends
to improve its image
internationally. In fact,
reports of monks being
caught either using or
selling drugs or even having
consensual sex with women
are not met with surprise in
the Thai media.

A senior Culture
Ministry official, however,
said monks should not be
banned from cyberspace.
Nevertheless, he added that
the monks should consider
these moments of “crisis”,
and rather spread the
teachings of Buddha to the
young. Ladda
Thangsupachai, head of the

Cultural Surveillance
Centre, said, “Instead of
using the Net to flirt with
young girls, monks should
find ways to preach
Dharma and lead them in
the right direction.”

After all, it is generally
said, everything has a plus
and minus factor attached
to it. Some use social
networking for constructive
purposes, while there are
some that use it wrongfully.
Either way, policing and
moderation is needed at
times to maintain the
balance. 

I BEAT M

IBM, Allies
Offer
Microsoft-
free PCs For
Eastern
Europe

It has been reported that
IBM has partnered with
companies in Austria and

Poland to offer Microsoft-
free PCs for the eastern
European market. According
to an official IBM statement,
the PCs will include IBM’s
Lotus Symphony software
based on the Open
Document Format, which is
a rival to Microsoft’s Office
Open XML. In recent times,
Microsoft has been trying to
push for Open XML as an
internationally approved
standard. IBM Corp said in
its statement that it was

Enter

Security Watch

FALLEN ANGEL

Thai Monks Told To Stick To Monking

15
n Mash Maker, a mashup creation tool launched by Intel n Sony tries to charge $50 for removal of bloatware, retracts fee after massive protests n n Cuba lifts ban on sale of computers, DVD players, 20 inch TVs n Microsoft chops Vista retail prices n 

Gavin Watson
Director—Asia Pacific, Corel

MS Excel
Vulnerabilities
The Problem
After studying reported
problems, Microsoft has
admitted that a vulnerability in
MS Excel could allow remote
execution of harmful code. As
per the official release by
Microsoft, an attacker could
take complete control of a
system by successfully
exploiting these vulnerabilities,
through a specially crafted Excel
sheet. Once, the attacker
manages to send the corrupted
file to the intended prey, he /
she can install programs, create
new accounts with full user
rights or even view or modify
data on the system. This
security update is labelled as
Critical for Microsoft Office
Excel 2000 SP 3 and rated
Important for subsequent
versions of Excel.

The Solution
Patches specific to the version
of MS Excel are available on
Microsoft’s Web site. Go to
http://www.microsoft.com/tec
hnet/security/bulletin/ms08-
014.mspx and download the
patch available according to
the MS Excel version you are
using. If you do not find your
version, chances are that you
are not affected.

Which feature of newer cellphones appeal to you the most
(You, too, can participate in this poll—at www.thinkdigit.com)

Large screens or Touch function Good music quality and storage capacity

Video playback Digicam quality camerasDC

BA

(You, too, can participate in this poll—at www.thinkdigit.com)

Opinion Poll

I love music and have a huge collection
in my PC. Phones should have greater
storage capacity so one can
store as many high quality
songs and videos possible.
And also better quality of
music is absolutely necessary.

Shoban Kumar
Thiruvananthapuram

(b) Good music quality and storage
capacity. A cell phone is supposed to be
multi-functional. Prevent the
need to carry multiple gadg-
ets. My cell phone should
play music all day long with
large memory.

Ashish Rohilla (Keith)

New Delhi

(d) All the above options are already avail-
able in the market, at cheap rates. So giv-
ing customers a camera with
digicam resolutions is an nice
option to get rid of carrying
digi or handycams, which is
too hard to handle. 
Milan P. Chouhan
Baroda

I’d go for option A large screens or
touch function. Reason—Large screen
and touch functions are of
great help when I am on the
move as I can check email,
browse Web sites and do
everything a business phone
can in a better way. 
Dinkar Mohana Pai
Kochi

I choose D—Digicam quality cameras. I pre-
fer digicam quality cameras, avoiding the
need for digital cameras or
video camera with a mobile.
Hence one phone serves both
the purpose, for communica-
tion and digital imaging.
Channabasanna S
Bengaluru

Users upgrade their phones often and
rather want a device offering the maxi-
mum. My next phone should
have at least 16M colour, GPS,
WiFi, Expandable Memory, 3rd
party applications and excellent
image capturing with crisp and
DVD quality Video capturing.
Yash Maheshwari
Pune
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Photograph Lakshmi Sudheendra Each month Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 20th of this month.

Digit Caption

Herbie goes the green
computing way

been illegally using her
patents without paying her
any royalty. All total 34
companies, including Sony,
Samsung, Nokia, LG,
Motorola, Sharp, Hitachi,
Sanyo, Sony Ericsson and
Toshiba have been named
as violators.

ITC is responsible for
safeguarding US industries
against dumping of goods
and takes action against
unfair trade practices like
patent, trademark and
copyright violations. This
means that if ITC finds merit
in Rothschild’s case it can
theoretically block the
imports of mobile phones,
cameras, camcorders etc to
the US. We rather think that
it won’t deprive the
American masses of their
daily dose, but they might
impose a steep fine on all
these entities.

This is not the first
time the professor has
tangled with Big Business.
Earlier she had sued Philips
and obtained an out of
court settlement over this
patent. This means that she
has built up a pretty
bulletproof case and is not

to be taken lightly. The 34
respondents must have
already got the message
and are presumably
brainstorming with their
legal teams. 

WATCH YOUR PATH

Kerala
Mapped

Recently in Kerala, the
first Active Web
Geographical

Information System (GIS)
service was launched for
public use by the Indian
Institute of Information
Technology and
Management—Kerala.
Developed using free and
open source software (FOSS)
technology, a simplified
version of dynamic
geographical information is
made available to the public. 

Log on to www.edugrid.
ac.in/webgis, to check out this
service. So instead of
watching the sky, the users
can surf online and find out
the forecast for a week in
advance. Why would one
need an expensive software

or tool when the geospatial
information is available on
Web browsers? Yes, dynamic
weather information and
one-week forecast gets
updated every three hours.

The available geospatial
information could be
utilised across several
dimensions—from
agricultural wellbeing to e-
governance projects. Also,
thematic maps provide
significant information.  

As per IIITM-K director
K.R. Srivathsan, “The
institute is actively
developing Active Web GIS
applications for e-
governance applications
such as community
instrumentation for
agrarian prosperity,
community-driven cultural
heritage portals and trade
logistics for farm produce”.
The geospatial information
is supposed to benefit many
dimensions of the state-
right from urban planning
to business.

Weather information
about the mapped cities /
villages of Kerala is
integrated with Google
Maps. Along with the

thematic maps of Kerala,
the 3D model topography
has been developed using
VRML (Virtual Reality Mark-
up Language) for the 3D
Web GIS.

Besides mapping the
state on Google maps and
syncing weather information
and presenting thematic
maps for Kerala, people
would surely be expecting a
lot more to come. The
toughest part is providing
dynamically variable
forecasting data along with
the dynamic geospatial data
actively available on the Web
browser. However, counting
the efforts of the free and
open mapping centric Free
Map community, this
initiative surely has a long
way to go. Kudos to the IIITM-
K team for Active Web GIS!

SYSTEM FAILURE

Hackermania

Indian government Web
sites are under attack.
This has prompted the

Department of Information
Technology to draw plans
for better security

Last Month’s Winner!
Akash Talukdar, Kolkata 
“The web has finally replaced
my hard drives”

E-mail your caption with the
subject “Beat That”, and your
postal address, to
beatthat@thinkdigit.com
and win 

Google Power
Tools Bible
by Corey Sandler

Published by
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hotspots of Bangalore and
Mumbai-IBM’s new centre is
in Noida and TCS’
expansion site in
Hyderabad. Among the
companies that were
analysed were Accenture, BT
Global Services, Capgemini,
Capita, CSC, EDS, Fujitsu,
HP, IBM and Logica.

As salaries of the Indian
workforce increase, it seems
obvious for the western
companies to look for
options that provide reduced
costs. With an efficient
English speaking workforce,
Europe seems to be a hot
destination. Similarly, close
proximity also enhances
their say in the outsourcing
industry. In fact, the
emergence of increased
outsourcing to China will be
closely watched by the
Indian industry for sure.

VIRTUAL BEHAVIOUR

World Of
Crime

Some months ago we
mentioned World of
Warcraft, a MMORPG

being used to study how

diseases can spread in the
real world. Turns out that
there are more lessons to
be learnt from studying the
role playing game universe
that are applicable in real
life. One of them is how
terror works, especially
terror cells and the
dynamics of crimes.

If you have ever played
WoW or heard about it you
would know that it has a
mind bogglingly diverse
set of characters with
varied powers and
capabilities. The players
mimic real life behaviour,
both good and bad. The
bad side includes crime
and terrorism, including
bio-terrorism. Now,
researchers have zeroed in
on this specific trait and
have found that studying
the in-game behavior can
tell them a lot about how
bad guys can operate in
real life. In fact, the
insights gleaned are much
more significant then
those from AI simulations
or mathematical
modeling, the traditional
tools of choice for analysts
when studying
phenomena like the

possible spread of diseases
like anthrax, or the
probability of suicide
bombers attacking a
particular place. 

The crowd behavior,
approximating real life
after an act of terrorism
can also be predicted by
observing, for example,
what surviving characters
do after an explosion in a
crowded area.   

Some researchers
however believe that WoW
needn’t be taken too
seriously by spooks. This is
because dying in the game
is no big deal and you can
easily take another new
avatar or simply return
after a specific period of
time. Obviously that’s not
going to happen in real life
and so players tend to take
more unrealistic risks.
However for all its flaws
WoW is the closest
researchers have got to real
life conditions that can be
controlled and they are
not letting it go unstudied
any time soon. Oh, and
they also get the chance to
mix business with
pleasure, which is another
added bonus.

NO MORE LIGHT

Suing All The
Way

Light emitting and laser
diodes are used in a
large number of

consumer electronics
products from the new
fangled Blu-ray drives to the
humble CD-ROM drives.
They are also used in
mobile phones and hand
held devices, and even in
traffic lights. Companies
have been making this stuff
for years and have been
reasonably clear that all
intellectual property related
issues have been ironed out.
In other words they don’t
expect someone to pop out
and claim royalties.

So this has come as a
shock to many companies
when the news of a patent
infringement lawsuit filed by
a retired professor of
Columbia University came
through. Gertrude Neumark
Rothschild, in her complaint
which has been accepted by
the US International Trade
Commission says that a
busload of companies have

A Round-up Of Technology News From Across The GlobeThe Digital World

n DVB-H Technology is now official Mobile Standard n India votes against OOXML, with dissenting votes from NASSCOM n Microsoft officially launches Windows Server 2008 n Emirates is first airline to allow mobile calls in flight

THAILAND
Thailand’s Loxley PCL, one
of the 12 companies hired
to develop the nation’s
WiMax network, has
partnered with Nortel to
complete the project

JAPAN
Japanese ISPs have
planned to cut off Internet
connections of users who
download files illegally, in
what is regarded as the
world’s toughest drive
against piracy

FRANCE
France won the approval of the EU to
grant $152 million to several
companies aiming to build a European
rival to the US search giant Google Inc

SWITZERLAND
Swiss researchers have
tested a high speed WLAN
network, claiming speeds
up to 216 Mbps with a
single antenna per station

SYRIA 
Syrian authorities are
revamping their ‘iron
censorship’ over the
Internet, and have strictly
ordered café users to
reveal their identity

CHINA
Chinese authorities have succeeded
in blocking news about Tibetan
protesters. Although not new, this
time effective blocking of You Tube
and blogs were noteworthy
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Quick Path
What is it?
Quick Path, also known as
Common System Interface is a
point-to-point processor
interconnect which is
intended to replace the Front
Side Bus used in traditional
processor architecture. It has
high bandwidth and extremely
low latencies. Like TCP/IP it is
a combination of five layers:
physical, link, routing,
transport and protocol (in
ascending order). Each of
these layers have different
responsibilities and some of
them may be omitted in less
complex systems. 

Who is developing it? 
Intel is developing this
technology as a rival to
HyperTransport, another point-
to-point interface used for long
by many manufacturers in
chipsets, routers, processors
and servers. 

Why is it needed?
With the dominance of multi-
core systems the need for
faster data transfers between
different cores are needed so
that performance is not
bottlenecked. In particular,
processors with four or more
cores need more bandwidth
than the FSB can handle. 

When is it going to debut?
Quick Path is going to debut
in the second half of 2008. 

Where will it be implemented?
It is going to be implemented on
Xeon and Itanium platforms and
will be first used by Nehalem
and Tukwila processors. Quick
Path is highly scalable and is
designed for laptops as well as
server farms.  

How will performance
change?
With 4.8 to 6.4 Gigatransfers
per second and bus widths of
up to 20 bits, the theoretical
bandwidth is 24—32 Gbps per
bus. These high speeds are
needed in mission critical
applications and eventually be
faster than HyperTransport
machines  technology. 

people who purchased the
board game after playing it
online. Slowly realising the
online potential, Hasbro
announced that it would
come up with an online
version of Scrabble with
Electronic Arts soon. Seems
to us that Hasbro changed
its tune pretty quick when
it saw a potential business
opportunity.

SMART VISION

TV View

It has finally happened.
All this while—since the
time John Logie Baird

invented television—it has
been one-way traffic.
People watch TV. They do
have the option to change
channels or even switch
the tube off. But they can’t
do anything apart from
that. Now Comcast is in the
process of testing new
technologies which it
hopes will take care of the
common ‘there-is-nothing-
good-on-the-TV-today’
complaint.

In an informal talk a
senior Comcast executive
(the firm is also a big ISP in
North America) has mooted
using cameras in set top
boxes. These cameras
would use smart
technology to recognize
who is sitting on the couch
based on body forms. There
is no face recognition
feature suggested as of
now, which means that
people don’t need to have a
picture of their face in the
system. It will be used to
provide contextual
advertisements, as well as
shows based on past
preferences. Also, if a

family is watching a show
and there are any
inappropriate scenes that
require parental controls
the system will
automatically censor them. 

This system, however,
has plenty of scope for
misuse. Many people won’t
necessarily want a camera
looking into their living
rooms, which would easily
be construed as invasion of
privacy. Combine this with
the fact that Comcast has a
history of unscrupulous
business tactics like
surreptitiously blocking
selected traffic like torrent
downloads, and we are
pretty sure this will get the
thumbs down. That said,
under proper regulations
and monitoring by a
responsible body, this
system could be a pretty
useful tool, especially when
parents worry about kids
watching FTV on the sly.

GOOGLE LENDS A HAND

Eradicate
Polio

Remember those
public service
announcements

about polio on television?
While polio outbreaks
were frequent across India,
thanks to the electronic
media, a wave of awareness
about polio eradication
had permeated to every
corner of the country.
Now, to give it a further
push, Google Foundation
has donated $3.5 million
to Rotary International
towards eradicating polio
from India and the rest of
the world.

Monetary contribution
from IT giants like Google,
Microsoft and Intel among
many others can be termed
as part of their Corporate
Social Responsibility. For
instance, Google has been
pushing green computing
actively for conservation of
environment. While this
not for profit step by
Google Foundation is one
of their initiatives besides
the investments in
development of SME sector
that will help India.

Deepak Kapur,
Chairman of the India
National PolioPlus
Committee of Rotary, said,
“The polio battle in India
today is just short of the
finishing line, and the
much needed funds
supported by Google.org will
further boost the campaign
in India and the world to
eradicate polio forever.”
Like India, three other
polio-endemic counties-
Pakistan, Afghanistan and
Nigeria will benefit from
this funding.

Rotary’s philanthropy
aims to reach most
challenging destinations
on earth. As part of this
initiative, India has
received Rs 3.12 billion
grant so far. India has had
the most polio outbreaks
with about 60 per cent of
the global polio cases. In
2007, 844 polio cases were
recorded as compared to
676 in the previous year. 

But from them any
innovative way to raise
funds would be something
really appreciative. For
instance, it would be nice
to see if Google came out
with any innovative ‘Help
for Polio eradication’
campaigns. Like signing up
for using Google’s online
services where Google will
pay the beneficiaries
certain share depending
upon usage. That would be
totally different than mere
clicking on Ads and
banners. While the drive to
eradicate polio from India
is about to conclude, this
push will help it to finish
it earlier.
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measures, including
relocating servers where
the sites are present to
Indian territory.

According to statistics
released by the
government, the past few
months have seen a rash of
attacks against Web sites of
bodies like the Telecom
Regulatory Authority of
India, Indian Railways,
Department of Telecom,
Air Cargo Customs and
National Institute of Social
Defence. These attackers
used several tactics to
compromise the sites.
Phishing seemed to be a
hot favourite, followed by

unauthorized scanning
and virus injection.
Defacing was also one of
the most used tactics with
attackers defacing the Web
site of even the
Department of Information
Technology, the nodal body
which is in charge of cyber
security. Talk about
guarding the guards. 

The Home Ministry has
sounded out the alert after
these hacking incidents and
has suggested that all
government sites be hosted
on Central or State
government servers. This is
because most if the affected
sites have been hosted

offshore on privately owned
servers. That means that
these servers, hosting
sensitive information
sometimes related to
national security are not
within the jurisdiction of
Indian authorities. The
MHA wants all the sites
moved to servers hosted by
the National Informatics
Centre (NIC) or Education
and Research Network
(ERNET). To prevent these
attacks from occurring
again, a DIT body, the
Indian Computer
Emergency Response Team
(CERT-IN), is installing tools
like a network flow based
threat assessment solution
and attack detection
system. Additionally it has
drafted a set of guidelines
involving issues related to
network security and
architecture, firewalls,
intrusion detection
systems, secure coding
practices, etc., for securing
Web sites in the future.   

LET’S PLAY ENGLISH

Word Me
Perfect

People are already
obsessed with social
networking and

instant messaging. Aren’t
they? Whether at college or
work, these both remain
the headaches of IT
departments. Recent
obsession is Scrabulous—the
word game which has hit
the systems of several users.
The cyborgs of this viral
fever spread through social
networking site Facebook’s

group and now Scrabulous
has become the top pass-
time activity of millions. 

Scrabulous, a popular
Facebook app, was pleaded
to shutdown because the toy
maker giant Hasbro found it
very similar to their board
game Scrabble. Due to its
similarity, the app was
already popular and this
piece news triggered the
traffic on Facebook. 

People looked upon
Hasbro’s allegations as a
jealous stupid kid. Hasbro
sent notice to Facebook to
shutdown and remove the
app. The users even warned
of going on hunger strike if
Facebook removed
Scrabulous from apps after
Hasbro’s demands. To save
it, they even started a
group—Save Scrabulous. Made
by two Indian brothers for
sake of fun, today the site
has over 700,000 users
bringing the owners about
$25,000 per month as
advertising revenue. 

Being an online game
and several users across the
globe to compete with adds
tinge of excitement and also
creates a social platform.
Though some players are
involved in cheating (yeah,
even in this game), there’s
nothing much to w00t
about except personal glory. 

Playing Scrabulous may
help vocabulary
developments but also
wastes thousands of man
hours if played at office. 

The makers of Scrabble
believe that the online
version can and will affect
their sales. While on the
other hand, several
instances cropped up about

Move over quad cores, here’s the new hexacore
processor from Intel to steal your thunder. Intel has
announced that it will be launching a native six core
processor named Dunnington based on the Penryn
architecture later this year. Altough aimed at servers,
we suspect that the migration to desktops and maybe
even laptops won’t take long.

According to the technical specifications,
Dunnington uses a 45-nm die fabrication process. The
six cores between them share three 3M L2 caches and
a 16-MB Shared L3 cache. It also implements Quick

Path interconnects, an Intel patented point-to-point
data transfer interface replacing the traditional
slower Front Side Bus. Data transfer rates would be
25.6 Gbps. It also has an integrated memory
controller and supports DDR3-800 memory.

Simultaneous multithreading (SMT) is another
feature that is widely touted. SMT enables each core
to handle two threads at a time—speeds will see a
huge increase. Implementation of this feature in
Dunnington means that servers will be able to handle
more requests and speed up delivery of pages.

According to a
study by

MultiMedia
Intelligence, 50
per cent of all

phones shipped
worldwide will be

music-capable 
by 2011

IDC says there
is about 281
billion GBs

(281 exabytes;
or 45 GB per
person) on
earth in the

‘digital
universe’

In the US, broadband mobile
Internet connections jumped
to 2.16 million in the final
three months of 2007 as
compared to 854,000 in the
same period last year,
according to comScore

Gartner predicts 11 per cent
rise in worldwide PC
shipments compared to 2007
at 293 million units in 2008
due to emerging markets

n Google wants to fill in unused TV spectrum n BBC Web site unblocked in China after eight years n Best buy offers gift cards for HD-DVD customers      n Viral videos win at second You Tube  awards n Tata and Telsima to rollout world’s largest Wimax network n Gujarat villages connected by broadband n

Dunnington

X-force’s graph on Vulnerablities
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Special Feature

Now in its sixth year,
Microsoft’s Imagine Cup is
the world’s premier student

technology competition, and offers
students from all over the world the
opportunity to apply their
innovation, knowledge, and
technical abilities to make the world
a better place through technology,
and to develop applications that are
locally and globally relevant. Will
they come up with ideas to enable
healthier lives? Better education?
Like they say, it’s only limited by
your imagination…

The theme for Imagine Cup 2008
is “Imagine a world where
technology enables a sustainable
environment.” Over 185,000 students
from across the world are
participating in Imagine Cup 2008—
now also endorsed by the United
Nations Educational, Scientific and
Cultural Organization (UNESCO)—up
from around 100,000 a year ago. In
India, the Software Design National
Final for Imagine Cup 2008 will take
place in Bangalore on May 9th, 2008,
where teams will be judged by an
eminent panel comprising experts
from academia, the industry, and
the venture capital community. The
worldwide finals will be held in
Paris in the first half of July, with
the total prize-money going up to
$200,000 (Rs 80 lakh). 

In a unique first in India, top
teams from the Software Design
India Finals will participate in an
“Innovation Accelerator Program”
that will be run by the Centre for
Innovation, Incubation and
Entrepreneurship (CIIE), at the
Indian Institute of Management,
Ahmedabad (IIM-A). This two-week-
long incubation program will help
this next generation of software
developers harness their talent and
take their ideas a step further
towards commercial reality.

Given the various constraints that
potential entrepreneurs face in
taking their dreams to reality in
India, the Innovation Accelerator can
help teams move through the phases
of starting a business by helping
those who have an idea and intention
to start an enterprise, and move to
the second phase of recognising a
viable business concept. Those select
few will finally end up exchanging
with the market and contributing to
the local software ecosystem in India.
In order to help these students cross
the chasm and fructify their ideas,
Microsoft has set up a fund of
$10,000 for one team of students that
starts up its own company within a
stipulated time-frame.

Deepak Jagdish, twice-member of
the winning team at the Imagine
Cup India Software Design National

Final (2006 and 2007) offers his
thoughts on the life-changing
experience: “The Imagine Cup is a
one-of-a-kind opportunity for
students who are oriented towards
software and information
technology. The competition offers
teams a chance to take their
innovative ideas from conception all
the way through to implementation
(obviously, only if they are good
enough). I believe that, even though
we weren’t able to immediately take
our ideas to fruition, we were richer
for the experience, and that we have
a new perspective on what it takes to
get an idea up and running. I
remain steadfast in my belief that
the entire experience of
participating in The Imagine Cup
taught me things I would have never
learnt otherwise. I still harbour
thoughts of starting my own
software company based on the
solutions that we developed as part
of The Imagine Cup. After all, who
wouldn’t want to be part of the
incredible growth story in our
country today, especially that driven
by the local software ecosystem? And
what more fulfilling way to partake
of this phenomenal success than by
contributing one’s own innovation
and intellect? In my case, I know
that it is more a question of when
rather than if!”

Microsoft’s Imagine Cup
Helping The Software Economy In India Grow
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Nimish Chandiramani

Jamie King is like you—he raises a fearless finger to record
companies and movie studios, and goes on ahead with his file

sharing activities. He’s a writer, activist, and with the Steal This
Film movies, a filmmaker. Along with his contemporaries in the
League of Noble Peers (LoNP), he’s fighting to usher in a new era
of content creation and sharing. (If you haven’t watched Steal
This Film II on our February 2008 DVD, do so now)

Digit: What inspired you to make Steal This Film?
Jamie King: We knew that we had the opportunity to do
something amazing with P2P distribution. And we’d been

looking for a project to do it with for some time. We’d had
discussions about fiction features and about all sorts of other
things—but when the raid on The Pirate Bay happened we
knew that this was the right topic for a documentary. 

D: “We”, we presume, is the League of Noble Peers? How’d
that start?
JK: The League of Noble Peers didn’t really start. Rather, it
was a new name for something that had been going on for a
long time already. We needed a new name partly because we
were convinced that we’d be sued after STF I, and partly
because this was the first project we produced with this exact
configuration of people. LoNP is also meant to be something
that anyone can be part of—you don’t have to ask our permis-

Jamie King, director of Steal This Film I and II
on piracy, the little guy and “the future”

The

Noblest
Peer?
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Fuelling The Pursuit Of Technology Knowledge
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sion. Already we had a couple of people using
the name to do quite big projects. 

If you want to know about the etymology of
the name, of course it’s a pun on Peers. Peers in
the UK are Lords, and Lords are supposed to be
Noble (they might be noble for all I know, but I
only met one, and he was shouting at me). So the
idea is that there’s a kind of nobility in P2P, and
we try to convey this by being principled, in our
own way, in our work (though we do well under-
stand that our idea of “principled” and “noble”
might be very different from an Intellectual
Property (IP) lawyer’s). 

D: So when is file sharing noble, and when does
it violate your principles? 
JK: I don’t think we ever wrote the principles
down or even spoke about them, so it would be
difficult to say. I suppose the fact that technology
is fundamentally unprincipled is one of the key
things we are trying to get across. You can’t
really argue with the material consequences of
digitality and the network form. The nearest I
could get to a straight answer would be to say,
poisoning networks with fake copies is pretty
much a violation of our principles. But then, on
other occasions, fakes are fun. 

D: So in the world that Steal this Film wants to see,
what happens to the big media companies? Do
they exist? How do they make money?
JK: How they will make money doesn’t really
concern us as League of Noble Peers. Starting a
conversation about an historical change in
human communications with ‘how will the big
businesses make money?’ is silly. In a way, it can
be more interesting to ask, “how will the little
guy survive?”

D: But it’s these companies that fund the content
in a lot of cases, right? Giving money to “realise
the vision”?
JK: That’s (been) true, but it doesn’t follow that
big media companies are the only way to make
nice media. The cost of production equipment is
falling dramatically. The cost of post-production
equipment is falling just as much. Digital file
formats mean that it is possible to shoot and edit
very cheaply and, with cameras like the Red One,
at the quality of major studios. In effect, the only
question a creator has to ask themselves today is
if they have a good idea, a good script, good
actors, a good editor, and the drive to finish a
project.  In any case, those kinds of people—who
are really the future—know very well that big
business has nothing to do with them. 

D: Have you recovered your investment in Steal
This Film I and II? How far have you made it there?
JK: It depends how you define “recovered our
investment”. We don’t see an investment purely
as a financial business, nor ‘recovery’ the same
way you might ‘recover’ a debt from a miscreant
borrower. I think we have recouped our invest-
ment—financial and otherwise—many times over
in terms of the contribution we’ve been able to
make to culture. And it constantly upsets me the
way that artists are conditioned to think of their
work in purely financial terms.

D: Tell us about your alternative compensation
system—DISPS. 
JK: The new name for DISPS (Distributed Support-
ive Payment System) is VODO—for VOluntary
DOnations. We ditched “payment” for “dona-
tions” as payment has the wrong resonance; in
the struggle to find an acronym we warped the
concept a bit. 

One of the things we learned from the
thousands of people who donated to STF I and
2 is that, for any given project, there are going
to be some passionate supporters who want to
make voluntary donations, often well in excess
of what they’d have to pay in the traditional
mode. So we decided to hatch a project that
would make it really, really easy for people to
donate to others when they want to. In effect,
VODO sees the P2P distribution chain as the
natural home for media and therefore the
right place for artists to let their work into the
world, and it tries to create an infrastructure
through which they can be supported on the
back of their work. I can’t say a great deal
about how VODO works in detail, as we’re
prototyping it at the moment, but I can tell you
that it’s not a Web portal. And we’re looking
for collaborators—especially people with
expertise in digital fingerprinting who are
prepared to work under the GPL.

D: Will it integrate into our P2P programs?
JK: Yes. And we’re actively working with some
massive BitTorrent trackers and indexes and
discussing with others. You can guess names but
I have no official announcements at the
moment. It will integrate across the P2P chain,
right down to the player. Under VODO, you don’t
pay to watch works—the work connects you to a
creator, to whom you donate. The work becomes
(as it is) a mediator between one person and
another—whereas under proprietrary media the
work (as it were) grows legs and often walks away
from the creator! 

D: It’s a bit idealistic—counting on the goodness
of others—isn’t it?
JK: It’s a bit unrealistic to count on being able
to reverse a technology. I can’t say too much,
but VODO actually makes it pretty sensible for
you to donate to artists. And since everyone is
an artist now, everyone produces and copies,
it’s obvious that we are going to become more
sensible in our creative ecosystem. Mutual
support won’t look so ‘idealistic’ when many
people have become small creators, but we do
get that some people have trouble seeing
around the corner.

D: One of the solutions proposed for the ‘p2p
problem’ is to introduce a “piracy tax” in an ISP’s
fees that compensates for any losses caused by
file sharing. Your views?
JK: I think I can safely say that the League of
Noble Peers are, while broadly friendly with
the people who are behind this, against the so-
called ‘content flat rate’, and we share this
position with our friends at PiratByran. There
are a couple of good reasons: the main one is
that we shouldn’t necessarily have to pay

creators who have already received more than
enough ‘compensation’. I should be able to
give what I like to who I like, regardless if their
material happens to be on a disk of mine or
not. Disks are cheap—almost worthless. Band-
width is cheap. Downloading—moving content
from one place to another—is an everyday,
mundane act. To connect it to creativity, to the
question of value, to the survival of culture, is
ridiculous. More and more, the question of
what is on your 100 TB thumbdrive is going to
be unanswerable—”Uh, I think... all of EMI’s
back catalogue... and Hollywood movies from
the last 60 years?” (and you’d still have 20 TB
left over). So what, you’re going to pay a tax
for each copy present on this disk? We don’t
think so. We think this is just a temporary
band-aid for the big content industries. As
such, it’s not terribly important, it won’t work
for long, and we can look round the corner to
the future that will scare the others. The worst
that could be said about it is, it keeps people
thinking that there is some way that there
could be a ‘return to normalcy’ in media.
There cannot and will not be. 

D: Have you been to India?
JK: Yes, three times. Big fan. We think India is
the future. I think we’re not alone.

D: How do you see your vision taking shape here?
JK: It’s more like we look to Asia to find inspi-
ration. Two of the LoNP were telling me: one of
our favourite BitTorrent trackers (I think I can’t
name it as it’s private) is a place for sharing
rare movies. Anyway, some of the LoNP often
get movies from there and then screen them
in their Pirate Cinema, and at that Pirate
Cinema you can also download the movies
from a local drive and take them away (e.g.,
burn them). So then, a visitor from India had
taken away a whole bunch (around 500 titles)
and he had shared them with the local markets
for copied films—who had transcoded the
MPEG4s to MPEG2 (DVD), downloaded the art,
and re-created quite high quality DVDs of the
films and were selling them with literature in
Bangalore for around $ 0.70—so that suddenly,
the street market in Bangalore becomes a
distribution mechanism for art cinema,
Godard, Marker, etc., And films that ‘big busi-
ness’ doesn’t care about, which could never be
seen by Indian people in general, are available
in a street market. 

No one had realised this had happened. It
was only when the LoNP saw them they
realised—these had travelled all the way through
these various circuits to end up here. That seems
like the “future” to us. 

Me: Anything you’d like to say to our readers?
JK: Yes, I want to re-iterate that anyone with a
penchant for digital fingerprinting wanting to
get involved with VODO should get in touch
with me. And also, you can stop buying paper
now, it’s all over.
You can contact the League of Noble Peers at
peers@stealthisfilm.com

nimish.chandiramani@thinkdigit.com

For almost 10 years, you have
contributed to our success as a reader 

It’s time to take it to the next level... 

We’re looking for Writers,
Copy Editors and Test Centre

Reviewers, based in Navi Mumbai

Send your resume to
editor@thinkdigit.com

Remember to specify the post applied for in the subject line
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Ray Samuels Audio
Emmeline II “B-52”
While most of us wouldn’t spend more than a thousand bucks on a
decent set of headphones, there are some who wouldn’t spend
anything short of Rs 10,000 to start with. In fact, they’d spend much
more on a headphone amplifier and one on the wishlist has to be the
big daddy of all headphone amps—the Emmeline II from Ray Samuels
Audio, also nicknamed the B-52. There are two power supplies for each
channel—that’s how far they go to keep interference to a minimum.
This is a balanced headphone amp that can drive headphones will
impedance upto 600 Ohms! The price is said to be around $2,495 or 
Rs 1 Lakh. The B-52 is a bomber alright—for your wallet.

Raon Digital Everun
Weighing it at just under half a kilo, the Everun
manages to house in it a 4.8-inch 800 x 480
resolution touchscreen, a 60 GB hard drive and an
optional 6 GB solid state drive (SSD). A 567 MHz,
AMD-powered CPU is used on the higher-end model
and they all come with 512 MB of DDR RAM. The
Everun comes loaded with Windows XP Home.
Unlike your laptop which runs out of air in hours,
the Everun (on the larger battery) can run for close
to 12 hours, and 6 hours on the standard battery.
The Everun also comes with a complete QWERTY
keyboard. WiFi and Bluetooth are standard. Prices
for the lower-end model start from $800
(Rs 32,000) going all the way up to $1100
(Rs 44,000) for the higher-end models.
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Dreamcom 10
series
It clear by now we aren’t the only
ones impressed by the Transformers
movie. The Dreamcom 10 is like any
other laptop that blatantly uses the
term ergonomic in all their
promotional material—except
there’s one big difference here. The
Dreamcom 10’s screen can be raised
vertically out of its base where the
keyboard resides. The docking
station helps elevate the keyboard
to face you with some extreme
angles. All this means you can have
a laptop that literally shapes itself
into all kinds of configurations—
making it like a desktop at times,
and an ergonomically designed
laptop when you want it. There will
be 3 seperate flavours choose from—
Personal, Professional and Business.

Future Retro
Revolution
Synthesizer R2
This concept design from Future Retro—which
tries to be record player from outer space—is, in
fact, a synthesiser and sequencer that will make
any DJ go cuckoo. The synthesiser utilises analog
and digital effects for the processing. The DSP
does proper 24-bit stereo processing and the R2
can handle 256 unique recordable patterns. There
are loads of presets and effects as well such as
chorus, flange, rooms, halls, etc to generate the
authentic sound. If none of the above impress you
then surely the looks will! The price is pegged at
around $750 (Rs 30,000) when it comes.

Vision One
Computer
Desk
Yes, this is in fact some furniture
that will lure geeks. Sure it
doesn’t have a built in toilet-seat
attached to it, so what? Prices for
the V1 Computer Desk starts from
around $1700 (Rs 68,000) and go
up to $2600 (Rs 1,04,000). For
that price, you get a rig that
weighs close to 100 Kg. It’s comfy,
it’s practical—you can easily set
all three of your displays and
your surround speaker set.
There’s even upgrades you can
opt for—custom paint jobs for the
many table tops to Porsche seats
with inbuilt heaters! Geeks have
never experienced comfort like
this before!
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Take a Crack 
and win
Professional Joomla
by Dan Rahmel

Published by

Rules and Regulations
Readers are requested to

send in their answers by the
15th of the month of
publication.

Employees of Nine Dot Nine
Interactive and their relatives
are not permitted to
participate in this contest.

Readers are encouraged to
send their replies by e-mail.
Nine Dot Nine Interactive will
not entertain any unsolicited
communication.

Nine Dot Nine Interactive is
not responsible for any
damage to your system that
may be caused while you are
trying to solve the problem.

The Windows Experience Rating is sort of
like a system performance gauging system
that you only find in Vista. While many
complain that it’s flawed and unfair at
times, there’s a way to fool Vista. Basically,
we change the performance figures in the
XML that holds the scores for each of the
subsystems. To see what your system rating
is originally, click on Start > Control
Panel > System and Maintenance >
Performance Information and Tools
or if you use the Classic Control Panel,
double click on Performance
Information and Tools.

1. Open up Windows Explorer and browse to
C:\Windows\Performance\WinSAT\
DataStore.
2. Right-click on the most recently created
XML file there and click on Properties.
3. Click on the Security tab and then on the
Edit button.
4. Click on Add and enter the username that
you log in using. Click OK.
5. Select the entered ID and check the
checkbox for Full Control. Click OK.

6. Click on Yes for any confirmation windows
that may pop up. Finally, click OK.
7. Open Wordpad from Start > All
Programs > Accessories > Wordpad.
8. Click on File > Open and browse to
C:\Windows\Performance\WinSAT\
DataStore. Select All files as the type of file
using the dropdown menu and select the
XML file. Click OK
9. Under the <WinSPR> section, make
changes to the scores given. These are the
changes we made to strike the totally
extraordinary score.
<WinSPR>
<SystemScore>9.9</SystemScore>
<MemoryScore>9.9</MemoryScore>
<CpuScore>9.9</CpuScore>
<CPUSubAggScore>9.9</CPUSubAggScore>
<VideoEncodeScore>9.9</VideoEncodeSc
ore>
<GraphicsScore>9.9</GraphicsScore>
<GamingScore>9.9</GamingScore>
<DiskScore>9.9</DiskScore>
</WinSPR>
10. Save the file and restart Performance
Information and Tools in the Control Panel 

THIS MONTH’S CHALLENGE

Adarsh Akhilesh
Dombivli

LAST MONTH’S WINNER

Do you see too little of
Windows XP’s blue screen
of death? Can you get
Windows to give you a Blue
Screen On Demand?

Send in your solution with
the subject “Take a Crack”,
and your postal address, to
takeacrack@thinkdigit.com

Get Windows XP
To Give You A
Blue Screen On
Demand

LAST MONTH’S CHALLENGE
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Vista Experience Rating after the necessary “tweaks”

Win!

Hike your Vista Experience Rating

Passion-Take a crack_Apr08.qxp  5/13/2008  12:32 PM  Page 30



Digital Passion l Insight

Now that’s all that there is to a digital camera. Did that
sound easy? No? Good, because it’s not. Let’s look at the signifi-
cant individual parts of a digital camera one at a time and list
out their role (no pun) in creating a digital image from light.

The Image Sensor Photophobic And Loving It
We’ve already
mentioned the role of
the image sensor in
capturing an image.
Image sensors are basi-
cally silicon chips, (like
your PC’s CPU), around
the size of your finger-
nail. The surface
consists of millions of
photosensitive diodes,
each capable of captur-
ing a single pixel of the entire image (for ease of understand-
ing you may assume each diode to be a pixel and the terms
have been used interchangeably). These diodes convert the
light that falls on them into electrons or an electrical charge.
We all know when an image is clicked, the lens shutter opens
briefly allowing light in. Now this light falls on each of these
photosensitive diodes, (but with varying intensities according
to the subject in the photograph), and is then converted into
electrons. The more the light hitting a diode, the greater the
charge it will record. For example, pixels capturing light from
bright areas of a scene (bulbs, shiny objects, sunlight etc) will
store a larger charge while those capturing light from dimmer
areas (dark objects, shadows, etc) will have a lower charge.
After the shutter closes to end the exposure, the charge from
each pixel is measured and stored. From these numbers, result
a digital image.

You will (surprisingly) not know that each diode can only
capture brightness and not colour. Therefore, each pixel
records an intensity of shade, a series of tones ranging from
pure white to pure black. This is what we call greyscale. Wait
now... where are all those gorgeous colours you see? That’s the
job of the next bad boy we’re going to see—the Image
Processor. But for now let’s look at the two types of Image
Sensors—CMOS (Complementary Metal Oxide Semiconductor)
and CCD (Charge Coupled Device).

CCD sensors are generally smaller resulting in their use in
mostly compact digital cameras. In a CCD sensor, every pixel’s
charge is transported across the chip to a single output node
(the modern cameras may have more than one such node)
where they are converted to analog voltages. This voltage is
then buffered and sent off the chip as an analog signal. Then
an ADC (Analog to Digital Converter) turns each pixel’s analog
value into a digital value by measuring the amount of charge
present at that particular pixel’s corresponding area.

CMOS sensors tend to be larger and till very recently were
considered to be superior to CCDs which accounts for their
prevalent use in DSLR (Digital Single Lens Reflex) a.k.a. profes-
sional cameras. On the CMOS sensor each pixel has its set of
transistors that amplify, convert and move the charge. Often
CMOS sensors also have additional circuitry for noise correc-
tion and digitalisation circuits, so that the sensor itself
outputs digital bits rather than analog signals doing away
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Michael Browne 

Tracing breakthroughs in technology has
been both, one of our favourite pastimes
as well as our solemn duty as harbingers

of technology related information. The era of
digitalisation is both the present and the
future. And this has touched our every day lives
too, as fluctuating waves (representatives of the
analog era) have given way to zeroes and ones.
Vinyl gave way to CDs and later MP3s, video
cassettes to VCDs and DVDs, similarly did film
eventually take the digital plunge, and it’s a
path from whence there is no return. And why
should there be? The digital photography revo-
lution brought about drastic reductions in the
cost of adoption of photography as a hobby
while reducing the learning curve and the cost
of making mistakes while learning. Sure in the
beginning there were teething issues and scep-
tics wrote off digital photography as an
amateur hobby, professionals stuck with film.
It’s been years since then, and today film is all
but dead, restricted to museums and a very few
niche professionals who still don’t believe.

In what follows, we’ll look into one of the
most remarkable breakthrough products in
modern times—the digital camera. A product
that has revolutionised a profession and
changed the way people create and share

memories, and simultaneously gained adoption
into nearly each and every one of our homes.

It’s All About Pixels, Really
The first thing about digital photography is its
complete compatibility with anything digital,
be it a computer, a cell phone, another digital
camera or even a portable multimedia player.
This is because digital images are nothing but
a long sequence of zeroes and one’s, making up
the bits and bytes that only digital devices with
digital processors recognise. Also, a digital
camera is ultimately tasked with creating a
digital image, which is made up of pixels—the
smallest unit of any image whether still or
motion picture. Images themselves very simply
consist of light waves and their interaction
with colours. Therefore a digital camera is
tasked with capturing a scene (also called a
subject) and converting this captured scene
into pixel values. Of course capturing a scene is
the big part of the job. Just like a traditional
camera, a digital camera uses a set of lenses
that focus light to create an image of a scene.
While film cameras focus this light directly
onto a piece of chemically reactive film, the
lenses of a digital camera focus this light onto
a semiconductor device (popularly called an
image sensor) which is capable of storing light
electronically.

Digital
Photography
touches each of
our lives in some
way today.
Digital Cameras
sell like hot
cakes but do we
know the
ingredients
behind the
perfect image?
Here’s a look at
how it’s done…

An Image Sensor
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Cool Fact

The image sensor’s ability to capture detail is measured in pixels
or megapixels. A 7.1 megapixel camera displays 3072x2304
pixels or 7,077,888 pixels, when in fact it is supposed to display
7,100,000 pixels. This loss of a few pixels is attributed to the CCD
circuitry. This loss isn’t present in CMOS sensors.
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with the need for an
ADC in many cases.

These different
technologies have a
number of advantages
and disadvantages
apparent from their
functional peculiari-
ties. Since each pixel
on a CMOS sensor has
a number of transis-
tors neighbouring it
the light sensitivity is
reduced since with the
same exposure some
light will hit these
dead zones i.e. the transistors. A CCD doesn’t
have this problem, but they consume a lot more
power—in the range of 50 to a 100 times more
than CMOS sensors.

For each image you click, there are millions
of calculations that take place inside the
camera. It’s these calculations that allow the
camera to interpolate, preview, capture,
compress, filter, store and transfer the image as
well as adjust settings, and allow manual tuning
before taking a shot. The latest image processors
are programmable which allows them to
perform some advanced functions like in-
camera photo editing, red eye removal, picture
borders, panorama views and stitching, and
even removing the blur caused by a shaky hand.

We spoke about each diode working in
greyscale only. The next big step to an image is
to add colours to it. This is where the Image
Processor and the Image Sensor work
together. In order to get colours into the
image, the sensor must use filtering to look at
the light (that they have captured) in its three
primary colours. Once these three colours
have been recorded, they are used in combi-
nation with each other to create all the
colours. The three primary colours are also
called RGB, where R is Red, G is Green and B is
Blue. Nearly all cameras use what is called a
Bayer Filter. This filter consists of a row of red
and green blocks alternated with a row of
blue and green blocks, something like a set of
mosaic tiles. Note that the total number of
individual blocks of each colour isn’t identi-
cal and there are around two times more
green blocks than any other colour simply
because the eye is more sensitive to the colour
green. Also note that the pixels on the filter
are such that they can only capture one
colour (that is, the colour corresponding to
the colour of the filter placed directly above
that pixel). Such a colour filter is placed over
each pixel-capturing micro site and the image
processor guesses the exact colour (read true
colour) of a pixel by combining the actual
colour that it captured corresponding to that
pixel with the other two colours captured by
the pixels surrounding it. If the raw output of
a digital camera image sensor with a Bayer
filter were to be viewed it would appear as a
grid of red, green and blue pixels of varying
intensities. There is then a process to break
down this mosaic of estimated colours into

another mosaic pattern with true colours.
One major advantage is that a particular
colour (of a particular pixel) can be used again
by another pixel if required.

Exposure and Focusing: 
Camera Optics
A digital camera has to control the amount of
light reaching the Image Sensor, just like a film
camera has to control exposure of the film.
There are two components that work together
to control the amount of light that is captured.
They are the aperture and shutter speed. The
Aperture is very simply the size of the opening
in the camera that is the opening which allows
light inside, and on to the image sensor. Mostly
digital cameras have automatic apertures,
although a manual setting is provided for
enthusiasts and professionals to have more
control over the final image. The shutter speed
controls the duration for which light is allowed
to pass through the aperture. Digital cameras
can have both analog and digital shutters.

The lens of a digital camera is very similar
to the lens on a conventional film camera. The

role of the lens too remains the same—to
control how light is focussed on the
image sensor for which the lens actually
moves. All digital cameras use autofo-
cus—a feature where the lenses automat-
ically adjust to focus on the subject.
Where there are more than one subjects
advanced autofocus methods may be
used or manual focus is also available on
digital SLR cameras.

The last part of the camera optics is
the focal length. The focal length is
defined as the distance between the lens
and the surface of the sensor. But

whereas for a film camera the size of the film is
fixed at 35 mm, for a digital camera the size of
the image sensor changes from manufacturer
to manufacturer and model to model. In most
digital cameras the size of this sensor is smaller
than the size of a 35-mm film, so in order to
project the image on this sensor the focal
length also has to be reduced in proportion.
With a zoom lens (optical zoom) the focal
length is actually changed so that the subject
appears to be much closer.

In Conclusion
Think of your digital camera as a miniature
computer. As camera resolutions increase and
image sensors have evolved, digital photogra-
phy has become good enough to become a
household commodity, and the focus has now
shifted to features and usability. Features like
face recognition, on-the-fly red eye removal
and even colour and tone adjustment in an
image, grant more control over image settings
even as they complicate things (unnecessarily
for some) over the default Auto mode. With
the latest consumer cameras upping the MP
rating and optical zooms, and a host of other
specifications we’ve come a long way from
black and white giving way to colour. 
Mr Maxwell would be pleased…

michael.browne@thinkdigit.com

Cool Fact
In 1860 James Clerk
Maxwell created a
colour photograph by
using a black and
white camera to take
three photos of a
tartan ribbon, and
each photo was taken
with a single colour
filter in place (red,
green and blue). The
three black and white
images were then
projected onto a
screen using three
discrete projectors.
When brought into
alignment this
formed a full colour
photograph, and
forms the basis for all
cameras since.

How the filter works

The bayer filter
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t’s a Saturday evening, 
and you come home after 
a day’s work to sit on your 
couch to enjoy a nice 
movie. It’s not as fun as it 
would be in a theatre, but 

you’re not quite in the mood to 
stand in queue for a ticket in a 
jam-packed cinema hall. Your TV 
isn’t going to give you the same 
thrill. What do you do?

We’ve always said that it’s 
high time everyone started mov-
ing to LCD TVs or even large 
screens for their PCs. The home 
entertainment system’s transi-
tion to the PC has been gather-
ing pace, and the whole high 
definition craze drives it even 
more. HD players haven’t hit 
the Indian market yet, so more 
people are buying large LCD 
TVs, connecting them to their 
PCs, and playing all their HD 
content on it. There are some 
things, however, that just can-
not be experienced using head-
phones or typically tiny desktop 

speakers you’ve used all these 
years. It’s something to do with 
that chest-thumping bass and 
the presence of clear, pristine 
sound that encapsulates the 
entire room—like in a movie 
theatre, except you can experi-
ence the same right at home, 
on your PC.

The biggest problem with 
going out to buy any speaker 
by just looking at its tag and 
PMPO power rating is that you 
could end up with speakers that 
you might think are amazing, 
but most likely don’t sound any-
where near right—some of them 
have an unnatural tone to them. 
The other common issue is with 
increases in volume, the drivers 
used aren’t able maintain their 
quality. Speaker manufacturers 
try all kinds of new techniques to 
get the best quality out of their 
products. While some might do 
very well, some fail miserably. 

This month, Digit looks at the 
speakers available in the market 

Good
Vibrations
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How can you dream of enjoying 
movies and music with the speakers 
you’ve been dealt? Here’s what you 
need for that extreme sound-a-thon!
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and it’s time we do what we do 
best—tell you which one’s right 
for you! We’ve tested 43 speakers 
in two categories—2.1 and the 
4.1 / 5.1 (surround) group. The 
latter are better for movies, and 
the 2.1 range generally for music 

and gaming. Let’s find out then, 
shall we?

2.1 Speaker sYstems
Multiple speakers don’t result in 
louder and clearer sound. They 
especially don’t make a lot of 
sense when you’re going to spend 
your time listening to music more 
than anything else. 2.1 speakers 
have a few advantages of their 
own—for one, there’s no trouble 
of setting up and arranging two or 
three additional speakers around 
you. Most surround speakers 
don’t come with stands, so you 
need to make your own or hang 
them on a wall, which won’t be 
at the right distance—so you end 
up with a completely ruined sur-
round sound experience anyway. 
There are also cables to hide to 
make sure you don’t have people 
tripping all over the place break-
ing their bones. However, if you 
want to use your system primar-
ily for the home theatre movie 
experience, you’ll need to spend 
on a 5.1 setup.

First Glimpse— 
Build Quality And Design
The focus on design and styl-
ing has become a big component 
of speakers, and all the speaker 
manufacturers are paying atten-
tion to it. 

The Creative T3030 was an 
elegant-looking set with clear 
glossy plastic stands, which 
look very much like the other 
Inspire speaker sets. These com-
paratively flat and tall satellites 
are light, and the driver, a little 
high up, has enough weight to 
topple them over very easily. 
Another set of Creative speak-
ers was on the other end of the 
spectrum—the M2600 satellites 
had a rather cheap plastic feel. 
They are meant to be thin and 
sleek too, but they have some 
provision made for the driver on 
the back. 

TECH-COM in general looked 
to create very unique designs 
throughout the range of speakers 
they sent us. Although they had 
decent designs, the TECH-COM 

SSD-803 was an ugly set, with 
spikes on four corners. It looks all 
right, but the front panels used 
on both the satellites and woofer 
look odd, are made of plastic, 
and aren’t firmly attached. It 
was also kind of funny to see the 
exact same design used for the 
Intex IT-2050W and TECH-COM 
SSD-2000.

The Artis S111R and the 
S111 / FM were two models that 
look and sound quite the same, 
except that the latter has an 
FM radio and the other has a 
remote control. These, too, have 
decent build quality—the knobs 
had the right amount of resis-
tance and sturdiness to them. 
The only issue was the pegs 
at the woofer, which make the 
woofer slide around a bit at 
higher volumes. The Zebronic 
ZEB-4000W’s woofer was anoth-
er sturdily-built set that looked 
simple yet attractive. The other 
Zebronics model—the ZEB-
SW8000—has a very unattractive 
design, and there were dials on 
the front of the woofer with no 
indication of purpose.

One of the issues we looked 
at was the quality of cables pro-
vided by some of the speaker 
manufacturers. The Supercomp 
SES 2077, for example, comes 
with extremely thin cables which 
won’t stand even a moderate tug. 
There were other problems, too: 
some of the TECH-COMs came 
with really short cables—so short 
with the SSD-815, that we were 
forced to keep the woofer on the 
table itself! Quite a few of the 
TECH-COM and Intex speakers 
used RCA connectors; we don’t 
use sound cards, so we were 
forced to buy 3.5 mm-to-RCA con-
verter cables. Some of the other 
TECH-COMs did come with the 
converter cables though.

There’s something about 
large subwoofers that intimi-
dates you, and the Altec Lansing 
MX5021 subwoofer clearly does 
that very well. It’s huge, and 
easily the largest of all the 2.1 
speakers. The other Altec Lansing 
woofers weren’t all that great at 
times—especially the FX4021—
with the down-firing setup. The 
panel on top of the woofer was 
really weak and is supported by 
just a metal mesh. The satellites 
are well designed and fairly stur-
dy. The Altec Lansing VS2421 has 
a very attractive remote with 
a nice red ring highlighting it. 

It matched a similar design on 
the woofer and the satellites. 
Simple, good styling.

Quality Tests
The quality tests aren’t just music 
tracks, but also recordings of all 
kinds of ambient background 
noises. Some of these were 
records with crackers exploding 
far in the distance and some 
right next to the recorder. 

The Altec Lansing MX5021 
came out far ahead of all the 
speakers in the 2.1 range. The 
ability to deliver clear sound 
at all volumes with very minor 
distortion at extreme volumes 
amazed us, and grabbed the 
attention of many passers-by. In 
one of the many tests, there was 
one where multiple bells were 
struck one after the other and 
it was amazing to hear the con-
tinuous hum from the different 
bells while new bells were added. 
Although the MX5021 isn’t the 
warmest of speakers, the treble 
is still kept under check and 
doesn’t go overboard.

The set leading the Logitech 
pack was the Z-2300. It was almost 

as powerful as the MX5021 but it 
lacked the prominent tight bass 
characteristic of the MX5021. If 
price is to be considered, it is 
more than a third costlier than 
the MX5021.

The Altec Lansing VS2421 was 
another set that wasn’t as power-
ful as the MX5021, but clearly 

Having received speakers from so many 
companies and for different setups, 

there were tests to gauge quality of the 
speakers and their performance under 
heavy load. The performance tests were 
basically a collection of tracks from dif-
ferent genres, as well as tracks designed 
to bring out fine details in speakers and 
highlight weaknesses. 

All tests were performed using 
a Creative X-Fi Elite Pro sound card. 
Winamp was used to play the music, and 
Foobar for a few other tests. The bass 
and treble settings, wherever present, 
were kept at the default level.

Music is still where speakers are 
used the most, and that’s why a big 
chunk of the tests involved listening 
to multiple tracks of different genres 
of music. Everything from Pop, Rock, 
Metal and Bollywood to Trance were 
used. Classical and vocalist-dependent 
tracks weren’t missed out either. A 
Sorta Fairytale by Tory Amol and Brid 
Og Ni Mhaille by The Corrs were used. 
The Rock and Metal genre consisted 
of tracks from Opeth, Rush, Dream 
Theater, Break Benjamin, Between the 
Buried and Me and many more. The 
emphasis on these tracks was on the 
general sound and how each compo-
nent of the track played out. 

There were some quality tracks which 
were just ambient sounds like dogs bark-

ing and birds on the trees, water flowing 
down streams and so on. Each of these 
tracks had a list of events that was 
checked with every speaker—whether it 
could render these sounds properly. In 
some speakers, many of these events 
could not even be noticed. In the end, we 
ran the woofer and treble test with the 
volume cranked up to the maximum.

We also used Foobar to generate 
different frequencies, and then a fre-
quency sweep of the whole spectrum 
to look for any kind of inaccuracy or 
inability to pump out certain frequency 
ranges. Many speakers show their glar-
ing faults here.

For surround sound speakers, we 
used additional tests—HD video clips 
with high quality surround audio. These 
were clips from Transformers, which 
many consider to be one of the best 
CG movies ever. The fight scenes where 
metal-pounding action took place are 
where we focussed our attention. Bullets 
ricocheting off the robots and big bassy 
booms were also a good test to evaluate 
the 5.1 speakers. The same tests were 
used on the 2.1 speakers as well. Other 
than that, space fight scenes from Star 
Wars: Revenge of the Sith were used, 
and for ambient sounds, a few scenes 
from Independence Day were used. 
While the main dialogue between char-
acters continues, there are background 

sounds of cyclists riding and people 
walking, sounds of dice being rolled and 
the sounds of the waterfront next to 
which they’re sitting—we wanted to see 
if the speakers could handle these well.

To evaluate surround sound, we 
use a benchmark called Rightmark 3D 
Sound. A looping track plays and keeps 
moving all around the listener—this is 
a great way to see how well surround 
sound systems perform. We looked for 
smooth transitions from one satellite 
to the next.

While all these tests were different 
from each other, half of the points were 
awarded to the general feel of sound and 
tone of the speaker and the other half 
were awarded on certain details present 
in each track. Tracks are played at dif-
ferent volumes to look for any signs of 
vibrations, fluttering or “tearing up”. In 
all, 40-50 different tracks were played 
on every single speaker set, trying to 
accommodate as many kinds of sounds 
and music genres as possible to get a 
good idea of what each of the speaker 
were capable of.

Other points were given to the build 
quality of the speakers, the stability of 
the stands and other features or effects 
that speakers might have. We also gave 
them scores on the type and quality of 
cables used, and the general usability of 
the features and effects.

  How We Tested

 Adam Professional Audio OSS
Adam’s Professional 
Audio OSS has a total 
power output that 
adds up to around 
3000W! It towers a 
mighty two metres 
in height and weighs 
well over 160 Kg. 
There are 60 driv-
ers in this complete 
speaker set which 
are powered by the 

12 amplifiers. The frequency range may be 18 Hz but 
it goes all the way up to 50 KHz—that’s far beyond 
what humans can hear. That kind of performance 
should make animals on the other side of the globe 
go nuts. To keep it precise, there’s a processor that 
makes changes to the delay to compensate for the 
location of the different drivers.

 German Physik Gaudi
The German Physik 
Gaudi is a $2,50,000 
speaker set. This speaker 
set comes with a choice 
of either titanium or 
carbon drivers. The 
weight of the cabinet is 
around 720 Kg. They are 
2.1m in height and 1.3m 
in width. To keep the res-
onance at a minimum, 
there’s use of a material 
called Hawaphon which 
is used widely in govern-
ment and military build-
ings. If you wish, you can 
have a special carbon 
fibre cabinet. 

 How Do You Set Up A Surround Sound System?

It’s one thing to set up a 5.1 speaker sys-
tem, and it’s a completely different thing 

to set it up right. It’s understood that most 
people don’t have the right furniture or 
the stands required to position their rear 
speakers suitably—so what do you do? Place 
them somewhere in the rear as long as they 
point to you. It’s absolutely important that 
for a good surround sound experience, the 
distance, the direction and height of your 
satellites are just 
right. Compared to 
buying the speak-
ers themselves, 
getting stands for 
the speakers is a 
minor cost, so it’s 
well worth the 
money you spend 
for them.

The centre 
channel speaker should preferably be 
absolutely head-on to the people watch-
ing the movie. It should be placed at the 
centre of the screen, and in front of it. The 
front left and right satellites shouldn’t be 
too close to the centre—if they are, you 
won’t be able to make proper channel 
separation.

The same thing should be taken care of 
while setting up the rear speakers. The rear 

speakers are where all the ambient sounds 
are projected from, so they will be pretty 
low in volume most of the time. The rear 
speakers can be much closer to viewers 
than the front channels.

The subwoofer—which generates the low 
frequency range in the sound and gives you 
the ground-shaking vibration—can be placed 
anywhere in the room, but for the right 
amount of volume of bass, you can choose 

to keep it a little 
closer to you. Using 
the woofer next to 
the centre channel 
or next to the TV is 
also popular.

In the end, it all 
comes down to you. 
Play a few quiet 
movie scenes and 
some action packed 

ones. Depending on the positioning of the 
speakers and the dimensions of the room, 
you’ll need to adjust the volume for the 
rear speakers and also the distance. 

All the satellite speakers should be 
placed on stands such that they are at the 
ear level of the audience—who could be on 
a sofa, for example. Also make sure you 
have all the speakers a foot or two away 
from the walls.
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excelled in quality tests. The 
Zebronics ZEB-4000W was also 
very close to it. 

The ZEB-4000W, due to its 
lack of high-frequency range 
performance, didn’t do too 
well in the bells test, and all 
the rings sounded rather flat—
finer harmonics couldn’t be 
distinguished.

Foobar Frequency Test
Foobar’s ability to generate 
steady frequencies or even fre-
quency sweeps is very useful in 
finding out how well speakers 
can handle different frequen-
cies. It’s a good test to find small 
weaknesses in the best of speak-
ers. There were quite a few sur-
prising outcomes.

Although the Altec Lansing 
MX5021 ploughed through all 
the frequencies effortlessly, there 
were some sounds around the 50 
Hz frequency range that created 
some vibrations in the woofer.

A big noticeable problem 
with many speakers is the 
how sharp the tone would 
become when the volume level 
was pushed beyond the 50-60 
per cent mark. This is mostly 
because of the satellites trying 
to play the frequencies meant 
for the woofer, or the other 
way around. The Zebronics ZEB-
SW8000 had an odd problem 

where the woofer would give 
very little output, and an occa-
sional kicking sound at high-
er volumes on extremely low 
frequencies.

Music Test
The strongest point of 2.1 speak-
ers is music, and the real fun 
part of the test was listening 
to our favourite tracks at mind-
blowing volume levels. 

The top place again went 
to the MX5021. The woofer per-

formed exceptionally, with 
tight, hard bass and booming 
sound where expected. The 
woofer on the Logitech Z-2300 
also had a respectable amount 
of bass. The bass on the Z-2300 
was not as hard as the MX5021 
at all. 

The Zebronics ZEB-4000W 
had a very nice bass too. The high 
frequencies weren’t exaggerated, 
but the higher mids were a little 
too pronounced. The compara-
tively less treble meant a slight 
lack of sparkling or crispness in 
the sound. 

Both the Artis S111-FM and 
S111-R are exactly the same in 
terms of quality. The woofer, 
although light, is pretty power-
ful and displaces a lot of air—we 
could feel it more than a foot 
away. Unfortunately, it lacks a 
deep bass because of its light-
weight woofer design, which 
didn’t make listening to music 
a great experience—especially in 
the bass-heavy genres like rock 
and metal.

The Altec Lansing BXR1121 
is pretty good at music. It went 
through all the tests with some 
more than decent results for 
its clean, natural tone. The 
only drawback is that these are 
fairly low-powered speakers, so 
the woofer doesn’t pump out 
the bass you’d like. Still, for a 
small room, these will do well. 
A low-powered speaker set has 
its own advantages—you can 
push the speaker to its lim-
its and your sound still won’t 
distort.

Having heard some really 
great quality from some of 
the other 2.1 speakers of Altec 
Lansing, the FX4021 is a dis-
appointment. The woofer is 
decent, but the satellites are 
pretty appalling, with major 
distortion even at mid-level vol-
umes. The Altec Lansing VS2421 
had a very warm sound signa-
ture which makes it ideal for 
jazz music.

TECH-COM has generally 
suffered from really coloured 
sound—the speakers are mostly 
high on treble, which makes the 
sound very unnatural. A lot of 
equaliser tweaks are required 
to cut down on the lower-highs 
before you can get the right tone 
out of these speakers. 

Movie playback is also very 
good with the 2.1 speakers, even 
if you do miss out on the sur-

round sound experience. The 
MX5021’s solid bass works won-
ders. Following it were the close-
ly performing Logitech Z-2300, 
Altec Lansing BXR1121, Zebronics 
ZEB-SW8000, and Logitech X-240. 
These are speakers with not-so-
hard bass.

And The Winner Is…!
The best speaker for music 
from all the tests that we ran is 
the Altec Lansing MX5021—its  
sheer power and undistorted 
sound, natural tone, with the 
right amount of crispness  
makes it an excellent perform-
er. It’s not very costly either,  
at an MRP of Rs 7,500. In some 
markets, it’s available for 
around Rs 6,500, which makes 
it a steal.

A little far behind is the 
Logitech Z-2300. The woofer isn’t 
as tight as the MX5021, or as pow-
erful, but it stands its ground 
when you demand power of it. 
It does well for music, and the 
slightly boomy woofer does its 
part for movies too.

The Zebronics ZEB-4000W 
grabs a surprising third place. 
Although a little off in tone, 
the sound still had vibrance 
and clarity, which makes it a 
very good speaker set. A bit 
of tweaking with your media  
player’s equaliser, and you can 
get decent music from this 
speaker set for sure. It’s got 
good, heavy bass, but it needs 
you to turn up the bass a fair 
bit before you get the setting 
just right.

The Altec Lansing BXR1121 
makes a for very good value-
for-money product at just  
Rs 1,250. Although it lacks 
power, this is actually an excel-
lent buy for people who want a 
fairly mid-powered sound sys-
tem for their PC.

The Artis S111R is yet anoth-
er product that makes a lot of 
sense for the budget-minded. 
Although a little costlier than 
the BXR1121 at Rs 1,500, it isn’t 
a lot more expensive either, and 
has a slightly better subwoofer. 

The Logitech speakers are 
really good, too but their biggest 
fault is the pricing. The Z-2300, 
for example, is fairly good—not 
better than the Altec Lansing 
MX5021—but it still priced at 
Rs 3,000 more! If you’re looking 
for the ultimate 2.1 speakers, 
then blindly opt for the Altec 

Lansing MX5021. It is a very 
good bargain.

Surround Sound
Speakers
Surround sound speakers are 
meant to serve a completely dif-
ferent purpose—watching mov-
ies with, well, surround sound. 
The sensation of being in the 
middle of the action is some-
thing that you can experience in 
a good movie theatre. The speak-
ers we’ve tested should be able 
to give more or less the same 
experience, but in the comfort 
of your sofa with your family and 
friends. The freedom to pause 
the movie and grab your unlim-
ited supply of popcorn and your 
cola whenever you want is just 
one of the perks of having your 
own little home theatre system. 
Although the emphasis would 
have to be on the surround 
movie tests, we still must focus 
on the best audio quality overall. 
After all, you won’t just be using 
your system for movies. While 
we received mostly 5.1 speak-

ers, there were also a couple 
of 4.1 speakers—Creative Inspire 
M4500, TECH-COM SSD-2800 and 
the TECH-COM SSD-3400.

First Glimpse— 
Build Quality, Design... 
And Some Issues
The Logitech Z-5500 is the scari-
est of all the speakers that we 
received—the woofer is massive! 
The satellites were of 61 W RMS 
each. Most complete speaker sets—
including the woofer and satel-
lites—weren’t made this power-
ful. There were sufficiently long 
cables provided with the speak-
ers, although prospective buyers 
should think of ways to tuck the 
cables away—they can get your 
room a little messy.

The Altec Lansing VS3251 is 
a cute little 5.1 setup. Although 
not as monstrous as the other 
speakers we saw, it is built rather 
well, is compact and comes with 
a chunky remote with very good 
buttons. The Philips MMS460 
has a very light woofer and we 
had our doubts about its perfor-
mance in the bass tests. The sat-
ellites were really built well and 
heavy. This is one of the most 

 Kharma Grand Exquisite
The Kharma Grand Exquisite is a 
$2,20,000 speaker which like its price 
uses exotic components too. Diamond 
tweeters are used for the high frequen-
cies and Kevlar for the bass. Wiring is 
done using pure gold and silver. Each 
speaker weights 440 Kg and they have 
an explosive power of 500W. If that 
doesn’t impress you, then the majestic 
looks surely will.

 Perfect8—The Force
Each of these transparent 
monster’s stands weighs 
around 200 Kg. The frequency 
range extends all the way from 
8 Hz to 50 KHz. All the drivers 
are housed in a glass casing. 
The high frequency range is 
not driven by some tweeter 
but through a 1.6 m long rib-
bon using a neodymium mag-
net system. The price for The 
Force with 2 towers and 4 
outbound woofers is said to 
be around $295,000.

Altec Lansing MX5021

Altec Lansing BXR1121
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 Stand Back MP3, Enter Vinyls?

MP3s have come to be known as the best 
audio quality to most of the people 

using them—a wrong notion. Audio CDs eas-
ily surpass MP3s at the best pos-
sible bitrate and quality, but 
true audiophiles don’t quite 
agree even there. There are 
many who would say that 
vinyls hold the crown for 
quality. Vinyls—for those 
who aren’t aware—are 
better known as gramo-
phone records. Unlike 
CDs, data on vinyls was 
stored as analogue. There 
is a groove that runs from 
the outside to the inside of 
the vinyl disc, and this groove 
contains the information which is 
read by a delicate nib—like on an ink pen. 
Data stored on either side of the groove is 
used to play stereo sound. This is far differ-
ent from how CDs or DVDs are read.

Vinyls are said to be able to store a 
larger frequency range than CDs. There’s 

also a unique tone to the music which many 
consider comes from the inaccuracies of a 
relatively crude technology. It sounds very 

natural and very warm, unlike digi-
tal formats which have a very 

precise razor-like crispness 
to them. 

Before you start 
unpacking your parents’ 
old record player, we 
should just remind you 
that there was a reason 
why vinyls got out of 
the market in the first 

place—they’re bulky, and 
very delicate. The surface 

is susceptible to scratches, 
and any kind of damage would 

completely ruin it. Now with CDs 
and the protective layer, there are no 
such worries. They were also very huge 
and therefore not portable—imagine going 
to work today in a train with a bunch of  
12-inch records in your hand and even 
bulkier record player!
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stylish speaker sets we received, 
but there was some minor shield-
ing issue with it.

TECH-COM’s SSD-2800 is a 
pseudo-4.1 set—which means the 
rear speakers are practically just 
playing the same stuff as the 
fronts. To make matters worse, 
the cables are extremely short, 
so you can only place them 
right next to the front speak-
ers. The SSD-3400 from TECH-
COM was another such speaker. 
While these may have four satel-
lite speakers, they’re still good  
for stereo.

The Logitech G51 comes with 
thick cables, colour-coded to 
make it extremely easy to set up. 
Even the Altec Lansing FX5051 
was considerably easy to set up 
for the same reason. These are 
examples of attention to detail, 
along with detailed trouble-
shooting information that make 
up a good set of speakers.

Some of the TECH-COM and 
Intex speakers, like those in 
the 2.1 category, had some very 
attractive designs. 

There were some problems 
we faced while trying to get 
proper surround sound from 
some speakers, though. On some 
of the TECH-COMs, we had to 
plug in the front channel tracks 

into the auxiliary port to get 
2.1 sound. Another general issue 
with most TECH-COM speakers 
is the lack of 3.5mm-RCA con-
verters. There were also very 
severe shielding issues seen in 
the TECH-COM SSD-5001R and 
the Intex IT-4800. Placing the 
centre speaker over a CRT moni-
tor—or anywhere near it—is out 
of the question.

Foobar Frequency Test
Very low deep bass along with 
power is necessary for a satisfy-
ing movie experience—for bomb 
blasts and crazy dogfights, among 

other things. The Z-5500’s level of 
bass at 20 Hz is pretty low as com-
pared to the other speakers—it’s 
the sheer size of the driver that 
could be to blame here. 

We also saw very erratic 
performance from all the other 
speakers. The Altec Lansing 
FX5051, for example, is extreme-
ly loud on higher frequencies, 
and not so much on the mids 
and lower range.

The sole Supercomp in the 
surround speaker category—the 
SES 5177—performed abysmal-
ly. The woofer was all over the 
place in the low frequency test. 
There was no clear steady tone 
but randomly switching tone. 
The Creative Inspire M5300 also 
lacked presence of bass between 
the 20-50 Hz frequency ranges 
but it was still a fair bit better 
than the M4500.

Music Test
Logitech’s Z-5500 seemed to be 
doing really well in most of the 
tests, and we assumed it would 
do equally well at music with its 
fairly neutral tone. It performs 
quite respectably,  but bass isn’t 
as tight as the Altec Lansing 
MX5021 from the 2.1 speak-
er category. The double bass 
drumming in the Metal tracks 
didn’t sound as pronounced as 
we’d like. For Bollywood pop  
music, the punchy bass did 
well. The Z-5500s are also very 
loud, so you can actually have 
your friends over for your  
very own party in an average-
sized room.

The Logitech G51 has a heavy 
but underpowered woofer. 
It gives you good soft bass in 
tracks like With or without you 
by U2. The satellites are pretty 

decent, and the sound is rather 
warm and neutral without any 
shrill treble. The remote has a 
“matrix mode” for gaming and 
music, and fares horribly. The 
bass completely disappeared, so 
it’s wise to keep the effects off 
at all times.

The Altec Lansing VS3251 isn’t 
powerful, but the quality and 
detailed reproduction of sound 
was pretty impressive regard-
less. The TECH-COM SSD-4301R 
was surprisingly decent—better 
than most of the other TECH-
COMs. It wasn’t as crystal clear 
or crisp as the Altec Lansings, 
but the woofer pumped out well-
balanced bass and it was pretty 
powerful as well. Another TECH-
COM that did well was the SSD-
5101R. The bass was very good 
for drum solos—both in the qual-
ity tests and in the drum solo by  
Mike Portnoy in the live  
version of Dream Theatre’s 
Beyond this life. 

The Philips MMS460 sur-
prised us quite a bit—it has a 
very light woofer, but it gives 
some really impressive bass that 
does justice to bass guitars. It 
lacks the punchy hard bass for 
the drums, though, and the 
satellites exaggerate the high-
er frequencies. Bollywood and 
pop music was given an extra 
sparkle on top range frequen-
cies, which made for a unique  
sound. The Philips MMS460 
sound pretty nice in the piano 
tracks with every single note 
pumping that essential little bit 
of bass. Similar sound charac-
teristics could be heard in the 
pure vocal (a capella) tracks with 
finger snapping. 

Movies
The Logitech Z-5500 does a fair 
job at movies. The ample power 
makes the action-packed Star Wars 
and Transformers clips a joy to go 
through. The Z-5500s are rated at 
500 W RMS, but it really doesn’t 
sound that much louder than 
the Logitech MX5021—which is 
around 90 W RMS. 

We’re pretty impressed by 
the Logitech M-50 in the music 
tests, even though they are low-
power speakers. Movies sound all 
right, but for quiet movie scenes, 
the bass wouldn’t play its part at 
all. Although not very loud, the 
detail was still very respectable. 
They are rated at 26 W RMS, but 
sound pretty powerful.

The Altec Lansing FX5051 
gives extremely good detail in 
the Star Wars scene—the quality 
of the crunch of a ship smashing 
into another was pretty amazing. 
The lack of punch in the woofer 
and the distortion at higher vol-
umes was a complete turn-off. 
The woofer had to be turned up 
to over 80 per cent to get some 
bass into the sound.

Extras
The Logitech Z-5500 comes with 
a remote control with a display 
on it. Along with the remote is 
an inbuilt decoder. All the fea-
tures and processing make the 
remote panel a little hot after 
some use. The remote itself is 
feature-packed with different 
audio modes for listening to 
music and movies, or using all 
speakers for music.

The FX5051 can also be driven 
through a USB interface if you 
don’t have sound card. There 
were no problems faced with 
detection, or anything to do with 
drivers. The quality is nothing 
special either, and these days 
pretty much every single moth-
erboard comes with integrated 
sound so it doesn’t do a lot.

The Best!
We recommend the Z-5500 for its 
good quality, and more impor-
tantly, its colossal power. The 
biggest problem with the Z-5500 
is the price—Rs 27,995! For that 
price, you don’t really get that 
many more times the power or 
quality that you would get from 
a very good 2.1 like the Altec 
Lansing MX5021. 

If power isn’t what you’re 
looking for, then the Altec 
Lansing VS3251 is a good set 
which is very affordable and is 
sufficient for an audience of two 
or three people in front of your 
PC. If you’re willing to ignore 
the slightly high treble sound, 
then the Philips MMS460 is also 

 Room acoustics—why bother?

In the audiophile’s bible, anything that 
reflects sound is evil. Well, most of the 

time, at least. Sound bounces off flat and 
hard surfaces and all you get from that is 
loads of stray echoes all over the place and 
some sounds end up overpowering others.

There are a few things you can do 
to improve the acoustics of your room. 
Firstly, you’ll need to use some sound-

absorbing material on your walls and 
floors, and if possible, even your ceil-
ing. Curtains, wooden shelves and stacked 
books also work as great absorbing mate-
rials. This way, sounds get absorbed rather 
than getting reflected. Moving the seating 
arrangement and positioning can also help 
you find a sweet spot where echoes are 
minimal. A very small room also has lots of 

resonance, and is a bad idea 
to set up a home theatre in 
such a place.

Some of the largest and 
most advanced anechoic cham-
bers are used for the develop-
ment and testing of aircraft and 
other vehicles for the armed 
forces. To give you an idea of 
the size, the largest anechoic 
(without echoes) chamber is 
the Benefield Anechoic Facility 
at the Edwards Air Force base 
in the US. The dimensions of 
the room are some 250 x 264 x 
70ft, and fits 816,000 cones to 
snuff out reflected sound.

Logitech Z-5500
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Altec Lansing VS3251

 Yg Acoustics Voyager
The Yg Acoustic 
Voyager’s distinc-
tive design looks 
like something out 
of a sci-fi movie. 
Unlike all the other 
mammoths of its 
class, the weight 
of the Voyager is 
just around 91 Kg 
thanks to use of 

cast aluminium. The price for the Voyager is a com-
paratively low $1,00,000. The Voyager is so exotic 
that it is only sold to the well known in the music 
and film industry. No, you can’t walk in for a dem-
onstration—you are to be invited by them.

 Dumped Your PlayStation, Did You?

If you did, it could have been a big mistake. The buzz 
among audiophiles these days is that the original 
PlayStation (Model SCPH-1001) could possibly be 
one of the best CD players ever made! It’s said that 
if you were to purchase a player that could match 
that quality, you’d be spending in excess of $6000 
(Rs 2,40,000) for it. Audio geeks who’ve spent that 
kind of money on their current high-end amps must 
surely feel like complete asses, having wasted all 
that dough, when the answer was right in front of 
them all along! 
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a very impressive set of speakers 
to consider. The VS3251 and the 
MMS460 are priced at Rs 4,200 
and Rs 4,999 respectively.

The Logitech G51 also makes 
a decent buy, but like the Z-5500, 
is overpriced. 

TECH-COM too had a 
few decent sounding woof-
ers with hard tight bass, too. 

2.1 Speakers Surround Sound Speakers

Best Performance

Logitech Z-2300 
Price: Rs 10,395

Altec Lansing MX5021 
Price: Rs 7,500

1

2

Cheapest Performer

Artis S111R 
Rs 1,500

Altec Lansing BXR1121 
Price: Rs 1,250

1

2

Best Performance

Logitech G51 
Price: Rs 12,995

Logitech Z-5500 
Price: Rs 27,995

1

2

Best Buy

TECH-COM SSD-4301R 
Price: Rs 2,250

Altec Lansing VS3251
Price: Rs 4,200

1

2

Cheapest Performer

TECH-COM SSD-4201R
Price: Rs 2,250

TECH-COM SSD-4301R
Price: Rs 2,250

1

2

Best Buy

Artis S111R
Price: Rs 1,500

Altec Lansing BXR1121 
Price: Rs 1,250

1

2

Unfortunately, their inability to 
play well at loud volumes or poor 
detail and bad colouring on the 
higher end of the spectrum is 
the reason they don’t figure in 
the top rankings. However, for 
the low price you pay, you get 
some really unique and fancy 
looking stuff.  Creative’s speak-
ers were once considered great 

Brand Company Phone No Email Website
Altec Lansing Rashi Peripherals Pvt.Ltd 022-67090909 altec@rptechindia.com www.alteclansing.

com
Artis Kunhar Peripherals Pvt. Ltd 022-66345758 Sales1@kunhar.com www.artis.co.in
Creative Compuage Infocom Ltd 022-23842200 vaishali.shinde@

compuageindia.com
www.creative.com

Logitech Logitech 022-26571160 kavita_nath@logitech.com www.logitech.com
Philips Philips Electronics India Ltd 022-66912000 sacchit.naik@philips.com www.philips.com
Zebronics Topnotch Infotronix (I)Pvt Ltd 044-26616201 enquiry@zebronics.info www.zebronics.net

 Contact Sheet	          Speakers

sets—they are costlier than 
the rest, but they always had 
the quality. Today, the speak-
ers from Creative don’t seem 
to be targeted at enthusiasts 
anymore—they’re just for peo-
ple who want a basic surround 
sound setup.

At the start of this massive 
test, we expected a lot, and it’s 
been a little disappointing to see 
no real fierce competition in the 
surround sound speaker market. 
There aren’t any improvements, 
and there are too many mod-
els—each one slightly worse than 
the other. Here at Digit, we’re 
still feeling the aftershocks of 
the Gigaworks and Megaworks 
range of speakers of the years 
that have passed. 

rossi.fernandes@thinkdigit.com

2.1 Speakers Surround  Sound  Speakers



Brand
Model

Altec Lansing
MX5021

Logitech
Z-2300

Altec Lansing
VS2421

Zebronics
ZEB-4000W

Logitech
Z-4

Artis
S111R

Artis
S111/FM

Altec Lansing
BXR1121

Zebronics
ZEB-SW8000

Altec Lansing
FX4021

Intex
IT-2820

Logitech
X-240

Altec Lansing
VS4121BLK

Price Rs 7,600 Rs 10,395 Rs 2,550 Rs 1,850 Rs 7,595 Rs 1,500 Rs 1,800 Rs 1,250 Rs 2,500 Rs 5,500 Rs 1,600 Rs 3,595 Rs 3,200

Pros Excellent 
performance

Decent woofer Stylish performer Comparatively tight 
bass

Great remote Above average woofer FM functionality Great value Very tight and power-
ful bass

Neutral warm sound Exotic design Good performer Sleek design

Cons Some minor vibra-
tions in woofer

Distorts easily Bass flutters at low 
frequencies

Minor buzzing Overpriced Overpowered mids Overpowered mids Lacking bass Bad controls Poor satellite 
performance

No punch in bass Minor issues with bass Highs distort too much

Total (Out of 100) 62.81 48.66 43.70 43.41 43.26 42.44 42.33 41.59 40.93 38.5 38.27 37.77 37.63

Features (Out of 40) 19.22 14.38 14.12 13.14 14.68 12.78 12.66 11.96 11.38 16.42 11.46 9.66 13.52

Performance (Out of 60) 43.59 34.28 29.58 30.27 28.58 29.66 29.67 29.63 29.55 22.08 26.81 28.11 24.11

Features

Power Rating (RMS Watts) 90 200 28 40 40 29 NA 15 60 46 60 27 31

  Subwoofer (RMS Watts) 50 120 14 20 23 12 NA 7 30 24 30 15 19

  Satellites (RMS Watts) 20x2 40x2 7x2 10x2 17x2 8.5x2 NA 4x2 15x2 11x2 15x2 6x2 6x2

  Frequency response (Hz) 40-18000 35-20000 35-20000 55-20000 35-20000 50-20000 35-20000 30-20000 35-18000 32-20000 55-18000 40-20000 20-20000

  Sub-Woofer (Driver Diameter) 6.5” 8” 5.25” 5.25” 8” 5” 5” 4” 5.25” 4.25”x2 4” 4” 6.5”

  Satellites (Driver Diameter) 1”+ 2x3” 2.5” 2.5” 3” 2”x3 2.5” 2.5” 2.5” 4” 1.6” + 0.7” 3” 2” 1.1”

Connectors on Speaker Set

 Analog (Front in/Auxilliary) Y/Y Y/N Y/Y Y/N Y/Y Y/N Y/N Y/Y Y/N Y/Y Y/N Y/Y Y/N

 SPDIF (Coaxial/Optical) N/N N/N N/N N/N N/N N/N N/N N/N N/N N/N N/N N/N N/N

Controls provided on speaker set / 
Remote control

Bass/Treble (Y/N) Y/Y Y/N Y/Y Y/Y Y/N Y/N Y/N Y/Y Y/Y Y/Y Y/Y N/N Y/Y

Volume (Y/N) Y Y Y Y Y Y Y Y Y Y Y Y Y

Surround Effects / Others Effects (Y 
/ List)

N / N N / N N / N N / N N / N N / N N / N N / N N / N N / SFX N / N N / N N / N

Bundled Accessories 

External Decoder/Power Adapter/Built-
in FM Tuner

N/N/N N/N/N N/N/N N/N/N N/N/N N/N/N N/N/Y N/N/N N/N/N N/N/N N/N/N N/N/N N/N/N

Remote control (Wired [W] / Wireless 
[WL])

WL W W N W W N N N W, WL N W N

Manual & documentation (Y/N) Y Y Y Y Y Y Y Y Y Y Y Y Y

Build Quality (Scale of 10) 7.5 6.5 5 6 5 7 7 4 4.5 5.5 5 4.5 5

Performance

HD Movie Audio Test (Scale of 10)

Transformers 7.5 6 5 6 4 4.5 4.5 6 5.5 5 4.5 5 5

Star Wars—Return of the Sith 7 6 5.5 5 4 5 5 6 5.5 4.5 5.5 6 4

Independence Day 7.5 6.5 5.5 5 4.5 4.5 4.5 5.5 6 5 4.5 5.5 4.5

Music Quality (Scale of 10)

Rock 7 5.5 5 4.5 5 5.5 5.5 5.5 4.5 3 4 4.5 3.5

Metal 7 5.5 5 5 5.5 5 5 5 4.5 3 3.5 4.5 3

Jazz 7.5 4.5 5.5 4.5 5.5 5 5 4.5 5 4 4.5 4 3.5

Bollywood 7.5 6 5 6.5 5 6 6 5 4.5 4.5 5.5 5 4.5

Pop 7.5 5 4.5 3.5 4.5 5 5 5 4.5 2.5 4 5 3

Techno/Trance 7 5.5 5.5 5 4.5 4.5 4.5 4 5.5 3.5 4.5 4.5 4.5

Surround sound (Scale of 10) 7 5.5 4.5 5 5.5 5.5 5.5 4 5 3 4 4 4.5

Frequency test (Scale of 10)—Foobar 6.9 7.2 4.2 4.7 4.1 4.2 4.2 5 4.3 4.2 4.4 4.5 4.3

Freq. Sweep—20Hz—22kHz (Scale of 10) 7 6 4 4.5 4.5 5 5 4.5 5 4 4.5 5 4.5

Quality Tests (Scale of 10)

Drums 7.5 5.5 5 6.5 5.5 6 6 5.5 5.5 3.5 4.5 5 4

Bells 7 5 5.5 4 5 5 5 5 5.5 2.5 4.5 5.5 2

Church Organ 7 5.5 4 5.5 5 5 5 5.5 5 2 5 5.5 3

Vocals 8 4 4.5 5 5 3.5 3.5 5 4.5 4.5 3.5 5 3.5

Woofer Test 7.5 7 4.5 5 4.5 5 5 3.5 4 3.5 3.5 4 4

Power handling Test (Scale of 10) 7.0 6.8 5.0 5.3 5.0 4.8 4.8 4.5 5 3.8 4.3 3.8 4.5
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Brand
Model

Creative
Inspire T3030

Intex
2050W FM

Creative
M2600

TECH-COM
SSD-2000

TECH-COM
SSD-815

TECH-COM
SSD-803

Supercomp
SES2077

Price Rs 4,597 Rs 1,500 Rs 2,699 Rs 845 Rs 525 Rs 975 Rs 850

Pros Unique, stylish 
design

Built-in FM tuner Compact design Cheap Average at vocals Decent build 
quality

Decent for vocal 
tracks

Cons Slightly underpow-
ered bass

Poor design No sturdy stands Extreme highs Bad design Over- emphasised 
highs

Poor cables

Total (Out of 100) 34.69 31.96 29.72 29.04 26.18 25.56 23.05

Features (Out of 40) 11.32 11.08 10.2 9.76 10.4 9.78 7.54

Performance (Out of 60) 23.37 20.88 19.52 19.28 15.78 15.78 15.51

Features

Power Rating (RMS Watts) 29 32 29 34 8 38 8

  Subwoofer (RMS Watts) 17 20 17 20 4 18 6

  Satellites (RMS Watts) 6x2 6x2 6x2 7x2 2x2 10x2 1x2

  Frequency response (Hz) 40-20000 40-20000 40-20000 30-20000 35-20000 35-20000 60-20000

  Sub-Woofer (Driver Diameter) NA 4” NA 4” 4.8” 4” 4”

  Satellites (Driver Diameter) NA 3” NA 3” 2.5x2 3” 3”

Connectors on Speaker Set

 Analog (Front in/Auxilliary) Y/N Y/N Y/N Y/N Y/N Y/N Y/N

 SPDIF (Coaxial/Optical) N/N N/N N/N N/N N/N N/N N/N

Controls provided on speaker set / 
Remote control

Bass/Treble (Y/N) Y/N Y/Y Y/N Y/Y Y/N Y/Y N/N

Volume (Y/N) Y Y Y Y Y Y Y

Surround Effects / Others Effects (Y 
/ List)

N / N N / N N / N N / N N / N N / N N / N

Bundled Accessories 

External Decoder/Power Adapter/Built-
in FM Tuner

N/N/N N/N/Y N/Y/N N/N/N N/N/N N/N/N N/N/N

Remote control (Wired [W] / Wireless 
[WL])

W N W N N N N

Manual & documentation (Y/N) Y Y Y Y Y Y Y

Build Quality (Scale of 10) 4.5 3.5 5 3.5 3 3.5 3.5

Performance

HD Movie Audio Test (Scale of 10)

Transformers 4 4 4 3.5 3 3 3.5

Star Wars—Return of the Sith 5 3.5 5 3 2 3.5 2

Independence Day 4 4 4 3.5 4 3 2

Music Quality (Scale of 10)

Rock 4.5 3 2 2.5 2.5 1.5 1.5

Metal 4 3 2.5 2.5 2 2 1.5

Jazz 5.5 3.5 4 3.5 3.5 2.5 2

Bollywood 4 4.5 2 4 2.5 2.5 2.5

Pop 3.5 3 3 3 3 2 2

Techno/Trance 3 3.5 3.5 3 2 2.5 1.5

Surround sound (Scale of 10) 4.5 4.5 3 4.5 3 3.5 4

Frequency test (Scale of 10)—Foobar 3.2 3 4.6 2.8 1.7 2.6 2.8

Freq. Sweep—20Hz—22kHz (Scale of 10) 3.5 3 2.5 3 2 3.5 3.5

Quality Tests (Scale of 10) 4.2 3.0 3.6 2.7 2.8 2.3 2.7

Drums 5 3.5 4 3 2.5 2 2

Bells 3.5 2.5 4 2 1.5 1.5 2.5

Church Organ 3 3 3.5 3.5 2.5 2 3

Vocals 5.5 3 3.5 2.5 3 2.5 2.5

Woofer Test 3 3.5 3 3 3 3 1.5

Power handling Test (Scale of 10) 3.0 3.5 3.5 3.5 3.5 2.8 3.5
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Brand
Model

TECH-COM
SSD-4101R

TECH-COM
SSD-2800

TECH-COM
SSD-3001R

TECH-COM
SSD-3400

Price Rs 1,875 Rs 1,250 Rs 1,900 Rs 1,475

Pros Decent at low volumes Low price Cheap Unique control knobs

Cons Distortion at average volume Pseudo 4.1 Weak at bass Pseudo 4.1

Total (Out of 100) 31.07 28.71 27.84 24.95

Features (Out of 40) 12.98 9.76 10.24 8.54

Performance (Out of 60) 18.09 18.95 17.60 16.41

Features

Speaker Setup 5.1 4.1 5.1 4.1

Power Rating (RMS Watts) 60 44 45 44

  Subwoofer (RMS Watts) 20 20 20 20

  Center (RMS Watts) 8 NA 5 NA

  Satellites (RMS Watts) 8x4 6x4 5x4 6x4

  Frequency response 20-20000 30-20000 40-18000 30-20000

  Sub-Woofer (Driver Diameter) 5.25” 4” 5.25” 4”

  Satellites (Driver Diameter) 3”x5+1.5x2 3” 3” 3”

Connectors on Speaker Set

Front in / Rear in / 
Center-Subwoofer

Y/Y/Y-RCA Y/N/N Y/Y/Y-RCA Y/N/N

Digital DIN / Auxilliary N/Y N/N N/N N/N

 SPDIF (Coaxial/Optical) N/N N/N N/N N/N

Controls provided on speaker set / 
Remote control

Bass/Treble Y/N Y/Y Y/N Y/N

Volume (Y/N) Y Y Y Y

Surround Effects / Others Effects  
(Y / List)

N / N N / N N / N N / N

Bundled Accessories 

External Decoder/Power Adapter/
Built-in FM Tuner

N/N/N N/N/N N/N/N N/N/N

Remote control (Wired [W] / 
Wireless [WL])

WL N N N

Manual & documentation (Y/N) Y Y Y Y

Build Quality (Scale of 10) 3.5 3.5 3 3.5

Performance

HD Movie Audio Test (Scale of 10)

Transformers 3 3.5 4 3

Star Wars—Return of the Sith 3.5 3 4.5 3.5

Independence Day 4.5 3.5 4 4

Music Quality (Scale of 10)

Rock 2.5 2.5 2.5 1.5

Metal 2.5 2.5 2 2

Jazz 3 3.5 3.5 2.5

Bollywood 2.5 4 3.5 2.5

Pop 2 3 3.5 2

Techno/Trance 2 3 2.5 2.5

Surround sound—(Scale of 10) 5.5 3.5 2 3.5

Frequency test (Scale of 
10)—Foobar

3.9 2.7 2.7 2.8

Frequency Sweep—20Hz—22kHz 
(Scale of 10)

4 3 3 3.5

Quality Tests (Scale of 10)

Drums 3 3 2.5 2

Bells 2.5 2 2.5 1.5

Church Organ 3 3.5 3 2

Vocals 3.5 2.5 3 3

Woofer Test 2.5 3 2 3.5

Power handling Test (Scale of 10) 2.8 3.5 2.8 3.0

 Speakers—Surround
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Brand
Model

Logitech
z5500

Logitech
G51

Altec Lansing
VS3251

Altec Lansing
     FX5051

Philips
MMS460

Logitech
M-50

TECH-COM
SSD-4301R

INTEX
IT-6800W

INTEX
IT-4800

Price Rs 27,995 Rs 12,995 Rs 4,200 Rs 12,500 Rs 4,999 Rs 2,895 Rs 2,250 Rs 5,000 Rs 3,500

Pros Very powerful Decent quality Sparkling details In-built sound through USB Modern design Powerful for a 26W set Average performer Easy to set up Decent looks

Cons Very expensive Highly overpriced Soft bass Noisy woofer Lacking deep bass Poor for music Poor controls Unstable bass Unshielded speakers

Total (Out of 100) 68.87 47.60 47.55 44.57 42.18 39.26 39.26 39.04 38.61

Features (Out of 40) 25.94 15.44 16.20 19.94 11.46 15.00 11.94 12.74 12.06

Performance (Out of 60) 42.93 32.16 31.35 24.63 30.72 24.26 27.32 26.30 26.55

Features

Speaker Setup 5.1 5.1 5.1 5.1 5.1 5.1 5.1 5.1 5.1

Power Rating (RMS Watts) 500 155 70 89 80 26 80 140 65

  Subwoofer (RMS Watts) 187 56 25 28 30 15 30 40 30

  Center (RMS Watts) 69 19 9 13 10 2.3 10 20 7

  Satellites (Front/Rear) (RMS Watts) 61x4 20x4 9x4 12x4 10x4 2.3x4 10x4 20x4 7x4

  Frequency response (Hz) 33-20000 36-20000 40-17000 40-20000 20-20000 48-20000 20-20000 40-18000 20-20000

  Sub-Woofer (Driver Diameter) 10” 5.25” 5” 6.5”x2 NA 5” 5.25” 6.5” 5.25”

  Satellites (Driver Diameter) 3” 2x2” 2.5” 1.6” + 0.7” NA 2.75” 3” 1.5+3” 3”x6, 1.5”5

Connectors on Speaker Set

Front in / Rear in / 
Center-Subwoofer

Y/Y/Y Y/Y/Y Y/Y/Y Y/Y/Y Y/Y/Y Y/Y/Y Y/Y/Y-RCA Y/Y/Y-RCA Y/Y/Y-RCA

Digital DIN / Auxilliary Y/Y N/Y N/Y N/Y N/N N/N N/Y N/N N/N

 SPDIF (Coaxial/Optical) Y/Y N/N N/N N/N N/N N/N N/N N/N N/N

Controls provided on speaker set / 
Remote control

Bass/Treble N/N Y/N Y/N Y/Y Y/N Y/N Y/N Y/N Y/N

Volume (Y/N) Y Y Y Y Y Y Y Y Y

Surround Effects / Others Effects  
(Y / List)

Y, Dolby Pro Logic II, 6Ch Direct, 
Stereo x2, Digital DTS

N / Matrix-Gaming, Movie N / N N / N N / N N / N N / N N / N N / N

Bundled Accessories 

External Decoder/Power Adapter/
Built-in FM Tuner

Y/N/N N/N/N N/N/N N/N/N N/Y/N Y/N/N N/N/N N/N/N N/N/N

Remote control (Wired [W] / 
Wireless [WL])

W, WL W WL W, WL N N N WL WL

Manual & documentation (Y/N) Y Y Y Y Y Y Y Y Y

Build Quality (Scale of 10) 7 5.5 4.5 5.5 5 3.5 4 4.5 4

Performance

HD Movie Audio Test (Scale of 10)

Transformers 8 5.5 5.5 5 5 5 6 4.5 6

Star Wars—Return of the Sith 8 6 5.5 5 5.5 5.5 6 4.5 5.5

Independence Day 8 4.5 6 4.5 5 4 5.5 5 6

Music Quality (Scale of 10)

Rock 6.5 5.5 5 3.5 5 4 4 4 3.5

Metal 6.5 5 5 4.5 5.5 4 4.5 4 4

Jazz 7 5 5.5 4.5 5.5 3.5 4 4.5 4.5

Bollywood 7.5 5.5 6 4.5 6 4 5 5 4

Pop 7 6 5 3 4.5 3.5 4.5 5 4.5

Techno/Trance 6.5 5 4.5 4 4 3 4 4.5 4.5

Surround sound—(Scale of 10) 8 6 6 5.5 5.5 4.5 5 5.5 5.5

Frequency test (Scale of 
10)—Foobar

6.9 5 5.3 3.7 4.8 4.1 3.4 3.2 2.9

Frequency Sweep—20Hz—22kHz 
(Scale of 10)

7.5 5.5 5 4 6 4 5 4 4.5

Quality Tests (Scale of 10)

Drums 7 5 5 4.5 5.5 4.5 5 5 4.5

Bells 6.5 5.5 4.5 4 5 5 4 3.5 3

Church Organ 7 5 5 4 5 4 4 5 4

Vocals 7.5 5.5 4.5 4.5 5 4.5 4 4 4

Woofer Test 7 5.5 4 4 4 3 5 4.5 3.5

Power handling Test (Scale of 10) 6.8 5.3 5.3 4 4.8 4.3 4.3 3.3 3.8
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Brand
Model

TECH-COM
SSD-5101R

TECH-COM
SSD-4201R

TECH-COM
SD-6001R

     Creative
Inspire T6060

TECH-COM
SSD-5001R

Creative
SBS A500

Creative
Inspire M5300

Creative
Inspire M4500

Supercomp
SES 5177

Price Rs 2,375 Rs 2,250 Rs 2,950 Rs 6,699 Rs 2,200 Rs 4,999 Rs 5,699 Rs 3,999 Rs 3,499

Pros Good woofer Decent tone Decent warm sound Stylish design Heavy woofer Good for surround sound Sleek design Smooth surround sound transition Decent detail in satellites

Cons Bad unnecessary display Very underpowered bass Issues with 2.1 setup Overpriced No treble control Lacks bass at low volumes Overpriced Flat sound Unstable bass

Total (Out of 100) 38.37 37.90 36.99 36.87 36.56 35.51 33.11 31.46 31.34

Features (Out of 40) 13.78 12.68 11.92 12.76 11.66 11.48 10.68 10.20 12.84

Performance (Out of 60) 24.59 25.22 25.07 24.11 24.90 24.03 22.43 21.26 18.50

Features

Speaker Setup 5.1 5.1 5.1 5.1 5.1 5.1 5.1 4.1 5.1

Power Rating (RMS Watts) 90 75 120 72 120 47 47 41 80

  Subwoofer (RMS Watts) NA 25 45 22 45 17 17 17 30

  Center (RMS Watts) NA 10 15 18 15 6 6 NA 10

  Satellites (RMS Watts) NA 10x4 15x4 8x4 15x4 6x4 6x4 6x4 10x4

  Frequency response 40-20000 20-20000 20-20000 40-20000 20-20000 45-20000 40-20000 40-20000 NA

  Sub-Woofer (Driver Diameter) 5.25” 5.25” 5.25” NA 5.25+3” NA NA NA 5.25

  Satellites (Driver Diameter) 3”+1.5x2 3” 3” NA 6+1.5” NA NA NA 2.75

Connectors on Speaker Set

Front in / Rear in / 
Center-Subwoofer

Y/Y/Y-RCA Y/Y/Y-RCA Y/Y/Y-RCA Y/Y/Y Y/Y/Y-RCA Y/Y/Y-cabled connected Y/Y/Y-cabled connected Y/Y/N-cabled connected Y/Y/Y-RCA

Digital DIN / Auxilliary N/Y N/Y N/Y-RCA N/Y N/N N/N N/N N/N N/Y

 SPDIF (Coaxial/Optical) N/N N/N N/N N/N N/N N/N N/N N/N N/N

Controls provided on speaker set / 
Remote control

Bass/Treble Y/N Y/N Y/N Y/N Y/N Y/N Y/N Y/N Y/N

Volume (Y/N) Y Y Y Y Y Y Y Y Y

Surround Effects / Others Effects  
(Y / List)

N / N N / N N / N N / N N / N N / N N / N N / N N / N

Bundled Accessories 

External Decoder/Power Adapter/
Built-in FM Tuner

N/N/N N/N/N N/N/N N/Y/N N/N/N N/Y/N N/Y/N N/Y/N N/N/N

Remote control (Wired [W] / 
Wireless [WL])

WL WL WL W WL W W W WL

Manual & documentation (Y/N) Y Y Y Y Y Y Y Y Y

Build Quality (Scale of 10) 3.5 3.5 3.5 4.5 3.5 4 5 5 3.5

Performance

HD Movie Audio Test (Scale of 10)

Transformers 5 5 4.5 4.5 5 5 4.5 4 5

Star Wars—Return of the Sith 6 5.5 5 4.5 5 4.5 5.5 4.5 5

Independence Day 5.5 4.5 4.5 4 5 5 5 5 4.5

Music Quality (Scale of 10)

Rock 3.5 4 4 4.5 4 4 3.5 3 2

Metal 3.5 3.5 4 4 4 4.5 3.5 3.5 3

Jazz 4 4 4.5 5.5 3.5 5 4 4 2.5

Bollywood 4.5 4.5 4 4.5 4.5 4 3 2.5 3.5

Pop 4 4.5 4.5 3.5 4 3.5 3 3 2.5

Techno/Trance 4 4 4.5 3 4.5 3 3.5 3.5 3

Surround sound—(Scale of 10) 5.5 5 5.5 4.5 5 6.5 6.5 6 4

Frequency test (Scale of 
10)—Foobar

3.5 3.6 3.6 3.5 3 3.4 3.2 3.1 2

Frequency Sweep—20Hz—22kHz 
(Scale of 10)

3.5 4 4 3.5 4 3.5 2.5 2.5 2

Quality Tests (Scale of 10)

Drums 4 5 4 4 4.5 4 4 4 3.5

Bells 2.5 3.5 3.5 3.5 4 4.5 4 4 2.5

Church Organ 3 3.5 3.5 3 5 3 3.5 3.5 3

Vocals 4 4 4 5 4 4 4 3.5 3

Woofer Test 3.5 4 4 3.5 4.5 3 3.5 3 2.5

Power handling Test (Scale of 10) 3.5 3.5 3.5 3.8 3 3.3 3.3 3.5 3
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Nash David

Speakers easily play the most significant
role in enhancing your audio experience.
So how do they actually manage to repro-

duce sound from the electrical signals that are
fed as input? Devices such as speakers and
microphones are technically called transducers.
A transducer transforms one form of energy
into another—in this case, a speaker converts
electrical energy into acoustic energy  (sound),
in about the same way that a microphone
converts acoustic energy into a corresponding
electrical signal.

There’s more to speakers than just plugging
them in and believing that the costly sound
system you got is going to take you
to new heights. Of course, higher-
end systems, with their excellent
low-noise amplifiers, filters and
impedance matchers reproduce
crystal-clear sound even from
speakers of the lowest end, but
audiophiles know the difference!

We need to dwell into
some physics to understand
its mechanism. During our
school days, we all have
played around with the
tuning fork during our
physics practicals. On strik-
ing the tuning fork, we
hear a long hum. 

This sound is created by
the compression and
rarefaction of air particles, around the
vibrating fork arms. When these
compressions and rarefactions hit the
eardrum, it vibrates, and we perceive
sound. In a speaker, this compression
and rarefaction is performed by a paper
diaphragm that vibrates in accordance
with the electrical signal fed to it. The
construction of a speaker sheds more
light on its functioning. At the base is a
powerful ring magnet. In the centre is a
voice coil made up of fine wire, wound
around a paper cylinder. As we can see
in the picture, the voice coil is attached

to a spider (an elastic paper sheet that holds
the voice coil), such that it always returns to
its fixed position under normal conditions. 

To start off with the functionality of a
speaker, the underlying principle is electro-
magnetism. The basic interaction between an
electromagnetic coil and a powerful perma-

nent magnet is what drives the speaker to
produce sound. The primary source of sound is a
diaphragm. One end of the voice coil is attached
to the centre of the paper diaphragm. This
diaphragm, in turn, compresses and rarefies the
air particles around it, thereby producing sound.

Speaker enclosures, in addition to the speaker
itself, also play a vital role in your audio experi-
ence. The reason for this is that the air flow
through the enclosure drastically affects bass and
crackling sounds due to undesirable harmonics.
The dimensions of the enclosure have an effect
on the resonance of the sound waves.

Getting more into the technicalities, let us
consider an amplifier as a block. In this case, it
primarily has two signals—the input and the

output. For the amplifier to have
high gain, its input impedance
should be as high as possible and
its output impedance should be as
low as possible. The reason for this
is the Maximum Power Transfer
theorem, which states that to get
the maximum power output from a
source (the amplifier, in this case),
the output resistance of the source
should be the same, or as close as
possible, to the resistance of the
load (the speaker, in this case). For
those of you who haven’t heard of
it, this simply means that the
resistance of the speaker should be
equal to that of the amplifier
output. Typical speaker imped-
ances are 4—8 Ohms—you can get

these values from the associated brochures and
manuals that accompany your sound system. 

Finally, in a scenario of multiple speakers,
positioning each speaker is of prime impor-
tance. Sound, after all, propagates in the form
of waves. Although multiple reflections cause
sound to be heard across all areas, sound trav-
els in a straight path—like light. You should
always consider sound to be similar to light
while positioning the speakers around your
home, with the prime aim to “illuminate” your
living room. This is the easiest way to get it
right, with minimal effort.

So go ahead and enjoy those tracks! 
nash.david@thinkdigit.com
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Stopping Public Access To Printer
I want to protect my office printer from 
unauthorised use. I have a single user account

and all office colleagues use the same computer. Is
there any way to lock the printer?

goldy_connect on Thinkdigit Forum

The easiest to way to block access to print-
ers is to first make sure the users using the

same computer have separate accounts on
Windows. Then, go to the Printer properties by
clicking on Start > Control Panel >
Printers and Faxes. Right-click on your
printer and select Properties. Click on the
Security tab and here you can set which
accounts you want to give access to the printer
and which you don’t. 

System Instability 
I have a desktop with a 19-inch Viewsonic LCD,
160 GB hard drive, Intel Pentium 4 3 GHz, i865g

motherboard with 1 GB of RAM and Windows XP SP2.
Everything has been running fine, but recently I have
some problems. GTA III works fine but NFS: Most
Wanted and Carbon crash! So will a graphics card
solve my problem? I have an AGP slot so what is the
best and cheap solution for it? Should I change the
motherboard and I don’t want to change my proces-
sor! Please suggest a solution for under Rs 10,000. 

bhadkow on Thinkdigit Forum

The problem with crashing could be to do
with overheating components. Check for

CPU temperatures just after running some heavy
games. If your processor crosses 70-75C then that
could be your problem. Clean up you cabinet and
fans. A complete system upgrade would be recom-
mended if you are one who plays lots of games. If
you want something temporarily, you could find
an AGP ATI Radeon x1800 or x1900 line of cards
for around or under Rs 5,000 if you are lucky but
that won’t fix your crashing problems. The
Radeons will run the NFS series perfectly fine.

Kaput BIOS 
My BIOS has gotten corrupted. When my
system boots up, it shows a message saying

“BIOS ROM checksum error” and “Please insert

system disk” (“Award BIOS Bootblocker 1.0” is on
the top of the page). So to correct this I downloaded
the latest BIOS updates from the MSI site. I am
going to get a startup floppy from one of my friends
and flash the bios. Will a startup floppy created on
my friends comp work on mine and will this solve
the problem of the corrupt BIOS? Please help! 

zodiac_511 on Thinkdigit Forum

The BIOS ROM checksum error does indi-
cate the corrupted BIOS. The latest BIOS

update is just a file that needs to be inserted
into the floppy drive. The floppy with the BIOS
firmware on it will work perfectly fine on the
motherboard and should fix the corrupt BIOS.

False Alarm?
When I run Spybot Search and Destroy, it
reports DSO Exploits. It appears to fix them,

but when I run the scan again, it again reports the
same DSO Exploits. Please help me, as I think that
my system is at risk. I am running Windows XP SP2.

Yogesh Bendre

If you have SP2 installed, then you need not
worry about these DSO Exploits warnings

issued by Spybot because they are false alarms.
Spybot removes the vulnerability by changing a
registry value, but unfortunately, even the
changed value continues to trigger this alarm,
even though the Exploit has been disarmed
already. To get rid of this annoyance, you need to
do some registry editing. Navigate to
HKEY_USERS\.DEFAULT\Software\
Microsoft\Windows\CurrentVersion\Inte
rnet Settings\Zones\0. Look for a value
called 1004 in the right-hand pane. The type of
this value should be REG_DWORD and its value
should be 0x00000003. If this value does not
exist, or if it exists but is the wrong type or has
the wrong value, delete it and recreate it with
the correct type and value. Repeat this step for
the other entries listed by Spybot:
HKEY_USERS\S-1-5-18\Software\
Microsoft\Windows\CurrentVersionInter
net Settings\Zones\0
HKEY_USERS\S-1-5-19\Software\
Microsoft\Windows\CurrentVersionInter
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High Definition Queries
What format should HD content should be in—
AVI, DivX, MPEG4? Does Blu-ray use any other

format? What does Java support in Blu-ray mean?
Also, is there a way using which I can convert opti-
cal audio output to, say, 5.1 analog output?

naveen_reloaded on the Thinkdigit Forum

HD content can be stored in any of the
formats—AVI, DivX or MP4. AVI and MP4 are

both containers for the media. Any codec that
supports HD resolutions can be used to encode.
Blu-ray is encoded using MPEG2 or MPEG4-AVC—
or what is more commonly known as H.264. Blu-
ray Disc Java or BD-J is the Java used as the inter-
face to interact with the content on a Blu-ray disc. 

Optical to 3.5mm output convertors are
pretty impossible to find. A DAC could be your
best bet for digital (optical) to analog output
but they are extremely expensive.

Poor Online Latency Issues
I was playing Call of Duty 4 online via BSNL 2
Mbps (Home 1800 plan) connection and was

very happy for a while. Now, suddenly the ping
shoots up to 400 ms while it was only 120 ms
before. Moreover, when I ping a server—even those
in India, the ping fluctuates to over 100 ms.
www.google.co.in gives me a ping of 400 ms. Is there
anyway to rectify this problem?

Amitash on Thinkdigit Forum

If your pings spike up randomly from 
120 ms to 400 ms, then it could be a prob-

lem on your ISP end due to load or bandwidth
shortage. It could also be disturbance in the
line between you and the ISP. If it’s a stable
400ms ping, then it could be the change in
routing by your ISP. That is—your ISP may be
using a different path to send data across the
Internet. Use the command—tracert <Game
server IP> and see the path your ISP has
taken. You could request your ISP to revert back

to the original routing and also ask them to
check line disturbance.

Playback Statistics In Winamp
I use Winamp 5.33 and I want to see the most
played songs and how many times they were

played. How do I go about doing that?
ax3 on Thinkdigit Forum

The Winamp Library is the best way to find
all the statistics for the songs you’ve been

listening to. Winamp can also tell you which
songs from the playlist you haven’t heard at all.
Press [Alt] + [L] with Winamp in focus to
open the Winamp Library.  

IP Hijacking?
I use the Internet through a cable connection
which has a static IP address. Whenever I try

to download from Rapidshare, I get time limitation
warnings such as “Download limit exceeded. Wait
for 80 minutes” or “You are already downloading
a file. Please wait till it is over”. For the last couple
of months I have not downloaded a single file from
Rapidshare. What is the matter? Has somebody
hijacked my IP address? Can I get it back? 

abhijitroy on Thinkdigit Forum

The issue could be with your ISP. It could
be someone logging into your account and

thus gaining access to your assigned IP. Change
your password from time to time if you have to.
If you connect to the Internet through a proxy
server run on your ISP end, then you are very
likely to keep getting that message. Also, try
clearing your browsers cache and cookies.

PPPoE On Windows 98
How to connect to my broadband Internet
connection through Windows 98? I have already

connected to the same broadband using Windows XP
from the same computer. I use the Ethernet port to
connect the modem with my PC. Kindly guide me.

Aanand on Thinkdigit Forum

RASPPPoE is a PPPoE implementation made
for Windows 95 / 98 / ME. Download it and

unzip the files into a temporary folder.
Uninstall any previous PPPoE software that you
may have installed or got with your installation.

Right-click on the Network Neigbhourhood
icon and right click on Properties. Click Add >
Protocol > Add. Click Have Disk and point
to the folder with the unzipped files. Select
the INF file. Select PPP over Ethernet
Controller. Go to Start > Run. Enter
RASPPPoE and the application should run.
Now create a dialup connection using the
selected network adaptor.

E-mail us your computing
problems along with your
contact details and
complete system 
configuration to
ssooss@@tthhiinnkkddiiggiitt..ccoomm, 
and we might answer
them here! Since we get
many more mails per day
than we can handle, it
may take some time for
your query to be
answered. Rest assured,
we are listening!

Get Help Now!

Optimizing Firefox’s Bandwidth Consumption
I use Firefox and it uses way more bandwidth than IE7 and Opera. I have set
the cache size to 500 MB. It seems to take bandwidth to load recently visited

pages despite the cache size. When I open Firefox it restores previous session but
it uses bandwidth to load all the pages again. How do I force it to load from cache?

adithyagenius on Thinkdigit Forum

A lot of users use Internet schemes with data download limitations.
Browsers like Firefox can really redownload many pages and images

despite setting large cache. The problem is on the way pages are designed. A
very good way to cut down on bandwidth is to install a Firefox plugin called
BetterCache—https://addons.mozilla.org/en-US/firefox/addon/6371. Click on
Install now to install the plugin. Restart Firefox then click on Tools >
Add-ons. Click on Options for the BetterCache plugin. Check the radio button
next to Never, under Check pages for acuality. This way Firefox will avoid look-
ing for new versions of the pages or elements. The other solution you could
try is to use a proxy server on your own system which caches pages better. 

All your computing niggles and nags
are dealt with here!

Your Questions, Our Answers

Question 

of the

Month

Q&A April_08.qxd  5/13/2008  12:52 PM  Page 68



Rossi Fernandes

Quake III Arena is one of the best
multiplayer games ever, and
easily one of the most refined

game engines ever made. To make your
very first map in Quake III, you need a
copy of the game (naturally) and
GTKRadiant—which is freely available
for download at www.qeradiant.com.
GTKRadiant is used to create maps for
many games other than Quake III, so
most of these techniques will be help-
ful in other games like Doom 3, Quake 4
and so on.

Configuring GTKRadiant
When you start GTKRadiant for the
first time, you’re asked to point out to
the location of your Quake III folder. By
default, it points out to C:\Program
Files\Quake III Arena. Make sure
you change the path to your installed
path, and remember to specify the
game as Quake III Arena. When
GTKRadiant loads, you will notice that
the interface seems rather compli-
cated. To make things a little simpler,
we will change the layout of the view-
ports to 4 views by going to Edit >
Preferences > Interface >
Layout. Restart GTKRadiant and there
will be three views showing the map
through the X,Y and Z axis and the
fourth one showing a real-time

preview. To use the preview, right click
in the window and use the directional
arrow keys to move around like you
would in the game.

Creating Brushes
Brushes are the building blocks that
make up the structures. The walls, the
floor, the pillars are created with
brushes. To create a brush, simply
drag a sufficiently large box in one of
the three views. In this example, we’ll
make a box and then make it hollow—
like an empty room, but without
windows. To make the box hollow,
click on the Make Hollow button in
the toolbar. The rotate, scale and
move tools can be found on the tool-

bar above. While making the struc-
ture, you need to keep in mind that
there are to be no leaks—no empty
spaces leading outside the map. If
required, make an additional hollow
enclosure outside the main structure.

Adding Textures
A map can’t have one single texture
painted all over—we now need to set
texture for each of these surfaces.
Hold the [Shift] key down and left
click on a surface. Now, click on the
Texture Browser button, or hit [T].
Click on a category of texture from
the left and click on the texture on
the right to apply the texture on the
surface. Depending on the size of the
texture and the object, the propor-
tions will be messed up. To fix this,
start the Surface Inspector—View >
Surface Inspector or [S]. Here
you can select the surface in the same
manner and change the alignment
and tiling for the texture.

Adding Gameplay Elements
Things like weapon ammo, armor,
jump pads and weapons contribute

to a fun-filled map. A spawn
point is the bare essential—
to add one, right click on
the view where you want it
added and select Info >
info_player_deathmatch.
You’ll need many more
depending on the number
of players you plan on
having in your map or you’ll
have all the players spawn-
ing at that single spot.
Similarly, place weapons,
armor and ammunition.
Lights are absolutely neces-
sary unless you plan on

playing hide-and-seek in the
dark. Right-click in the top view
and select Light. You can give it
an intensity and colour here. 

Test Run
To compile, first save the map to
(File > Save). Then, click on
the Build menu and select one
of the compile presets.
Compiling the map can take a
while if it’s very detailed and
has many lights in it. If your
compile fails, there’s a good
chance that there are leaks in
the map—GTKRadiant will tell
you where they are.

To test the map, copy the
compiled .bsp file from the loca-
tion where it was compiled to

your Quake III
Arena\baseq3\maps folder. Start
Quake III. Make sure the pure server is
turned off by typing /sv_pure 0.
Type /map mapname or /devmap
mapname and your map should load.

Packing Up
When you feel you are satisfied with
the results, its time to pack your map
up so you can send it over to your
friends so fragging can commence.
Create an empty folder called Maps
and copy the .bsp file into it. Next,
use a compression tool such as
WinRAR or WinZip and create a ZIP
archive out of the maps folder.
Rename the .zip file to .pk3. Now you
can give your friends the .PK3 file to
be dumped into the BASEQ3 folder of
their installation.

If you are the one hosting the
server, then you can have Quake III
automatically send the map from
your machine. Just make sure the
clients use the command /cl_Allow
Download 1 and you use the
command /sv_AllowDownload 1. 

rossi.fernandes@thinkdigit.com

Create Your First Quake III MapCreate Your First Quake III Map

Changing GTKRadiant’s default viewport layout
is preferable—it makes things 

Every surface you create can be given its own texture

Textures need to be moved into place and aligned
using the Surface Inspector

… it’s not as hard as you’d think!
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net Settings\Zones\0
HKEY_USERS\S-1-5-20\Software\
Microsoft\Windows\CurrentVersionInter
net Settings\Zones\0
and so on (all of the entries in the HKEY_USERS
branch that do not contain the word “Classes”).

Vanishing Space
After using the Automatic Update to install all
the necessary updates for Windows XP, I found

that the free space on my system drive has been
reduced significantly. I remember that this cannot
be accounted by the size of the automatic updates
alone, because I see that more than twice that
amount of space has been gobbled up.

Harish Chaturvedi

Windows downloads all the updates to a
temporary folder and then installs them,

However, it does not delete them after installa-
tion—that is why you find that a lot of your free
space has been lost. Open Windows Explorer and
go to the folder C:\WINDOWS\Software
Distribution. Delete the folder called
Download. This will free up most of the space
that had been occupied. In Windows Explorer, go
to Tools > Folder Options and select the
View tab. Ensure that Show hidden files and
folders is selected. Open the Windows folder.
Locate the $NtUninstall... folders. Note the
name or KB number that follows Uninstall.
Delete the folder. Start the Registry Editor.
Expand SOFTWARE\Microsoft\Windows\
CurrentVersion\Uninstall. Delete the
subkey with the name noted above. Expand
SOFTWARE\Microsoft\Windows\CurrentVer
sion\App Management\ ARPCache. Delete the
subkey with the name noted above.

Prints Gone Wrong
When I try to print a page of a Web site from
Internet Explorer, the text/image at the right

margin is cut off.
Ashish Sharma 

This problem is caused due to a bug in
Internet Explorer, which is not able to deter-

mine the width of the printable area of the page.
The better way to get rid of this problem is by
installing of Internet Explorer 7, which does not
have this bug. If you are unable to do so for some
reason, you can print the page in another
browser such as Mozilla or Opera. You can also
try to use this workaround: Open Internet
Explorer, open the web page you wish to print
and go to File > Page Setup. Set the left and
right margins to 0 and click on OK. Try printing
the page again. If this does not resolve the prob-
lem, then click on File > Page Setup and
change the Orientation setting to landscape.

Dynamic Disk
I have a SATA 120GB drive. It has a primary
and an extended partition. The extended

partition has 4 logical partitions. I added a
320GB SATA drive and created partitions in it.
The new disk shows up as a dynamic disk.
What is a dynamic drive? I was creating an
image of my Ubuntu partition on one of these

volumes and Acronis showed a warning saying
the drive was dynamic. 

Kenshin on Thinkdigit Forum

Dynamic disk is a type of initialisation that
is done by Windows. Dynamic disks provide

advanced features and volume management as
compared to basic disks. The Dynamic Disk must
have been initialized when you created parti-
tions for the drive formatted them. Converting a
Basic disk to Dynamic is possible without losing
any data using Disk Management feature in
Computer Management. Click on Start >
Control Panel > Administrative Tools >
Computer Management. To convert a Dynamic
disk back to Basic, you will need to remove all
the volumes on the disk which means you need
to back up all you data on these partitions. Right-
click on the disk you want to convert and click
Convert to Basic Disk.

Dead Links
I have been facing a weird problem—hyper-
links that are in my e-mails in Outlook Express

do not open when I click on them.
Arshpreet Kaur

Make sure that you have a default Web
browser configured. To make Internet

Explorer the default browser, open Internet
Explorer and go to Tools > Internet
Options. Click on the Programs tab. Ensure
that Internet Explorer should check to
see if it is the default browser
checked. Close Internet Explorer and reopen it.
When you see the message “Internet Explorer is
not currently your default browser. Do you wish
to make it the default?”, select Yes.

Disable any third party pop-up blocking soft-
ware that may be running on your computer.

You may also need to repair the file associa-
tion for hyperlinks in the following way. Open
Windows Explorer go to Tools > Folder
Options. Click on the File Types tab and locate
the entry named URL:HyperText Transfer
Protocol. Click on Advanced.

Select open and click Edit in the Edit
File Type dialog box. Make sure that the
field Application to perform this action
contains: C:\Program Files\Internet
Explorer\ iexplore.exe -nohome (if your
default browser is Microsoft Internet Explorer)
or C:\PROGRA~1\MOZILL~1\FIREFOX.EXE -
url “%1” (if your default browser is Mozilla
Firefox.) Please note: These paths may need to
be modified if IE or Firefox are not installed in
the default locations. Also keep in mind that
the 8-character short path needs to be used for
Firefox. The Use DDE box must be checked and
the DDE Message: must be: “%1”,,-1,0,,,,, (or
“%1”,,0,0,,,, for Firefox.). Also ensure that
Application: is set to: IExplore (for Microsoft
Internet Explorer) or: Firefox (for Mozilla
Firefox.) Ensure that DDE Application Not
Running: is blank. Ensure that Topic: is
WWW_OpenURL.
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There was a time when your beloved
agent dropped his beloved cell
phone, and then his beloved was

no more. Thus began the hunt for a new
beloved, but this time I couldn’t afford
to spend a lot (no more than 5,000
bucks). So I began my hunt for a cheap,
yet feature-rich cellphone (does it even
exist?), and I was joined in this quest by
my faithful sidekick… err friend, who to
his credit dropped his phone into his
shaving mug! Our adventures took us
from shops in Nerul and Vashi (Navi
Mumbai) to the dusty, teeming streets of
the western suburbs of Mumbai. 

Buying a cell phone isn’t easy, espe-
cially when money is a serious limiting
factor, and manufacturers compete a lot
in this segment—where features like
expansion, Bluetooth, FM radio, MP3
support and decent cameras are key
words, and one little omission may
mean a product that is a market failure.

I’d heard of the new Chinese cell
phone wave that has swept across the
country. Manufactured on the cheap,
these cell phones largely look alike

(with a few exceptions), with number
keys and a large four way directional
keys and centre key all on the front
facia. Their screens range from 2.2 to
3.0 inches, and nearly all of them have
touch screens. These devices are based
on their own proprietary firmware
and I’m pleased to report that the
menus are rather intuitive.

I was curious to know why exactly
these devices are so cheap (Rs 5,000 to
7,500). If a Nokia or Sony Ericsson
phone were to have all these features,
the price would be no less than 
Rs 15,000. Well, Chinese manufactur-
ing processes are much cheaper for
one. Secondly, these phones don’t have
any specific brands, and there are no
advertising / marketing costs involved.
Equally to blame for their cheap prices
is our government—yes, for once our
legislature has actually favourably
affected prices! You see, such phones
are carted over the border—smuggled
in—and so no duties are paid on them.
But this is a double-edged sword—with
cheaper prices, you also lose out on a

bill, and warranty. Oh yes—your war-
ranty lapses as soon as you walk out of
the shop door with one of these
phones. Vendors of such phones are
quick to point out that they’re
repairable both on the software and
hardware level. Of course, the quality
of such a service is at best dubious.

We came across many such phones,
the peculiarity being that the model
number is only written on the box, and
not printed on the device itself. Also,
some phones don’t have any model num-
bers written anywhere! Infinity was one
such branded device at Rs 4,500, with a
touchscreen, FM radio, Bluetooth, MP3
playback and expansion. Other model
names were downright weird like the
0078 priced at Rs 4,000. Yet another
model the CT200 was priced at Rs 6,000,
and seemed to have a better build quali-
ty. From chats with previous owners of
such phones, we discovered some people
who were very happy with their devices
and happily reported trouble free serv-
ice, but a few people have had problems. 

Coming to the branded stuff, we
came across a model called Bleu 151X for
Rs 1,300. Nokia has a list of phones in
this price bracket—the very basic Nokia
1200 (monochrome display, no FM radio)
for Rs 1,350 and its colour equivalent,
the Nokia 1208 (Rs 1,800), the 2630 (with
MP3 support, FM radio) for Rs 3,200. A lit-
tle higher up, the Nokia 3306 comes
with MP3 playback, 1.3 MP camera,
colour display and  memory expansion
for Rs 4,900. The basic Sony Ericsson
J121i was quite popular, good music, and
a nice screen for just Rs 1,800. All these
phones come with a one-year warranty.
From Motorola, we came across their F3,
which is very basic at Rs 1,140, and the
W205 priced at 1,650 bucks. The cute
flap-based W220 was priced at Rs 2,600,
while the W375 was priced at Rs 3,300—
two screens but no expansion. 

We were very tempted to throw cau-
tion to the wind and go Chinese—the
features that their cell phones have are
serious value for money. My only issue
was warranties. Peace of mind makes a
difference to me, so I ended up shelling
out 4,800 bucks (bargained for a 100
buck discount) for the Nokia 3306—I
gave up a number of features mainly
because all I needed my phone for was
to make calls and the odd SMS. My
friend decided on the cute and compact
Sony Ericsson J121i, and when I teased
him about the Chinese phones and
what he was giving up he simply told
me that he’d buy one after I took the
plunge. Which won’t be for a while
now—I bought a rubber phone cover—so
this time my beloved is well protected
from the daily bustle of urban life.

agent001@thinkdigit.com
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Cheap Mobility
Agent 001 goes on a hunt for an inexpensive

phone—and stumbles across some good alternatives

Ashwini Baviskar
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Sound Buy
I am planning to buy a PMP which has voice
recording and FM radio. I wish to purchase

Apple’s iPod Touch but I am unable to get my hands
on it. My budget is Rs 13,000.

Anirudh Jain

Firstly, Apple’s iPod Touch doesn’t have
support for FM Radio or voice recording.

If you want a touchscreen with the functions
you’ve mentioned, I suggest the Cowon D2. It’s
not as flashy and doesn’t have as big a screen,
but what it does have is terrific performance,
with unmatched features. At under Rs 10,000
for the 4 GB version, the D2 is your best bet. It’s
also expandable.

Phone Call
I am looking for a cellphone, and these are my
needs: Net browser xHTML / HTML, 3G, Screen

(320x240), FM radio (stereo), fast processor (200
MHz or more), video player, 2 MP camera. My budget
is Rs 14,000.   

Arnav Sengupta

I suggest you take a serious look at
Nokia’s N73 Music Edition. At Rs 14,000,

it will give you strong multimedia capabilities
with a 3.2 MP camera, good music playback,
and 2 GB of storage via MiniSD that is bundled
with the phone. 3G browsing is a sad misnomer
in India, and the browsing speed will be bot-
tlenecked by your service provider and not your
GSM handset, so I suggest you forget about this
feature—it’s useless for now.

Plug And Play
I want to buy a pair of earphones for around 
Rs 1,500 for my Sony Walkman. I would prefer

Sony earphones but others will also do. I have a Sony
NW-E003F Walkman.

Nikhil Sonthaliya

For in-ear type earplugs I usually suggest
Creative’s EP630. These earplugs have

become very common and at Rs 900 they offer
terrific value for money. I’ve used them myself
and must say that for the price, the performance
you get is pretty good. Beware of duplicates
though—their popularity has spawned counter-
feit look-alikes. Please insist on a bill when you
do purchase them. 

Board Games
I’d like to purchase a motherboard. But I am con-
fused whether to go for an Intel- or NVIDIA-

based motherboard. My basic need is a good onboard
graphic support. I’d also like to know about the per-
formance and onboard graphics of the chipset
designed by Abit.

Jidnesh Chaudhari

Abit is a motherboard vendor like ASUS,
MSI, Gigabyte, Foxconn, etc. They do not

manufacture onboard graphics chipsets. Since

Want a tech product, but
don’t know how to go

about buying it? E-mail
agent001@thinkdigit.com

with your complete 
contact details, and he

might answer them here!
Please note that

Agent001 only answers
purchase-related

questions in this space.

Ask Away!

Ask Agent 001

you mentioned Intel, I take it you are going for
a system based on an Intel Core 2 Duo
processor. In that case, NVIDIA has better
graphics solutions than Intel or AMD. The new
GeForce 7050 is a good onboard solution.  I rec-
ommend MSI’s P6NGM based on their GeForce
7050 chipset. It’s priced at Rs 4,800. I suggest
you also look at 2 GB of system memory since
the onboard solution will hog some main
memory for video purposes.

Top Choice
I need a laptop with the following uses and
parameters in mind: basic office work, watching

movies, music, browsing, basic gaming. My budget is
Rs 50, 000. I want a minimum of 1 GB RAM and a 
160 GB HDD, webcam and DVD writer. Lastly, is it safe
to buy a laptop in SP Road, Bangalore?

Ashwin S

Your best bet seems to be Dell, and con-
sidering that all Dell laptops ship from

Bangalore you’re well covered if you’re in the
city. Dell also has a very cool five-year warranty.
Regarding your preference, you haven’t men-
tioned the size of screen you want or the
processor. I am assuming a 15.4-inch screen.
I’m also going by the assumption that you’ll
stick to Windows Vista, and opt for 2 GB of
memory in lieu of 1 GB. The Dell Inspiron 1525
comes to Rs 38,000 with a 2.0 GHz Core 2 Duo
processor and 2 GB of RAM. If you want to
spend more on something faster and more
slick looking, the Dell XPS 1530 will come to
Rs 52,000 with the same processor and a 128
MB GeForce 8400GS graphics card that will
handle casual gaming easily. Both laptops
come with DVD writers and 2 MP webcams, so
all your needs are covered.

Right Mix
I’m upgrading my PC with a Quad-Core
processor, Gigabyte GA-P35-DS3R motherboard,

2 GB RAM, a Palit 8800GT card. I’m confused about
QX6700 and Q6600 processors, which one is better?
Which is better—the quad core ‘QX’ or ‘Q’? And ulti-
mately the power supply—is 550 watts sufficient?
Please give the prices also. You can change my con-
figuration if you feel something better is available.

Zubair Mustahid

The QX6700 (2.66 GHz) is an Extreme Edi-
tion and while it is a faster processor it’s

also insanely expensive. The newer Q6600 (2.4
GHz) is also available and it’s also reasonably
overclockable. A 550 W power supply from
CoolerMaster or Antec should suffice, but I rec-
ommend a little more juice just to be on the
safer side, especially if you plan on more than
one HDD. Look for CoolerMasters eXtreme
Power 650W or Antecs Trio 650 watts. Go for
800 MHz DDR2. For the motherboard, I recom-
mend the Abit IP35-E, for Rs 7,500—superb
value for money. Your choice of graphics card
is good—stick to it.
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At times, downloading, installing and uninstalling several programs
could lead you to a confusing and dangerous situation. When
you’re on a hard drive cleaning spree, you might be wary of

deleting an important OS file instead of a junk one. Using Task Man-
ager also doesn’t serve the purpose. So what do you do when you come
across a file with a weird name? We introduce you to WhatIsThatFile.com
which helps give you
more details about that
weird sounding file name.

This service will help
you know about the thou-
sands of files that reside
on your hard drive and run
with the OS-and the ones
that stay dormant. If you
search for these files in
Google, you may not get the expected result-the engine is an algorithm,
after all. Again, at times, your anti-spyware and antivirus programs may
not be as secure as you think. The possibility of malware files residing
on computers are high for those who stay connected to the Web.  

Functioning like a mini-wikipedia sort of a database, the site allows
you to edit information. In case you don’t find information about the files
you’re looking for, then just submit its inclusion. 

Being community driven, a 100 per cent guarantee of accurate infor-
mation cannot be expected. But the site keeps you updated about pop-
ular viruses, malware and Trojans. However, the home page could’ve
been better if the Google ads weren’t placed right on the top and
bottom—which may distract you. One can also contribute by checking
the to-do list database and help users identify unknown files. A nice
resource to clarify your doubts about certain files, add more knowledge
about them and also keep your hard drive clean!

Summer School
Digital Tools l 3 Incredibly Useful Sites

A
re you looking for free educational media online? Log on
to openculture for educational audio books, podcasts,
videos, free online courses, etc. The site is a free library of

educational and cultural resources. 
Want to learn a foreign language for free? No problem;

open culture will lead you to several podcast lessons for
you to pursue online education. There’s a library of pod-
casts on technology, culture, foreign languages, literature,
law, etc. available. 

Like any other educational resource site, openculture too
offers digital books that will increase your educational quotient.
You get additional help on how to download podcasts and
videos on your iPod. It’s a site carrying varied collected
resources available for free from the Web so that you need not
waste time searching for the obvious. You also get details of various
courses being offered at various global universities. 

This is a nice place to look for free media resources which can
be downloaded and used as per your convenience.

WhatIsThatFile (www.whatisthatfile.com)

openculture (www.openculture.com)

DIGIT APRIL 2008

Linkbun.ch (www.linkbun.ch)

Post examinations, students would want to enjoy
mailing, chatting and surfing. Holding several links on
the same topic like Photoshop or PHP tutorials is

always convenient for later reference. Enter Linkbun.ch,
which functions as its name indicates—it bunches links.
Imagine—you don’t have to remember URLs of 20 favourite
sites but simply a short and sweet URL!

You might’ve seen us using TinyURL or SnipURL for
shortening long links. Linkbunch takes several URLs and
bunches them into one single and short URL which remains
active for a long period. At the homepage there’s a box
where you’ve to paste all your links and press “Bunch”. 

The key feature of Linkbun.ch lies in its “no automatic
redirection” function where you can access a bunched page
with lots of links. This totally eliminates the possibility of
being redirected to a malicious site. 

Firefox fanatics can also download the Linkbunch’s
Firefox extension from http://linkbun.ch/linkbunch.xpi (check
http://xrl.in/18v for how to install) to bunch their links on the
go. The only thing that site needs to add is editable or pre-
customisable links for the bunch any user wishes to create.
It is a totally free site with no sign-up hassles. Here is a sleek
resource and collection storage maker for Web crawlers who
care for every byte from their bandwidth! 

Samir Makwana

Even more educational material for your grey cells this month
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LINUX MINT

Today we’re looking at Linux Mint
(www.linuxmint.com), another distri-
bution derived from Ubuntu Linux.

They claim it’s very user friendly but it’s
also very appealing in looks. While most
of the tips today were tested on Linux
Mint, they will still run perfectly fine on
your Ubuntu installations as well. 

Restarting Gnome
Rebooting an operating system to

get changes to come into effect is irri-
tating because it’s really slow and most
of lack patience. When you’re busy
tweaking and want Gnome to be
restarted every few minutes, you can
restart it without rebooting the entire
system. Save your work first and then
press [Ctrl] + [Alt] +
[Backspace]. Gnome will restart and
you’ll be returned to the login screen
without rebooting within moments. 

Automatically Logging Into
Your Distribution

Linux Mint and even Ubuntu have the
option of having your user name automat-
ically logged in when your PC boots up.
That way, you don’t have to enter your
user name and password every single
time. It’s also useful when you use remote
desktop to login to Linux and the VNC
server can’t be accessed until you login. 

In Linux Mint, click on the Start
button and then click on
Administration > Login Window.
Enter your password and then click on
the Security tab. Check the box for
Enable Automatic Login. Use the
dropdown menu to select the user to be
automatically logged in. 

Changing The Login Screen
Theme

There’s no denying that the login screen
on Linux Mint looks very nice indeed.
After a while, it gets boring and is
always better to have a fancy theme
greet you during login. Click on the
Start button. Next, click on
Administration > Login Window.
Click on the Local tab and you can
choose one from among the many
themes in the list. A custom welcome
message can be set using the text bar
below. Sites like www.gnome-look.org,
http://art.gnome.org/ and www.cus-
tomize.org have a large collection of
themes, which you can download. Look
specifically for GDM themes. New
themes can be installed by clicking the
Add button and browsing to the loca-

tion of the theme. Click Close when
you are done.

Enable Complete Previewing
Of Files In Nautilus

When you’re using Nautilus to browse
files, especially ones on a network, you
may notice that some of the files do not
generate previews like they do on your
hard drive. This is because, by default,
Nautilus only generates previews for
local files. There is another limitation—
only previews of local files smaller than
5 MB are generated. 

To change these default settings,
start Nautilus and then click on Edit >
Preferences. Click the Preview tab.
Here, you can change the values in the
dropdown menu from Local Files
Only to Always to Have previews
generated for all locations.
The limitation for files of certain sizes
can be disabled by clicking on the drop-
down for Only for files smaller
than and Set the size from 5 MB
to something larger. Click Close
when done.

Remotely Accessing Your Linux
Desktop

Say you’ve installed Linux Mint on a
spare unused machine but don’t have 2
monitors, you can use remote desktop to
access the machine through a network.
Remote desktop runs on VNC, so you
can use any VNC client to connect to
your server. TightVNC www.tightvnc.com
is one VNC server/client that can be
downloaded for free. You can also
choose to download just the viewer. 

To enable remote desktop, click on
the Start button. Next, click on
Preferences > Remote Desktop.
Check the Allow other users to
view your desktop checkbox and
the one to Allow users to con-
trol it. If you want to have a password
to be entered for security reasons, you
can enable that too. By default, you
need to authorise the user to be
allowed access to the desktop, so dis-
able the checkbox for Ask you for
authorization.

SECRETS THAT KEEP YOU AHEAD IN THE RACE

TIPS
Linux Mint  . . . . . . . . . . . . . . . . . . . . . . 63
Deluge  . . . . . . . . . . . . . . . . . . . . . . . . . 65
Safari For Windows . . . . . . . . . . . . . . . 67
Total Commander Ultima Prime  . . . . 69

30 MINUTES EXPERT
Compiling From Source  . . . . . . . . . . . 66
andLinux  . . . . . . . . . . . . . . . . . . . . . . . 68

A variety of login screen themes are present
in Ubuntu and Linux Mint

Remote Desktop can be set up to allow secure
remote control of your Linux PC
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more importantly, support for plug-ins.
We’re using the latest 0.5.8.6 version on
Windows and we’re looking for some of
its features that can come handy while
migrating to it and some others that
match the features in other clients.

Getting Deluge On Linux
Deluge most likely doesn’t come

installed with the distribution so you’ll
have to download it. You can download
it from www.deluge-torrent.org. If you’re
on Linux search for Deluge using a
package manager such as the Synaptic
Package Manager. Check the box and
click on Mark for installation.
Click on Apply to have it downloaded
and installed.

Running Deluge In The System
Tray

Deluge like other applications such as
download managers, instant messenger
and BitTorrent clients can be run in the
system tray all the time. To enable or
customize the way Deluge runs in the
tray, click on Edit > Preferences.
Click on the Other tab and make sure
the checkbox for Enable system
tray icon is enabled. Clicking on the
Start in Tray checkbox will put
Deluge in the system tray when you ini-
tialize it. You can even assign a password
to make sure no one else can open
Deluge. Click the Password protect
system tray checkbox and enter a
password. Click OK to save the changes.

Tweaking Connection Settings
For Your Speed

BitTorrent clients need to be tweaked
and set up right or you end up with very
bad speeds. Upload speeds need to be
high as well, to get a proportionate
download speed. Click on Edit >
Preferences and then on the
Bandwidth tab. Here, you can make
changes to the number of connections
being made by your BitTorrent client.

You can also set the number of simulta-
neous downloads. If all this is rather
confusing, you can also use the wizard
which asks you for your connection
upload speed and sets all the other
parameters for you. Go back to the main
Deluge interface and click on Help >
Run Configuration Wizard.

ISPs can also try and throttle down
BitTorrent clients and every single
BitTorrent client has been implementing
features to try and bypass this. Deluge
too has an encryption feature that can
be enabled by clicking on the Network]
tab under Preferences. Select the
dropdown menus for Encryption for
Inbound and Outbound as Enabled.
If your ISP blocks certain BitTorrent
ports, making changes to the default
port range of 6881 to 6889 to something
else can help too. Clicking [Random
Ports] will set a random port every time
Deluge is run. If you want to check if the
port is open and accessible from the
Internet, click the Test Active Port
button. A page with the result appears.
Click OK and restart Deluge.

Downloading Select Files
When a torrent contains a folder or

multiple files, you’ll notice that you
aren’t able to select just a few files for
downloading like you would in other
clients such as µTorrent. To select spe-
cific files, click on Edit > Preferences
> Downloads. Leave the checkbox for
Enable selecting files for
torrents before loading checked.

Automatically Download
Torrents

Deluge can automatically download tor-
rents that have been put into a folder—
you need not open every single torrent
to make Deluge download it. To enable
this feature, first create a folder where
all your torrents will be placed. Click on
Edit > Preferences > Downloads.

Start up the Package Manager
through the Start button. Search for
gnome-splashscreen-manager using
the Search button. Check the box for it
and choose to install the application.
Any dependencies required can be down-
loaded too. When installed, press [Alt]
+ [F2]. Enter gnome-splashscreen-
manager. Click on the Install button
and browse and select the image that
you want to use as your splash screen.
Click Activate after choosing the
splash screen of your choice.

Autocomplete Search In
Terminal Or Console

A complete history of all the commands
is stored in a file in your home directory
called .bash_history. Linux already
has autocomplete that you can use by
pressing the [Tab] key while entering a
command. A more useful feature is the
find feature, which gives you the closest
search result from the history. That way,
you can type large commands that you
normally wouldn’t remember. To use
this feature, press [Ctrl] + [R] and
then start typing the command. As you
type, the closest result from your history
will be displayed. Press [Enter] when
you have the right command.

Adding Visual Tags To Folders
In Nautilus

Nautilus allows you to tag folders or files
using artwork called emblems. Start

Nautilus and go to Edit >
Backgrounds and Emblems. Click on
the Emblems button and then drag and
drop emblems from the list to a file or
folder of your choice. 

You can also import your own custom
emblems by clicking on Add a New
Emblem. Enter a new keyword and click
on the Image button. Choose from one of
the existing images or click on Browse to
select a different image. Click OK.

DELUGE

Deluge is a BitTorrent client that
runs on Windows, Linux and
MacOS X. It’s not as small as

µTorrent (which Windows users adore)
but it still has loads of features and

Tags can be added to any file or folder by a
simple drag and drop action

Tags can be added to any file or folder by a
simple drag and drop action

Other than setting the connection speed and
ports for your connection, enabling encryption
can also help achieve higher speeds

Stop Your PC Speaker From
Beeping

Speakers will beep and they will beep
every time there’s an error or alert that
occurs. These can be very disturbing to
the user and others around. The speaker
can be turned by a simple command
that you can type in a terminal or at the
console—modprobe pcspkr. Should
you decide that you need the speaker
again, you can turn it back on by
entering rmmod pcspkr.

Using Better Smoothing
Like Windows, where LCD users

choose ClearType fonts for LCDs, Linux
too has a font smoothing option that
can be used. Go to Start >
Preferences > Appearance. Click
the Fonts tab on the top and select
the Subpixel Smoothing fonts on
the bottom-right. Click OK. More
advanced settings for the font
smoothing can be changed by clicking
on the Details button.

Moving The Mouse Cursor
Using The Keyboard

There are those rare occasions when
your mouse is not detected or stops
responding. You can use the Num pad on
the keyboard in Ubuntu, to move your
mouse around. Press the [Ctrl] +
[Shift] + [Num] Lock keys to enable
this mode. Now use the direction keys
on the Num pad to move the mouse
pointer. Use the + sign to single click, 0
to right click and [Enter] to execute a
program. Press [Ctrl] + [Shift] +
[Num Lock] again to disable it.

Restarting X And Killing
Applications

If due to any changes that you make or
any stability issues that you maybe
facing, restart the X server. A quick way
to do this is to press [Ctrl] + [Alt] +
[Backspace]. 

Delete Files Permanently
Nautilus sends all deleted files to

the Trash by default. Pressing the [Del]
key normally sends files to the Thrash.
To permanently delete files, bypassing
the Trash, the best way is to hold the
[Shift] key and then press the [Del]
key or right click on the file and select
Delete. If the option isn’t available,
start Nautilus. Go to Edit >
Preferences > Behavior. Make sure
the box for Include a Delete com-
mand that bypasses Trash is
enabled. Click Close.

Switching Virtual Desktops
Quickly

Linux distributions have had virtual
desktop from a very long time. They are
useful to categorise and use each

desktop for a different task. That way
you can have all your messengers in one
window, browser windows in another
and so on. The quickest way to switch
virtual desktops is to hold down [Ctrl]
+ [Alt] + left arrow or right
arrow. The left arrow takes you to the
previous desktop and the right arrow
takes you to the next. You can also move
applications from one workspace to
another by right clicking on the titlebar
of the application, choosing Move to
Another Workspace and then
selecting the workspace.

Quick Run Applications
Windows users know the

[Windows] + [R] shortcut all too
well. It’s a quick way to run applications
but Linux Mint and Ubuntu Linux users
have a similar feature they can use. Hold
down [Alt] + [F2]. Here you can type
in the name of an application or loca-
tion of a folder. You can also choose

from a list of applications to run. Click
on [Show list of known appli-
cations] and you can choose one of
the many installed applications to run.

Viewing Folder Trees
In Nautilius, files are displayed like

in any other file manager. Nautilus has
an option where all the sub-folders and
the files can be displayed as a tree some-
thing similar to what Windows Explorer
does to machines on a network. First,
change the view mode to details by
clicking on View > View as List or
by pressing [Ctrl] + [2]. To open up a
tree, click on the triangle on the left of
the folder.

Installing A Splash Screen
A custom splash screen can be used

where all the different modules load
when you log into X. For this, you can do
things the hard way but the simplest
way to download a tiny application
called gnome-splashscreen-manager. 

Easter Eggs

The Book of Mozilla!
Firefox like any other browser has the [about: address] that can be entered. For
example, [about:config] loads up the advanced preferences windows where
values for all the variables in Firefox can be accessed. Enter [about:mozilla] and
you will see an extract from “The Book of Mozilla”. The entire list of extracts can be
viewed at www.mozilla.org/book/

Aptitude Easter Eggs
Aptitude is an easy interface for package man-
agement. There are a few Easter eggs hidden
inside aptitude. [apt-get moo] should give
you a funny little cow as ASCII art. Next, try
[aptitude moo], then try [aptitude -v
moo]. Keep adding an additional [v] to the
earlier parameter and you’ll get a funny
sequence of messages.

Something fishy about Gnome
Gnome has an Easter egg, which is a fish that

swims about on the screen. The only way you can actually see it, is by pressing [Alt]
+ [F2] to get the [Run Application window]. Enter in, free the fish and
click [Run]. A small fish will appear from one corner of the window, making its way to
the other side. Click on it and it will dash back again from where it came.

apt-get’s ASCII cow

The Run Application box allows applications to
be executed quickly

gnome-splashscreen-manager lets you set a
custom splash screen
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Click the checkbox for Autoload all
torrents in and then click the drop-
down menu and choose Other. Using
the file browse, navigate to the folder
and click Open.

Plug-ins
To keep resources consumption to

a minimum, Deluge has almost all of
the plug-ins disabled and so only the
very basic features are available to the
user. To enable any of these features,
click on Edit > Preferences > Plug-
ins. All the plug-ins associated with
Deluge are available here and can be
enabled by clicking on the checkbox
next to the plug-in name. Here are some
of the most useful plug-ins and how
handy they are.

Web User Interface
Deluge—like µTorrent and Azureus—

can be controlled through a Web
browser. Enable the Web User Interface
plug-in from the list by clicking on its
checkbox. Click Preferences and set
the port and the password. You can also
choose a template and button styles here.
Click OK once you are done. 

To access the Web interface, open
your browser and visit the URL

http://Your_Machine_IP:8112. If you have
already changed the port, then use the
new port number instead. Enter your
password and click Submit. You can
now control pretty much everything in
Deluge from here.

Scheduler
With the help of the Scheduler

plug-in, it’s now possible to be slow
down or stop the torrents from down-
loading altogether between a given time
period. Enable the Scheduler plug-in and
click on the Preferences button. In
the chart displayed, click on the time
slots once to make it yellow and then
again, to make it red. The yellow blocks
limit the speed and the red completely
halt download. Before closing the

window, set the limited speeds for down-
loads and uploads, then click OK.

If you just want to be able to cap
speeds of specific torrents on demand,
you can do so by enabling the Speed
Limiter plug-in. You can now right-click
on a torrent and click on Torrent
Download Speed and Torrent
Upload Speed.

FlexRSS
RSS feeds are a great medium for

receiving quick updates from a site or
service. The FlexRSS add-on allows users
to receive RSS feeds from sites. These
updates are used by the Deluge so it can
download any file from that site without
the user having to manually download
the torrent and then start it. After
selecting the FlexRSS plug-in, click on
Preferences. To add a new entry, click
on New. Enter a name for the feed, the

URL and the interval after which it is
refreshed. Next, click on Filters. Here
you can adjust the scope, so that only
the selected files are downloaded. Give
the filter a name and then under pat-
terns, enter the name of the files that
you want Deluge to look for. Click Add to
add any more keywords to look for. Click
Save then ready. 

Torrent Search
The torrent search plug-in allows

users to look through multiple torrent
sites. Check the box for the Torrent
search. A small search textbar will
appear on the toolbar of the Deluge
window. Click on Preferences to add
your own search engines. Enter a name
for the search engine or site and then
enter the URL for the search itself,
which you can find on the site. Use the
URL, but replace the search keyword
part to ${query}. Click Add to add the
new search engine. Click OK. You can
now use the dropdown on the search bar
to select your search engine.

Network Activity Graph
The network graph is a missing fea-

ture, but like the others, it can be
enabled through the plug-in window. The
network activity graph feature is one of
the better graphs you can find in a
BitTorrent client and this one can be cus-
tomized as well. Check the box for
Network Activity Graph and choose
Preferences. Here you can set the
colour for the graphs and even the trans-
parency. The graph can also display the
maximum recorded speed and a line that
shows the average speed in real time.

SAFARI

Apple has a handful of software
such as QuickTime and iTunes on
Windows for some time now. The

latest one to arrive—a Beta version of

New Tab
Close Tab
Mark Page for SnapBack
Page SnapBack
Downloads
Show/Hide Bookmarks Bar
Add Bookmark
Next/Previous Tab
Preferences

[Ctrl] + [T]
[Ctrl] + [W]
[Ctrl] + [Alt] +[K]
[Ctrl] + [Alt] + [P]
[Ctrl] + [Alt] + [L]
[Ctrl] + [Shift] + [B]
[Ctrl] + [D]
[Ctrl] + [Shift] + [ / ]
[Ctrl] + [,]

Safari Shortcuts

Deluge can use RSS feeds to automatically
start downloads of the latest pod cast
releases for example

The Scheduler plug-in can be used to throttle
you’re your downloads during specific time
periods

Many of Deluge’s functions can be made
accessible remotely using the Web User
Interface plug-in

Compiling From Source In Linux
Ever been too scared to install a program that wasn’t an RPM or DEB?

Bhaskar Sarma

In Windows, installing software is a
matter of clicks. In Linux, however,

there are quite a few ways to skin the
cat. Depending on the distribution
you have, software can be downloaded
in the form of either RPM or Deb pack-
ages. Again, you can compile software
directly from source code—download
the source code which comes in a tar-
ball, unzip it and then compile it. In
fact, this is the way source packages
were distributed in the old days, and
you might still have to go by this
route in some cases.  

However, to most people out there,
compiling from source still feels like
voodoo. Here is a quick guide to all
that you need to know about com-
piling from source and what goes
behind the scenes, without leaving
anything to chance.

Unpacking
Command to use: [tar xvzf
mypackage.tar.gz] or [tar xvjf
mypackage.tar.bz2]

This is the first thing to be done
when you download the software. All
the source files, associated libraries
and documentation are distributed as
compressed archives called tarballs.
They are compressed using either gzip
or bzip2, and hence the different
extensions and the slightly differing
switches used in the command. 

After unpacking, a directory will be
created with the name of the package
in the destination folder. Change the
directory using cd mypackage and
then use ls to explore the directory
tree. Make sure to read the readme,
install and other documentation. Some
packages might need some additional
libraries or might suffer from depend-
ency issues, so it makes sense to know
what’s needed. 

Configuring
Command to use: ./configure

After you have unpacked the tar-
ball and have also solved any depend-
ency issues by installing required
libraries it’s time to go to the next
step: configuration. You have to run
the command while inside the
installed package directory. This com-
mand does not change anything sub-
stantially. It basically does a house-

keeping job, checking whether all the
required resources in the form of
system libraries are present and then
assigning values for system dependent
variables. Various switches can be used
along with the ./configure com-
mand to change the behaviour of the
program. For example, appending
-quiet would stop printing the
checking… messages during the con-
figure process. If you know what you
are doing you can use -no-create to
inspect the output files before they are
created. Using -prefix=mydirec-
tory you can change the path where
the Makefile will be created. The
sample output of a configure com-
mand will look something like this:
creating cache ./config.cache 
checking for extra
includes... no 
checking for extra libs... no 
checking for a BSD compatible
install.../usr/bin/install -c 
checking whether build envi-
ronment is sane... yes 
checking whether make sets
${MAKE}... yes 
checking for working
aclocal... found 
checking for working auto-
conf... found 
checking for working
automake... found 
checking for working auto-
header... found 
checking for working make-
info... found 
checking for a C-Compiler...  
checking for gcc... gcc 
…
creating Makefile 
creating kdevelop/Makefile 
creating po/Makefile 
creating kdlgloader/Makefile 
…
creating config.h 

After the ./configure command
has run—during which you will see a
bunch of messages scrolling up the
screen in rapid fire sequence—a
Makefile will be created. This Makefile
is then used to build the binary which
then needs to be installed.

Building
Command to use: make

The make command uses the
Makefile to create installable binaries.
Binaries are the Unix equivalent of exe-
cutables, or .exe files. The make com-

mand is time consuming and results in
a whole bunch of messages scrolling
across your screen. This part is going to
take a lot of time, depending on the
package being compiled as well as the
system configuration. There will be
another bunch of messages scrolling
across the screen, sometimes with
warnings about some resource being
absent. If all is okay, it will display the
command prompt. If however, there is
some problem it prompts you with
appropriate status messages. 

Most of the errors in the compila-
tion process are due to missing or
incompatible libraries. Say you have a
software that depends on GTK+, with
the latest version not present. You
might then have to download it from
the Web. For the most part, if your OS
is new you won’t have any problems.
However, you can always search soft-
ware repositories provided by your OS
vendor. Look for development versions
which end with –devel. 

Installation
Command to use: make install

The make install command is
the equivalent of point and click rou-
tine on Windows. The installation time
will again depend on how big the soft-
ware is. Before doing this, you need to
log in as root. Since you have followed
the best practices and have up till now
done everything from a user account
type su (sudo for Ubuntu) and enter the
root password. After getting adminis-
trator privileges use this command to
install the software. You will have no
glitches and every thing will work out
fine. Don’t forget to log out by using
exit when you are done. 

The program will be usually
installed in /usr/local/bin (check
our Know More About on Linux Directory
Structures in the February issue for
more details). However, if you have spec-
ified a path during the configuration
process, you will have to navigate to
that directory to access the program. In
most modern Linux distributions, you
will see a graphical shortcut and will
have to click there to launch the pro-
gram. It’s that simple, really.

Oh, and if you need to uninstall
the program just delete the binaries.
In some cases, you could use the make
uninstall command to uninstall the
program. Get cracking. n

bhaskar.sarma@thinkdigit.com
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Safari—a few months back is now finally
out. We took a closer look at the latest
version—3.1, which just arrived a couple
of days ago. 

Setting The Right Font
Smoothing 

Anyone who has used a Mac will tell you
that the font smoothing and rendering
on Apple Macs is really something.

Safari tries to bring similar font
smoothing to Windows. While some
might find the fonts very pretty, some
find it rather distracting. To change this
setting, click on Edit >
Preferences > Appearance. Use
the Font smoothing drop-down and
select Standard if you want the effect
turned down to minimum. The default
setting—Medium is generally preferred
for LCD users.

Creating Temporary
Bookmarks Using SnapBack

Safari has a feature called Snapback,
which allows you to mark a temporary
bookmark while you’re browsing through
a page. While on the page or site, click on
History > Mark Page for
SnapBack. Safari now remembers this
page. Say you’ve proceeded several levels
into the site and you want to return back
to the main page on which you created
the bookmark, click on History again
and then on Page SnapBack.

Browsing Without Footprints
Safari has a feature called Private

Browsing, which can be accessed by
clicking on Edit > Private
Browsing. This mode stops caching any
of the pages that you visit from then on.
No records such as history or passwords
are maintained. This is useful for any
user who might want complete privacy
while checking their mail or while doing
online transactions for example. To get
back to the normal mode, go back to
Edit > Private Browsing.

Bookmark Migration 
If you like Safari, then you’re

bound to move your bookmarks to Safari
at some point in time. Start your orig-
inal browser and then export the book-
marks to an HTML file as that is what

Safari uses to import bookmarks. Once
that is done, click on File > Import
Bookmarks. Select the file and click on
the file you exported. A new windows
view with all the imported bookmarks
will now open. To have all the book-
marks accessible in the Bookmarks
menu in Safari, select all the bookmarks
and drag and drop them into the
Bookmarks menu item in the left pane.
Bookmarks can also be exported by
clicking File > Export Bookmarks.

The other place where bookmarks
can be displayed is the Bookmarks bar,
which needs to be enabled by clicking
on View > Show Bookmarks Bar.

RSS Feed Reader
Safari may be new to Windows, but

Apple has still implemented some fea-
tures such as feed reading into it. There
is no separate feed reading window as
we find in Opera to read feeds. When
you visit a site with an RSS feed in it,
click on the RSS icon in the address bar
to read the feed right there. To save the
feed, you need to add a bookmark as in
any other page by clicking on
Bookmarks > Add Bookmark.
Controls for searching the feed, or
changing the size of the preview or
viewing feeds using a timeline are also
present on the right pane.

To make changes to the refresh
interval, click on Edit > Preferences
> RSS and use the dropdown menu for
Check for updates. There are also

settings to automatically mark read items
and highlight unread ones.

Monitoring Browser Activity
Most of the loading status bars

used to indicate the percentage of

objects in a page loaded, are usually
inaccurate. Safari allows users to see the
status of all the elements being down-
loaded in a separate window. Click on
Window > Activity. You can see a
neatly sorted list of files and their down-
load status for all the sites open.

Spelling And Grammar Check 
Safari’s inbuilt spelling and

grammar check can help avoid errors
while writing mails or posting replies
on a forum, for example. The checks can
be enabled by clicking on Edit >
Spelling and Grammar and click the
menu items for spelling and grammar
check. If you do make an error while
typing, the mistakes will be highlighted
by a red underline, which can be cor-
rected by right-clicking on it and
selecting the right spelling.

Reopening A Window From The
Last Session

Unlike most browsers, where the last ses-
sion can’t be loaded unless you save it,
Safari remembers the last session’s sites
and tabs. That means you can shut down
Safari in a hurry without worrying
about forgetting to bookmark those
pages. To open the last session, click on
Reopen All Windows from Last
Session from the History menu.
Other visited sites are also sorted
according to dates in the same menu.

TOTAL COMMANDER
ULTIMA PRIME

Total Commander has been well
known as a replacement for
Windows Explorer and has been

around for many years. Total Commander
Ultima Prime (TCUP), is, on the other

The activity tool allows the user to view the
download status for all files in a page 

Safari’s font smoothing might not work great
with CRTs as it does with LCDs

Safari can easily import bookmarks from your
other browsers through HTML files

Safari has a simple feed reading feature but
one with well integrated functionality 

andLinux
Run Linux in Windows... With a twist!

Rossi Fernandes

We keep complaining about how
we’d like to use Linux but all our

work and favourites applications are
here on Windows. Virtualisation can
be harnessed to run both Linux and
Windows together, but virtual
machines are very resource hungry
and it’s not practical. andLinux could
be the solution to all your problems.
With andLinux, you can run Linux
applications on Windows without
having to boot into Linux or run vir-
tual machines. The andLinux installer
can be found in this month’s DVD.
We’re showing you a quick outline of
some of its features.

Getting andLinux Up And Running
andLinux doesn’t require you to create
or modify any partitions, and the
entire installation procedure is done
on Windows like any other application.
Double click the executable and con-
tinue beyond the agreement accepting
window. Enter a suitable amount of
memory that you want to allot to
andLinux. If you want to use sound
applications, check the radio box for
enabling the audio support module.
Similarly, if you want to use andLinux
seamlessly when you boot into
Windows, choose to set up andLinux as
an NT service that runs automatically.
Next, select the method you want to
access the Windows file system. Choose
CoFS, however, network shares can be
used using Samba. The next step is to
select the partition that can be
accessed by andLinux. You can also set
it to access a particular folder. Select
the folder and proceed. 

Accessing andLinux’s Applications
If you’re wondering where the
andLinux applications are, they are all
accessible from the icon in the system
tray. If you want to run console appli-
cations, you can open a terminal ses-
sion using Konsole or an andLinux ter-
minal. The username to use is [root]
with no password. The andLinux ter-
minal allows you to jump to other ter-
minals using the [Alt] + [F1] / [F2]
/ [F3] / [F5] / [F6] keys.

Adding New Software
You might think andLinux works like
some kind of LiveCD that runs on

Windows, but it is much more than
that. LiveCDs generally don’t let you
install applications, which means you
are stuck with what is provided. One
of the most impressive features other
than running Linux on Windows is
that you can actually install new soft-
ware on it. The simplest and quickest
way to do this is to use the Synaptic
Package Manager, as long as you have
an Internet connection. Right-click on
the system tray icon and click on
Synaptic. Now search or browse
through the directory for the software
you want. Right-click on the applica-
tion and click Mark for
Installation. Click on Apply on
the top menu to have the software
downloaded and installed. You can
also use apt-get to install, like you
would in other distributions.

Stopping The Service
While it’s fun to have andLinux and its
applications running on Windows, it
can sometimes be a resource hog espe-
cially if you don’t have a lot of RAM to
spare or if you’re about to start some

intensive games. In such cases, you
might want to shut down all the unnec-
essary services and programs running in
the background. Go to the folder where
you installed andLinux. Double click on
srvstop.bat and the service will end.
The service can also be shut through the
Services manager under Windows
Administrative Tools. To start the service
again, double click srvstart.bat.

Using andLinux’s Integration For
Windows File Formats
If you haven’t noticed, andLinux doesn’t
only run applications or open files in
the Linux file system. You can browse
through folders and use andLinux’s
applications run certain files—for
example, .doc files can be opened using
KWord. Browse using Windows explorer,
right-click and you will see the applica-
tion name in andLinux.

If you don’t see an association
made, you can open the application
using the menu. Then proceed to open
the file through the File > Open
menu. Look for a path to Windows to
open files in the Windows partition.
You can also access the same partition
through the path /mnt/win. Keep in
mind, that andLinux will not be able
to open paths outside the ones you
specify during the installation.

Modifying The Launcher Menu
The andLinux launcher allows you to
run most applications available in
andLinux. It might even not add any
new software that you download and
install. The menu can be modified
through a small text file located in the
installation folder of andLinux—
andLinux\Launcher. Open
menu.txt in any text editor and add
any new entries that you want. Adding—
adds a separator in the menu. The
format is—
ApplicationName;ApplicationIc
on.ico; ApplicationCommand. For
example,  Digit;digit.ico;kon-
queror www.thinkdigit.com will
add an entry Digit that will load
www.thinkdigit.com in Konqueror.
Unnecessary entries can be deleted from
the list by removing a line. Save the files
and close the launcher by right clicking
on the system tray icon and then Exit.
In the Launcher folder, run menu.exe
again to restart the menu and you will
now see the changes in place. n

rossi.fernandes@thinkdigit.com

Synaptic Package Manager is an easy way to
add applications to andLinux over the Net

andLinux can be temporarily shutdown by
shutting down its service in Windows
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hand, a Total Commander plug-in that
adds many more features in the form of
other plug-ins and software bundled
within it. We are using Total Commander
along with the Ultima Prime add-on and
you’ll be surprised at how much more we
can do and how simpler things can get. 

TCUP’s Process Manager
The Windows Task Manager is a

rather simple utility, which shows the
list of processes running on Windows. It
does a satisfactory job, but TCUP has a

very impressive process manager, which
offers many more details on a selected
process. To open the process manager,
click on Plugins > Processes. Now
double click on Processes again. A list
of all the running processes is displayed.
Double click on a process and you see
information on everything from the CPU
resources and RAM utilised to network
connections being made. You can also
view a graph of very interesting set of
performance parameters for that process
when you click on the Graph tab.

Running Applications As A
Different User 

If you’re running Windows on a standard
user account without any administrative
rights, it can be quite messy to log back
in as Administrator. Total Commander
gives you an easy window into the
Administrator account to run an applica-
tion. To do this, click on the file that you
want to run, then click on NTFS > Run
As. Enter the username and the password
for that account. You can use this to use
any account on your Windows system.

Burning Discs And Creating
Images

Total Commander has integrated a nifty
little CD / DVD burning software that
will also let you create images out of
files and folders. Click on the Network
Neighborhood icon, which will open
the list of features in TCUP. Double click
on CD / DVD Burning. Choose the
type of disc you want to create by
double clicking on it—Data CD/DVD /
Video DVD / Audio CD. You can also
choose create an ISO of the data. Drag
and drop the data to be recorded from
the opposite pane into the CD / DVD

burning pane. Double click the Burn
Media menu item.

Snipping Menus To Your Liking
Adding features and add-ons to

Total Commander has definitely clut-
tered the interface and more confusing
than the original TC. Fortunately,
changes can be made to the menus and
the interface can be given some colour.
To edit the menus, click on
Configuration > Menu > Main
Menu. Click on English if you want the
default simple menu without any links
to any of the additional features. You can
also edit the menu by adding or
removing any extra menus by clicking
the Edit button. The POPUP at the
beginning denotes the main menu,
which bifurcates into MENUITEMS.
Delete all the unnecessary menus by
deleting these lines. Make sure you make
a backup of the files in the LANGUAGE
folder in your Total Commander folder,
just in case anything goes wrong while
editing the files.

Turning Off The Monitor
Through TCUP

Total Commander allows you turn off
the monitor on demand similar to
Windows Power Management. This can
be done by clicking on Power > Turn
off monitor. You can also turn off the
PC completely or send it into hiberna-
tion or standby through the same menu.

Accessing Registry And
Startup Items

Any changes to the Windows registry
requires users to use the Windows
Registry Editor which requires significant
browsing and searching, before you find
the key that you’ve been looking for. The
most important keys in Windows are gen-
erally the ones which start programs
when Windows boots or when a partic-
ular user logs in. While you can still use
it to view the entire registry, there is an
option in the main menu to view the
Autorun items. Double-click on
Autorun. Now enter the category of
applications and double-click on an item
to stop it from running or you can even
delete it by pressing the [Del] key.

Making TCUP Your
Image Viewer

TCUP has the ability to generate thumb-
nails and previews for images so that
should make it a pretty decent image
viewer something like ACDSee. First
browse to the folder with the images.
Next, click on Show > Thumbnail
View. All the files should be displayed as
thumbnails now. Now, click on Show
again and click Quick View Panel to
have a large preview panel on the oppo-
site pane. You can even use the controls

available that let you rotate the image or
add a few effects. Click Edit and an
image editor that comes bundled with
TCUP loads up. The same previewing fea-
ture can be used to preview videos and it
even supports some unexpected formats
such as PDFs!

When you aren’t viewing images or
PDFs, then just point your mouse to a
particular folder, and the preview pane is
used to show a graph depicting the size
and files in that folder. 

Quick Searching Folders
TCUP can scan through your direc-

tory tree for a particular folder. With
this, you can search for a folder without
having to browse in and out of different
branches. Click on Commands > CD
Tree. This will start the scanning of the
entire drive for folders. When the search
is complete, start typing in the name of
the folder you are looking for and Total
Commander will pinpoint to it. Click OK
and you will be directed right there!

Choosing A Suitable Menu
On installation, you might be asked

by TCUP to enter a resolution that you are
using for your screen. TC will automati-
cally set the right icon size and layout so
that it fits properly in your desktop reso-
lution. Unfortunately the fitting isn’t
always perfect when you select a large
screen resolution and you notice tiny
icons within huge if you choose it. To set
standard resolution, click on
Appearance > Resolution and check
1024 x 768. You will now get standard-
sized icons on standard-sized buttons in
the toolbar. Click on Appearance >
Buttonbar and select one of the pro-
files—some of them have minimal layout
while others are full fledged ones with all
the utilities and features.

Tabs In A Windows Explorer
Replacement

Total Commander has tab support,
which is useful when you want to keep
many folders open at the same time. To
make use of the tab feature, right-click
on the title bar for the folder or drive
that is open, and click on Duplicate
this tab to create a copy of the panel.
You can now even copy from one tab to
another by dragging and dropping a
folder into the title of the tab.

The process manager in TCUP is far more
feature packed than the one in Windows

The Preview panel in TC UP makes it a decent
quick image viewer
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T he mid-range graphics
card market is abuzz
with new releases

that promise never-before-
seen performance at rea-
sonable price. These new
value warriors had us
gasping in disbelief. With
the 8800GT and 8800GTS
(512 MB) both priced above
10K, the 9600GT fits the
“affordable gamer card”
bill perfectly. 

Based on the newer G94
core, the 9600GT is sim-
ilar to the G92-based
8800GT and 8800GTS
cards. However, the
stream processors (SP)
have been halved on this
new budget card. The
stock clock speeds are
650 MHz for the GPU
core, the memory run-
ning at 900 MHz (1,800
actual) and the SPs hum-
ming at 1,625 MHz.

We have five cards
from XFX, MSI, ASUS,
Sparkle and Gigabyte.
Though based on the
same chipset, these cards
sported various designs.
ASUS, Sparkle and XFX
were based around the
NVIDIA reference, single
slot design. MSI has the
most spectacular looking
card, where as Gigabyte
had resorted to their pas-
sive-cooled heat pipe

design. Both these cards
require two slots though. 

During our testing, the
single slot cards got warmer.
However, the temperatures
were within acceptable
limits and we could touch
the card. The heat pipes on
the Gigabyte card did an
excellent job, although the
fins got really hot. The MSI
card with its unique heat
pipe plus fan design kept
cool throughout the test.

We test the latest hardware
and software products 
available in the market

NVIDIA 9600GT Galore!
More For Less

BazaarBazaar

Almost all cards supported
HDMI connectivity, which is
good. However, this is done
via the DVI-to-HDMI con-
nector. Some higher-end
9600GTs have them on the
back panel. 

The XFX 9600GT comes
bundled with the Company
of Heroes game, necessary
cables and HDMI connector.
MSI, ASUS, Sparkle and
Gigabyte cards come with
an HDMI connector, cables

and the quick install
guide—but no free games. 

On the performance
front, the MSI and Gigabyte
cards were neck and neck.
Other cards were trailing
behind. All 9600GT cards
are within a hairs-breadth
of the 8800GT card. At lower
resolutions, the difference
isn’t noticeable, in fact in
some benchmarks the
9600GT runs at par with the
8800GT. However at 
higher resolutions, the 
performance gap widens. 

Gigabyte’s 9600GT
returned the best results
across the board with MSI
following closely at its heels.
Gigabyte has priced its card
at nearly Rs 16,000. At that

price, one can buy an
8800GT. MSI is sweetly priced
at Rs 13,000 and offers the
best buy for the buck, consid-
ering the slight performance
edge it has over other cards.
XFX has the best bundle,
good performance and is rea-
sonably priced. Sparkle offers
the best of both worlds—
decent performance at a 
terrific price.      

Specifications
Core clock 650 MHz,
1,800 MHz memory clock,
512 MB GDDR3, 256-bit
memory interface,
1,625 MHz shader clock,
PCI express 2.0, 400 MHz
RAMDAC and HDMI
connectivity.

Features

Performance

Build Quality

Value For Money 

Overall 

Price

E-mail

Phone

Ratings and Contacts      Sparkle SF-PX96GT512D3-HP Gigabyte GV-NX96T 512HP MSI N9600GT-512MB XFX 9600GT 512MB ASUS EN9600GT HDMI

Rs 13,000

sanyam@msi-in.com

+91-11-41758808 / 09

Rs 11,900

xfx@rptechindia.com 

+91-22-67090909

12,600

media_india@asus.com 

+91-22-67668800

Rs 15,900

sales@gigabyte.in

+91-22-23823331 / 2

3DMark 2006

Palit 11152

10630

10554

10255

10155

10140

Units

9600 9800 10000 10200 10400 10600 10800 11000 11200

MSI

Gigabyte

XFX

Asus

Sparkle

Ca
rd

s

Doom 3 @ 1280x1024 (4AA, 4AF)

Palit 135

133

131

130

120

119

Frames per second

110 115 120 125 130 135

Gigabyte

MSI

XFX

Asus

Sparkle

Ca
rd

s

Prey @ 1280x1024 (4AA, 4AF)

Palit 120

115

113

111

104

103

Frames per second

90 95 100 105 110 115 120

MSI

Gigabyte

XFX

Asus

Sparkle

Ca
rd

s

Splinter Cell Chaos Theory @ 1280x1024 (4AA, 4AF)

Palit 159

147

142

139

136

135

120 125 130 135 140 145 150 155 160

Gigabyte

MSI

XFX

Asus

Sparkle

Ca
rd

s

N9600GT 512MB

GV-NX96T 512HP

9600GT 512MB

EN9600GT HDMI

SF-PX96GT512D3-HP

8800 GT 512

GV-NX96T 512HP

N9600GT-512MB

9600GT 512MB

EN9600GT HDMI

SF-PX96GT512D3-HP

8800 GT 512

GV-NX96T 512HP

N9600GT-512MB

9600GT 512MB

EN9600GT HDMI

SF-PX96GT512D3-HP

8800 GT 512

MSI N9600GT 512MB

GV-NX96T 512HP

9600GT 512MB

EN9600GT HDMI

SF-PX96GT512D3-HP

8800 GT 512

Frames per second

Rs 10,500

megha@abacusperipherals.com

+91-22-40914613

ASUS EN9600GT HDMI

MSI N9600GT-512MB

Gigabyte GV-NX96T 512HP

Sparkle SF-PX96GT512D3-HP

XFX 9600GT 512MB
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Logitech’s G (for gaming)
series features the highest

pixel count sensors, and
classy aesthetics that
includes grip-friendly curves,
and slick-as-teflon feet for a
smooth glide—something
that gamers will appreciate.
The G9 goes a little high
tech, and includes a laser
sensor that allows a whop-
ping accuracy of 3,200 dpi.
Although gamers will recog-
nise this as marketing rub-
bish (no gamer worth his
salt plays at even 2000 dpi),
the fact remains that the
sensor on the G9 is sensitive
indeed. Also, onboard is the
micro precision scroll wheel,
which we all recognise as a
clone of the excellent unit
on the MX revolution, and
two working modes. One you
can use as a regular wheel
with clicky feedback. We did
mention modular—the G9
has changeable grips—the

two bundled are the regular
stripped down grip and an
additional bezel-like unit
which clicks on to the outer
body of the mouse, making
it significantly wider and
hence the name wide grip.
There are also other grips
that you can purchase from
Logitech, each customised
for a certain type of usage.
From its predecessor—the
G5, the G9 gets a weight car-
tridge, only this time it’s
cleverly removed by applying
pressure on its notch at the
rear. The weights on the G5
had a tendency to rust.
Thankfully, these seem to
have been adequately
treated. One issue that we
noticed right away (and
what is possibly a major
flaw) is the slight play
between the weight tray and
its housing—truly annoying
while using the mouse. Also,
if you remove the tray, you

get an ugly hole at the rear
of the body, whereas the G5
was neater with the tray slot-
ting underneath the body.

Practically, the side but-
tons feel a little too soft,
mainly because there is a
slight gap between the outer
body and the inner body,
which has the contacts for
the buttons. There is a DPI
indicator (whose colour can
be changed via drivers—neat
but useless!), that is useful to

let you know how much
to dial up or dial

down the DPI.
At Rs 5,995, the

G9 is very expensive
for the innovations
and features it

offers. 3,200 DPI is
just gimmicky because

nobody will use this mouse
at that resolution. The
Lachesis from Razer is
another similar high DPI
product (4,000 DPI) that does
a better job, at a slightly
higher price. The polling fre-
quency of 1 kHz is some-
thing though, so is the
ability to store and load pro-
files. This is a good mouse
for the serious fragger, but
not at its current price.

Specifications
Sensor 3,200 dpi, polling
frequency 1 kHz, customisable
grips, customisable weights

Contact: Logitech India Pvt. Ltd
Phone: +91-22-26571160
Web site: www.logitech.com 
E-mail: kavita_nath@logitech.com
Price: Rs 5,995

Features  
Performance 
Build quality
Value for Money
Overall 

RATINGS
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Although internationally
they’ve been around for

a while, Tagan is a relatively
new name in the Indian
market for desktop power
supplies. Enter their new BZ
series, a funky product line,
meant for discerning users
and gamers and offering
some show to what is 
usually just go. The BZ series
do things radically different
as far as visuals go. They’re
modular, with pipe-like con-
nector cables complete with
circular pin arrangements
(called piperock by Tagan)
that ensure incompatibility
with any other power
supply. Then there are the
cool looking LED-lit circular
strips around each modular
socket on the PSU that illu-
minate when a cable is
plugged in. The cables are
colour coded as per the LED
colour. This ensures no 
mistakes while plugging 
in cables. If you have a
transparent side window,
the ensuing lighting is defi-
nitely one to get the drool
out as intended. Add to that

a large cooling fan (135
mm) with blue LEDs and
the BZ800 is definitely lit to
kill! There is a pair of
branded nylon gloves—
free publicity for Tagan if
you should choose to wear
them around. The outer
body itself is reasonably
well built, but the gauge of
sheet used isn’t as good as
the CoolerMaster Real
Power 1000W or the Corsair
HX series. 

On the technical front
the BZ800 sports six 12 volt
rails. There is a Turbo mode,
which disables the power
limitations on the 12 V rails
allowing them to overdraw
power, in case you should
need it. Four PCIe (two 6 pin
and two 8 pin) power con-
nectors mean SLI/Crossfire
is possible with the latest
cards. With a combined
load capacity of 64 amps on
the 12 V rail (768 W) the
BZ800 is no different from
other recent power supplies,
which concentrate on
beefing up the 12 V rail that
typically powers CPUs,

graphics cards, hard drives,
optical drives and case fans.

We fired up our nuclear
reactor of a rig, consisting
of a Core 2 Quad Extreme
QX6850 CPU, ASUS Striker
Extreme, two 8800 Ultra
graphics cards, two WD
Raptor 80 GB HDDs, a
500GB WD Caviar HDD, two
DVD RW drives and an X-Fi
Elite Pro. Just to make
things interesting, we took
our quad core to 3.6 GHz,
and ran a gamut of bench-
marks. Not once did it seem

that the BZ800 ran out
of juice, and performed
well right through.

At Rs 8,700 the
Tagan BZ isn’t cheap by
any means, but for a
high-end power supply
(which it most certainly
is), the price isn’t too
bad. The only better

option we’ve seen is the
CoolerMaster Real Power
1000W Pro—which is much
costlier. Incidentally, the
fact that the BZ800 is 80+
certified means your power
bills will be in check. If
you’re looking for an
extreme PC, or a super
duper gaming rig, and need
a powerful PSU with loads
of visual appeal, you can’t
go wrong with this.

Specifications
800 W continuous power, 6x12
V rails, max power (12 V)—768 W
(64 A), 8x SATA connectors, 2x6
pin PCIe connectors, 2x8 pin
PCIe connectors, 6x peripheral
connectors (4 pin)

The SES668 Music Station
is essentially an iPod

dock with killer looks. The
dome-shaped design looks
good and the use of silver
highlight on a jet black
body adds that extra style—
something missing on
most cheap docks. 

On the top of the
speaker sits the dock
receptacle. The recep-
tacle accepts multiple
base connectors thus
allowing the use of
almost all generation of
iPods, expect for the
newer wider body
Nano. The base
connector is
large enough to
hold most iPods
in place.

On the four corners of
the squares, are the buttons
for powering on and volume
control, and one is a
dummy button. The buttons
are hard to press with dis-
tinct clicks, however one

can keep them
pressed to
increase /
decrease the
volume. The
volume control
isn’t smooth
and boosts in
huge steps. 

The dock requires 12 V
and it is powered via an
adapter that runs off the
mains. There is no option for
alternative power source like
batteries, if the mains are
down. The iPod can be
charged via the dock and the
USB connector allows it to be
connected to a PC for data
transfer. The dock also has an
auxiliary input thus allowing
an alternate sound source. 

On the performance
front, the dock didn’t per-
form as per our expectation.
Bass is non-existent and the
drum beats often sound
flat, highs are not repro-
duced at all and the mid-

range is completely mud-
dled. Also there is no way to
control the playback from
the dock, and you will have
to use the iPod.   

Though affordably
priced at Rs 1,350, the
SES668 Music Dock isn’t the
right solution for your iPod.
We suggest that you up the
ante and invest in JBL or
Bose if you care for music
quality, else stick to the
stock earphones.   

Specifications
USB charging, USB data
transfer, Auxiliary input, mobile
phone compatibility and
CD/DVD player. 

The D201GLY2 is the
cheapest motherboard-

processor combo solution
to come out of the Intel
stable. Built to the micro
ATX form factor, the
motherboard is mere 17x17
cm. This combo makes a lot
of sense for people building
Linux nodes or low power
downloading machines. 

The motherboard comes
with an Intel Celeron 220
processor soldered, which
means no speed upgrade.
The core 2-architecture
based processor runs at
Jurassic 1.2 GHz on a 533
MHz system bus. Thankfully,
the motherboard supports
DDR II, but it has single
memory slot—so no dual
channel for you.

Though the mother-
board comes from Intel,
both the chipsets are from
SiS, namely, SiS662. The
graphics driver for

Windows works well, but
with Ubuntu 7.10 and Linux
Mint 4.0, we ran into dis-
play problems and needed a
patch driver for the GUI to
work properly.

Other features include
two SATA ports, one IDE
slot, six USB ports, one
serial port and one parallel
port. A 10/100 Ethernet
comes onboard and it has
only one PCI slot. 

Considering the hard-
ware, we didn’t run our

usual heavy duty tests, but
instead relied on some old
ones to do the number

crunching. The processor
is reasonably fast and

can handle three
applications

simultaneously.
Running

multi-
media,
we
could

see the
system suffer a

bit when switching
between applications.
Graphic engines on the
motherboard are quite
weak and don’t stand a
chance when put to
gaming. Reasonable resolu-
tion movies run fine, but
high resolution ones occa-
sionally stutter. The
chipsets and processors are

passively cooled and when
put to task, get really hot.
We suggest going for the
actively cooled model
(D201GLY2A).  

Priced at Rs 3,300, the
D201GLY2 offers excellent
value and if you want to
build a compact, low cost
machine, the 201GLY2 is
definitely the solution to go
for. However, don’t expect
to run games or any other
heavy duty application. We
suggest this for building a
downloading machine, a
print server or a file server.  

Specifications
17x17 cm size, Celeron 1.2 GHz,
supports DDR II up to 667 MHz,
ADI AD1888 Audio (2 channel),
2 SATA ports and 10/100
Ethernet.

Features  
Performance 
Build quality
Value for Money
Overall 

RATINGS
Contact: Nanopoint Technology 
Phone: +91-33-22251192  
E-mail: ivan_tsai@nanopoint.com.tw 
Web site: nanopoint.com.tw 
Price: Rs 8,700

Contact: Supertron Electronics Ltd.
Phone: +91-22-23881397
E-mail: info@supertronindia.com
Web site:
www.supertronindia.com
Price: Rs 1,350

Features 
Performance
Build quality
Value for Money
Overall 

RATINGS

Features  
Performance 
Build quality
Value for Money
Overall 

RATINGS

Contact: SES technologies Ltd. 
Phone: +91-80-28542105
E-mail:
apacsupport@mailbox.intel.com
Web site: www.intel.com
Price: Rs 3,300

Tagan BZ800
Power In Colour

Supercomp Music Station SES 668
May Not Be Music To Your Ears

Logitech G9 
The G series Goes Modular!
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Intel D201GLY2
Honey, I Shrunk The PC!
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Freecom, though
unknown to the Indian

market is an established
player in the external
storage arena. In the past,
we have reviewed Freecom
drives and now that
Freecom has officially
come to India, we expect
them to be priced sanely.

The Tough Drive series,
as the name suggests, is
aimed at enduring shock.
This particular drive is clad
in pink rubber, which
Freecom hopes will lure
the fairer sex. 

Thankfully, the Tough
Drives are available in
other colour options. In
terms of design, the drive
is sleek but not portable,
obviously due to the thick
layer of rubber cladding it
dons. The rubberised body
feels good to hold, but the
tyre pattern design on it

doesn’t do anything to
enhance its looks. 

On the brighter side, the
Tough drives are indeed
solidly put together and
sport good design from the
usability aspect. Apart from
the rubber cladding, inter-
nally the hard drives are
put on a spring suspended
frame (anti-shock frame) for
better shock absorption. The
USB connector is integrated
in the drives, and hence
there is no need to carry
along any cables. The drive
can be directly connected to
the PC. The USB connector
lights up blue, and blinks
during data transfer. The
Tough drive doesn’t require
additional power and runs
off a single USB port. 

Freecom has bundled
back-up software, namely
NTI shadow. It can do real
time continuous data

backup, scheduled back-up
and has version control. Thus
older files can be retrieved.
The user interface is simple
and the settings are granular
to the point that you can
even select the types of files
to be backed up. 

Internally, the Tough
Drive comes with 5,400 RPM
Fujitsu hard drive and
delivers good performance. 4
GB (1 DVD) of assorted data
takes less than 3 min to copy
whereas a 1 GB (one movie)

took
around 39

sec to copy. We
say the drive is fast

for most purposes it will
be used for. 

Priced at Rs 10,150, the
Tough drive is a reasonable
buy. Ordinary 250 GB drives
are available in the Rs 8,500
region and the small pre-
mium of Rs 1,500 for shock
proofing is well worth it in
the longer run. However, we
would prefer to never see
the pick version again—
black or blue please!

Specifications
5,400 RPM drive, 2 m drop
shock proof, USB 2.0 and
Integrated USB connector 
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Contact: Rashi peripherals Pvt Ltd.
Phone: +91-22-67090909 
E-mail: freecom@rptechindia.com 
Web site: www.freecom.com
Price: Rs 10,150
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The XPS 420 is the top of
the line Dell desktop

model for the Indian market.
Cramped with features, the
XPS 420 is a multimedia
powerhouse aimed at
gamers, enthusiasts, etc

This new model features
a new completely revised
chassis. Finished in shiny
black plastic, the front panel
is a smudge magnet and
attracts much dust as well.
The side panels finished in
brushed aluminium with a
big XPS logo scream for
attention. One unique thing
about the XPS 420 is the
presence of small LCD screen
on the top (Windows
Sideshow) an extension of
Vista’s Sidebar. This small
LCD can be used for showing
small tidbits of information
via the sidebar gadgets. New
gadgets can be downloaded
from Microsoft’s Web site. 

The base configuration
consists of Intel Quad core
Q6600, 2 GB of DDR II 667
MHz, 250 GB hard drive and
8600 GTS graphics card.
These components are
powerful enough to
ensure a high-end rig
experience, though we
think the 8600 GTS is
aging and expect dell to
replace it soon with the
newer 9600GT card. 

The 20-inch LCD
monitor comes bundled
with the system is
breathtaking. The screen
is glossy and reproduces

crisp images. Movies are fun
on this monitor, so is editing
photographs and the sheer
space on offer will allow you
to open two word pages side
by side. The LCD also has an
embedded 2 MP Web
camera, which can be used
for chatting, taking photo-
graphs and capturing video.
The capture quality is good
and colours are faithfully
reproduced.   

There is also an MPEG 2
transcoder with front
mounted AV ports, which
can be used for importing
video from camcorders and
encoding it to DivX. The
accompanying software,
however, isn’t user friendly
and requires lot of patience
to learn. Additionally, there
is the 19-in-one memory card
reader with Bluetooth 2.0
module, wireless (Bluetooth)
keyboard and mouse and a
Hauppauge TV tuner card
with remote. Miscellaneous
items include micro fibre
cloth for wiping the LCD,

soft and hard mouse pads
and a folder with the neces-
sary manual and CDs all per-
fectly packed in the box.

The cabinet can be
opened without any tools.
All it requires is pulling a
single latch to release the
side panel. On the inside,
everything is neatly packed.
Since Dell has opted for the
BTX form factor, the system
requires just one fan to cool
itself. The cables and wiring
are tied down and routed
optimally without affecting
the air flow. The single 120-
mm fan is placed right after
the huge CPU cooler and
throws out hot air from the
front of the cabinet.
Throughout our testing
process the system remained
cool and quiet. Though the
cabinet is tall and the inter-
nals are neatly organised,
there isn’t much space for
future upgrade; just two
hard drive slots that’s what
you get here. 

On the software front,
Dell has bundled in Adobe’s
Elements Studio package
consisting of the Lite ver-
sion of Photoshop
Elements, Premier
Elements and SoundBooth

CS3. The typical Dell in-
house software is present
and they provide complete
control over every aspect of
this beautiful machine. 

The XPS 420 performs
admirably in all aspects,
thanks largely to the pow-
erful hardware that’s under
the hood. The Q6600 simply
chewed through the test we
put it through and has
enough grunt to transcode
home videos on the fly.
Though the 8600 GTS ran
through the entire graphics
test delivering playable
frame rate, we think it’s best
to upgrade to a higher card.
Dell offers 8800GT in lieu of
the 8600GTS and if your
pocket permits you should
upgrade for better gaming
experience. Overall, the
system performance is more
than satisfactory, despite
Vista running on the system,
it was responsive with
hardly any lag. 

Priced at Rs 69,169, we
feel the XPS 420 is overpriced
considering the weak
graphics subsystem.
However, it is very difficult
to recreate the overall look
and feel that the XPS 420
has—the beautiful case,
neatly packed interiors, stu-
pendous hardware and the
tiny LCD screen on the cab-
inet! If you have money to
blow and appreciate style,
then the XPS 420 fits the bill.

Specifications
Intel Core 2 Quad Q6600, 2 GB
DDRII, 250 GB, Media Xcelerator,
8600 GTS, 20-inch LCD screen
with 2 MP Web cam and
Bluetooth keyboard and mouse. 

Features  
Performance 
Build quality
Value for Money
Overall 

RATINGS

Contact: Dell India Pvt. ltd 
Phone: 1800-425-4026
E-mail: dell_enquiries@dell.com
Web site: www.dell.co.in
Price: Rs 69,169

Features  
Performance
Build Quality
Value for Money
Overall 

RATINGS

The View is SanDisk’s
attempt at a video ori-

ented PMP and features a
slightly larger screen than
their mainstream E200
series. It’s also a slightly
longer device, and gives up
the metal back for a matt
finished black rear that
adds a touch of class to an
already up-market looking
device. The ribbed click
wheel also goes in favour of
a smooth finish with a
smooth moving click
wheel. The menu system
remains the same, but we
found exploration a little
better, courtesy the new
smooth action wheel.
Expansion is via MicroSD
now. Should for some
reason 16 GB onboard be
insufficient, and given the
fact that 8 GB MicroSD
cards are slowly making
their way to the market
space, is never going to be
a constraint.

All the features we
loved on the E200 series are
present—FM radio, voice
recording, video and image

viewing—although features
like an alarm clock, cal-
endar, and the ability to
store notes was absent—a
pity SanDisk didn’t think
of adding anything new.
Navigating the menu is
simple and the same ease
of use has being carried
over to the FM radio too.
Setting up the channels
took very little time. The
screen is also a touch below
par, especially when com-
pared to the screen on the
new Apple iPod Nano 3G,
its logical competitor.
Other devices like Cowon’s
D2 and Apple’s Touch are
miles ahead. Music quality
is the other significant
parameter, and the View
doesn’t disappoint here.
Although we noticed good
volume levels, the View
isn’t as loud as either the

D2 or the Nano / Touch
duo, nor is it as defined in
the highs. In fact, bass
doesn’t extend as low as
the competition, and while
it does pound lightly, it’s
not the thump that we’ve
seen from the best of the
PMPs in our tests.

At Rs 12,790, the Sansa
View is a good and reason-
ably feature-rich PMP. The
problem is that it doesn’t
standout at anything, prefer-
ring mediocrity to fame. It’s
hard to recommend to
anyone, with each of the
competition mentioned
above doing at least some-
thing better, while retaining
all the same features.

Specifications
16 GB Flash, MicroSD
expandable, 2.4-inch LCD, FM
radio, Voice recording, H.264
video playback

Contact: Rashi Peripherals Pvt Ltd
Phone: +91-22-67090909
E-mail: sandisk@rptechindia.com
Web site: www.rptechindia.com
Price: Rs 12,790

Features  
Performance
Build Quality
Value for Money
Overall 

RATINGS

Freecom Tough Drive Pink 250 GB
Gigabits On A Pink Platter 

SanDisk Sansa View
A Sleek Vision

Dell XPS 420
The Good 420

Bazaar April_08.qxd  5/13/2008  12:43 PM  Page 58



Go Green! Seems to be
the mantra these days

and every manufacturer is
doling out power efficient
products. Lenovo’s A61e is
based on AMD’s DTX form
factor—the first of its kind,
consisting of their power
optimised processor, chipset
and graphics. 

The A series of desktops
from Lenovo are oriented
towards business and hence
don’t expect this PC to
churn out big numbers—it
isn’t meant too. The A61e is
designed to consume less
space—an important aspect
for most businesses. We
found the dimensions very
compact for a full fledged
PC—great for Media centre
PCs. Despite the diminutive
form factor the PC doesn’t
get hot—thanks to good
ventilation and low power
components. 

The configuration offers
a decent balance between

performance and power con-
sumption. AMD’s Athlon 64
X2 BE-2350 (power optimised)
processor along with ATI’s
X1200 onboard graphics
power the PC’s critical sys-
tems. The motherboard is
custom built, and hence we
could not trace its manufac-
turer. Other goodies include
1 GB of memory, 160 GB
hard drive, DVD writer and
Gigabit Ethernet. The PC
doesn’t run directly off the
mains, rather it requires the
provided power adapter sim-
ilar to a laptop. The tight fit
of components means,
upgradeability is limited.
However, the system admin
will appreciate the tool-case,
which opens by sliding a
single latch. 

Along with the A61e,
Lenovo has bundled the
familiar black keyboard and
optical mouse. The A61e can
be ordered without any dis-
play. However, our test unit

had their 20-inch LCD mon-
itor. During our tests, the
LCD fared well and delivered
good tonal accuracy. The LCD
is fit for any office related
work, i.e. Word processing,
spreadsheets, browsing etc. 

When we upgraded the
memory to 2GB the PC
shifted its gear and deliv-
ered reasonable results.
With all the eye candy on,
Vista requires at least 2 GB
for other applications to
work. With Windows XP, we
had no problem with the

stock configuration. The
performance was satisfying.
We tried Ubuntu 7.10. The
PC did boot, but with
minor glitches such as
wrong screen resolution, no
sound, etc., which needed
some fixing. 

The A61e without the
monitor is sweetly priced at
Rs 15,800.   

Specifications
AMD Athlon 64X2, 1 GB DDRII,
160 GB HDD, DVD-RW, X1200
onboard graphics, Keyboard,
optical mouse, Gigabit Ethernet
and PC DOS.
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CoolerMaster or CM as
it’s commonly referred

to, enjoys the patronage of
enthusiasts thanks largely
to their attractive STACKER
and COSMOS cabinets,
which fall in the upper ech-
elon of the desktop cabi-
nets. The CM690, on the
other hand promises the
performance and designer
looks of the higher end at a
reasonable price.   

A thin chrome strips
runs across the entire length
of the mess and it contrasts
nicely with the black mesh.
The chunky rubber feet with
slanting cuts give the case a
sporty stance.  

The front panel connec-
tors have been moved to the
top and consist of two USBs,
one Firewire and one eSATA
port. Thumb screws mean
opening the case requires
no tools. The side panel

comes out with minimum
effort. Except for the moth-
erboard, all other compo-
nents can be installed
without screws. 

Near the front, there are
five 5.25-inch bays and
another five 3.5-inch bays
for connecting optical
drives and hard drives,
respectively. A large 120-

mm fan ensures the hard
drives are kept cool. The
cabling can be routed
within the case using the
sturdy clamps provided
inside. The case comes with
three 120-mm fans installed
and additional 3 fans can
be installed to cool the
components.      

Everything from the side
panels and power supply
housing, to the HDD trays
and the fan mounts have
silent, (read rubber), treat-
ment to keep the dBs down.
There are two rubber lined
holes for passing liquid
cooling pipes too. The side
panel has a stylish cut and
displays your wares in their
full glory.  

The CM690 performs
well and handles even a Core

2 Duo X6800 and GeForce
8800GTX with a RAID 0 hard
drive array without breaking
a sweat. This along with
three 120-mm fans—one at
the rear (exhaust), one in the
front (intake) and another
exhaust on the side panel.

The CM690 retails for
some 4,000 odd bucks and
for that price it’s a steal. In
case you are planning to
build a gaming PC, then the
CM690 should be on your
must have list. Though a tad
expensive than the normal
beige boxes, the CM690
makes up for it in every con-
ceivable way. 

Specifications
Form factor—Mid Tower, 3.5-
inch bays—5, 5.25-inch bays—5,
No of fans—3x120 mm, side
panel cut (acrylic) tool less
design.

Contact: Coolermaster India 
Phone: +91-9833870302
E-mail: tanmay_l@coolermaster.com 
Web site: www.coolermaster.com

Contact: Lenovo India Pvt. Ltd
Phone: +91-80-22108490
E-mail: buy@in.lenovo.com
Web site: www.lenovo.com/in
Price: Rs 15,800

Features  
Performance 
Build quality
Value for Money
Overall 

RATINGS

Features  
Performance 
Build quality
Value for Money
Overall 

RATINGS

Lenovo ThinkCentre A61e
Green PC

CoolerMaster CM690
Keep Your Cool
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2.1 Speaker Sets
Altec Lansing MX5021

Excellent performance
Some minor vibrations in woofer

Contact Rashi Peripherals Pvt.Ltd
Phone +91-22-67090909
E-mail altec@rptechindia.com
Price Rs 7,600

5.1 Speaker Sets
Logitech Z-5500 Digital

Explosive power
Too expensive

Contact Logitech
Phone +91-22-26571160
E-mail kavita_nath@logitech.com
Price Rs 27,995

Processors
Intel QX6850 Core 2 Extreme

Extreme performance
Expensive
Contact Intel Tech India Pvt Ltd
Phone +91-9833823474
E-mail saranya.rustagi@intel.com
Price Rs 52,000

Projectors
Acer PD726W

Great overall performance
Lacks remote sensor at rear

Contact Acer India Pvt Ltd
Phone +91-9880544226
E-mail alankar_s@acer.co.in
Price Rs 1,35,000

MP3 Player above Rs
10,000
Cowon D2

Very good performance
Slightly bulky 
Contact Lipap Systems P. Ltd
Phone +91-9819917440
E-mail iaudio@lipap.com
Price Rs 11,000

Digital Cameras
(High-End)
Canon PowerShot A570 IS

Good overall performance
Lacking in macro 
performance 
Contact Canon India Pvt Ltd
Phone 1800-345-3366
E-mail info@canon.co.in
Price Rs 13,995

LCD Monitors (19-inch)
AOC 197S

Good looks and performance
Gloss finish catches smudges

Contact AOC India
Phone 1800-425-4318
E-mail info@in.aocmonitor.com
Price Rs 12,000

LCD Monitors (17-inch)
AOC 177V

Good performance
None in particular

Contact AOC India
Phone 1800-425-4318
E-mail info@in.aocmonitor.com
Price Rs 9,800

MP3 Players up to Rs 5,000
Apacer Steno A4351

Good performence
Tacky build, Screen quality

Contact Apacer Technology
Phone +91-80-25702208
E-mail   suraj_raina@apacer.com
Price Rs 1,720

MP3 Players up to Rs 10,000
Samsung T10

Good music quality, nice
screen
Tacky exterior

Contact Samsung India Ltd
Phone +91-11-41511234
E-mail jitendra.c@samsung.com
Price Rs 6,600

Internal DVD-Writers
Samsung SH-S203

Performance, inexpensive 
None in particular

Contact Samsung India
Electronics Pvt Ltd

Phone +91-11-41511234
E-mail c.serrao@samsung.com
Price Rs 1,200

Internal SATA Hard Drives
WD Caviar SE16 WD5000AAKS

Fast transfer speeds
None in particular

Contact Champion Computers 
Pvt Ltd

Phone +91-11-26214751
Web site www.championindia.com
Price Rs 7,500
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Graphics Cards (High-End) 
Galaxy GF8800Ultra

Sheer performance
Heats up
Contact Technology and Gadgets
Phone +91-22-23823331
Web site technologyandgadgets 

.com
Price Rs 35,000

Graphics Cards 
(Mid-range) 
ASUS EN8600GT 

Well priced, fast
None in particular
Contact Asus Technology Pvt Ltd
Phone +91-22-67668800
Web site http://in.asus.com 
Price Rs 8,800

External Portable Hard
Drives
WD Passport Portable (Black)

Excellent performance, good
value
None in particular

Contact Champion Computers 
Pvt Ltd

Phone +91-11-26214751
Web site www.championindia.com
Price Rs 6,500

Internal SATA Hard Drives
WD Caviar SE16 WD3200AAKS

Value for money, 
performance
None in particular

Contact Champion Computers 
Pvt Ltd

Phone +91-11-26214751
Web site www.championindia.com
Price Rs 4,500

Multimedia Cell Phone
above 20,000
Nokia N95 8 GB

Great all round performance
Slightly bulky

Contact Nokia India
Web site www.nokia.com
Price Rs 28,000

Below Rs 12,500
Sony-Ericsson W910i 

Great sound
Flat and clumsy keypad
Contact Sony Ericsson Mobile 

Comm. India Pvt Ltd
Web site www.sonyericsson.com
Price Rs 19,000

Intel P35-based
Motherboards
ASUS P5K Premium

Excellent enthusiast solution
Expensive

Contact ASUS Technology Pvt Ltd
Phone +91-22–67668800 
E-mail media_india@asus.com
Price Rs 15,870

Intel Integrated Graphics
Motherboards
Gigabyte GA-G33-DS3R

Very good layout
Expensive 

Contact Gigabyte Tech India Ltd 
Phone +91-22-30616666
E-mail sales@gigabyte.in
Price Rs 9,500

Desktop PCs
Sahara 20CK16

Great performer
Slightly bulky

Contact Sahara Computers & 
Electronics Ltd

Phone +91-120-4397777 
E-mail info@saharacomputers.co.in
Price Rs 40,000

AMD AM2 Motherboards
Gigabyte GA-MA69G-S3H

Well built, feature rich
None in particular

Contact Gigabyte Tech India Ltd 
Phone +91-22-30616666
E-mail sales@gigabyte.in
Price Rs 6,900

Home Inkjet MFDs
Canon PIXMA MP160

Good performance
No memory card reader 

Contact Canon India Pvt Ltd
Phone 1800-345-3366
E-mail info@canon.co.in
Price Rs 5,995

Mono Laser MFDs
Brother MFC-7420

Great cost per page, fax
No Ethernet Port 

Contact Brother International India
Pvt Ltd 

Phone 1800-222-422
E-mail customercare@brother.in
Price Rs 18,000

PCI TV-Tuners
Leadtek Winfast PVR2000

Excellent video quality and 
software
Expensive

Contact Topnotch Infotronix (India)
Pvt Ltd

Phone +91-44-42042565
E-mail naqui@zebronics.net
Price Rs 5,500

Mono Laser Printers
HP LaserJet 1020

Good combination of speed,   
print quality, and warranty
A bit slow in comparison to
others

Contact Hewlett-Packard India 
Sales Pvt Ltd 

Phone +91-124-2566111
E-mail kakuni.mahto@hp.com  
Price Rs 6,999

Mice
Logitech MX Revolution

Has a flywheel
Expensive

Contact Logitech Electronic 
India Pvt Ltd 

Phone +91-22-26571160
E-mail response@logitech.com
Price Rs 8,000

Performance Laptops
HP DV6226tx

Funky Looker, features 
Needs better graphics

Contact Hewlett-Packard India
Phone +91-124-2838700
E-mail tapoti-t.tipnis@hp.com
Price Rs 56,990

The best products tested so far in different 
hardware and software categoriesThe A-List
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Value Executive Phone
Nokia E51

Loads of features
None

Contact Nokia India
Web site www.nokia.com 
Price Rs 13,000

Business Device
Nokia Communicator E90

Extremely powerful
Heavy, bulky

Contact Nokia India 
Web site: www.nokia.com
Price Rs 40,499

Office Inkjet MFDs
HP Photosmart C4188 All-in-
One

Good print quality
No fax

Contact HP India Sales Pvt.
Ltd.

Phone +91-124-2566111
E-mail kakuni.mahto@hp.com
Price Rs 7,999

DVD/DivX Players
Samsung DVD-1080P7

Great looks and perform-
ance

No 5.1 channel RCA

Contact Samsung India
Electronics Pvt. Ltd.

Phone +91-11-41511234
E-mail shailja.m@

samsung.com 
Price Rs 2,990
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Broader Scope
India being one of the fastest growing 

markets for civil aviation, leading avionics 
companies have a presence in this country
directly or indirectly. For any outsourcing 
business like design, development or 
production, India has always served to be the
ideal option. “Avionics jobs are similar to other
engineering jobs, with the exception of need
for aircraft knowledge”, says C. V. Ravi Shankar,
Director, Merlin Hawk Aerospace, involved in
research, design and value added development
of hardware and software for aviation and aero-
space applications. 

Civil and defence are two areas you can
work in. The functional roles remain nearly the
same in both these areas. An avionics candidate
can be involved in functional roles like design,
development, integration, testing and advanced
research of the hardware and software for
avionics systems.

The private sector in the avionics field com-
prises the aerospace components 
suppliers / OEMs, IT solutions providern and
other small and medium enterprises dealing
with maintenance and allied services. Speaking
of IT specifically, top IT companies like Infosys,
Satyam, HCL, TCS, Wipro, Hindustan Aeronautics
Limited, to name a few, specialise in providing
solutions as aerospace IT players. 

“In avionics, one should know and be sure of
where and what is the specialisation required

Samir Makwana

Like the heart is an integral part of the
human body, an aircraft also has a
heart—the avionics system. This system

forms the integral part of an aircraft design
and increases its capability. All the electronic 
components utilised in an aircraft for display,
communication, navigation and management
of other systems linked with them form the
avionics system. Electronics systems like 
communications, surveillance and navigation
systems, display systems, flight management
systems, engine, fuel systems and other 
primary functions are used on an aircraft. 

Avionics systems play a crucial role for 
effectiveness of the aircraft. Complex as well as
expensive by nature, avionics systems are often
called ‘systems of systems’. For designing, 
integrating and testing the avionics systems
and subsystems, a lot of expertise, time and
money is required. 

For the past five years, the Indian aerospace
and aviation industry has been registering 
significant growth. Praful Patel, Minister of
State for Civil Aviation, stated at the World
Economic Forum held at Davos in January that
the current annual growth of numbers of
domestic passengers is 40 per cent and an 
average growth of 25 per cent per year is expect-
ed over the next five years. 

Upwardly
Mobile

Want a high-flying career? The booming field of avionics beckons you

Tech Careers

Tech Career_April 08.qxd  5/13/2008  12:16 PM  Page 83



85DIGIT APRIL 2008

Digital Business l Tech Careers

“If you’re really keen about avionics then you
can take up research as your career goal and join
research establishments like the Defence Avionics
Research Establishment. You can also work for
organisations like NAL, HAL, ISRO and DRDO or
labs like ADE and ADA”, says Vanamali.

Gaining hands-on experience and 
undergoing training at the apprentice level is a
crucial part of an avionics career. 

Besides academic qualifications, other basic
skills like job knowledge, reasoning power, 
analytical ability, task orientation, tool 
identification, innovation, communication and
being a team player are expected in freshers.

“The best thing would be to have some 
industry participation with colleges during the
project phase. More than seminars, one-on-one
hands-on training programs may be more use-
ful in minimising the demand-supply gap”,
says Kumar. 

Know Your Role
The levels of hierarchy in this sector remain the
same as other occupations. The typical jump
from the fresher level to the intermediate level
requires good knowledge and rigorous hands-on
working experience in dealing with 
mission-critical hardware and software. 

One can expect to work in the following 
hierarchy:
l Top level-Director / Project Manager
l Middle Level-Avionics / Aircraft Engineer
l Intermediate-Senior Technician / Developer / Software

Tester
l Entry Level-Asst. Engineers / Technicians

With the IT outsourcing companies the structure is:
l Top level-Vice President / Director / Project Manager
l Middle-Technical Lead
l Intermediate-Senior Tools Developer / Designer /

Architect / Tester
l Entry level-Programmer / Tool Developer / Designer

Note that here the structure remains more or less the
same whether you work on hardware design-testing or
software development. 

At IT outsourcing companies, one month of vigorous
training on avionics domain—software development tools
and verification tools—is provided before candidates are
deployed on projects. Due to shortage of skilled workforce,
many IT outsourcing units have developed and 
implemented their own training programmes for fresh
recruits. Generally, training involves developing 
familiarity of working with co-ordination between 
software and hardware systems.

The Future 
Like every other industry in the IT and ITeS domain,
the avionics industry is also starved for a skilled work-

force. The private aviation sector is yet to
make it big by constructing an entire plane
(for civil or military use) or complete engine
by itself. Machines are getting more automat-
ed as technology advances, so the scope for
growth is high. 

“With a number of regional airlines 
coming into existence and growing at rapid
speed while other national airlines go 
international, the growth of employment
opportunities will take place. The industry
has bright prospects,” says Mehta.

The outsourcing business of the aviation
industry has also gone up. “We’re already
ahead in terms of software development and
the research front. With the 30 to 50 per cent
offset clause for aircraft and defence pur-
chase, lot of joint ventures in aviation indus-
tries are coming up like maintenance and
repair organisations at the Tier-I and Tier-II
cities. Apart from that many industries and
sub-industries will emerge with huge finan-
cial outlays,” says Singh.

Major developments are afoot in this 
sector. For example, DaimlerChrysler is setting
up research centres, IT honchos like Infosys,
TCS and HCL are offering specialised 
engineering and design services, and firms
like Hindustan Aeronautics are planning to
invest in R&D as well as manufacture aircraft
components in India. 

Patel has predicted at the World Economic
Forum that the fleet of aircraft operating
domestically is expected to increase from the
current 400 to about 2,500 by 2020. Hence the
long-term equation for the avionics sector is
simple—more passengers, more planes, more
demand for skilled work force. 

samir.makwana@thinkdigit.com
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since there are different sub-divisions in the
field. For example, mission computer and 
related hardware, cockpit displays, inertial 
navigation systems, weapons guidance system,
etc., are parts of hardware. (Providing) software
for those systems is again a challenging task,”
says Suresh Kumar, Director-Sales, Datasol (B),
which designs, develops and integrates modular 
products focusing on the areas of automated test
equipment, avionics and embedded Systems.

The different sub-areas you can specialise in
avionics are flight control system, flight 
management system, communication system,
navigation system, surveillance system, safety
and security system, power and electrical 
control system, in-flight entertainment and
other miscellaneous systems.

On The Radar
You can decide to work either on the software
side or the hardware side of avionics systems.
Besides defence, options of working with other
services-oriented organisations like the IT 
companies as well as the maintenance, repair
and overhauling companies are widely open.  

IT companies provide solutions on both
hardware as well as software side for working
with avionics systems. 

On Hardware side 
Detailed hardware design (VLSI-digital and 
analog, FPGA, ASIC), testing of the equip-
ments and components like radio frequency
chips, quality and qualification testing with 
environment, system safety analysis and even
critical hardware manufacturing and 
development are a few options. IT solutions 
organisations are involved in providing the
DTI (Design, Testing and Integration) 
solutions to airlines.

Today, the latest aircraft carry a unified
solution in form of an open architecture 
computer as well. By synchronising the other
subsystems like the radar systems and sensory
systems with the core avionics systems, mission
critical data is processed and displayed. The
same data is communicated through radio
communication to specified towers at airports.

Electronics engineers get involved mostly
with designing and testing of the avionics 
hardware and subsystems. For example, VLSI
chip design engineers specialise in designing
different silicon components for mission 
computers based on open architecture. 

On software side
Mission-critical electronic systems interface
with the hardware using some software 
systems. The computers and embedded 
electronics used in aircraft today run on 
real-time operating systems. It’s the data 
processing software that collects the data
from the mission computer based on open sys-
tem standards. 

Avionics software and components testing
professionals are expected to check whether 
different avionics subsystems and hardware
components are working properly or not. 
In-flight entertainment services also require

strong networking and telecommunication
support, which has to match the regulatory
standards. Every organisation working with
hardware and software of avionics systems
must meet the respective standards for 
hardware and software published by the Radio
Technical Commission for Aeronautics (RTCA).

For software programmers, knowledge of
different basic programming languages like C,
C++, MATLAB, and familiarity of working with
RTOS as well as other platforms is necessary.
Simulated environments are created to test
avionics systems. Proficiency or awareness of
CAD / CAE / CAM design tools and flair for
design is also expected—it’s been the most
essential practice in the automobiles as well as
aviation industry. 

Take-off Conditions
Deep interest in using cutting-edge computing
ability and advanced electronics in challenging
applications areas form basic elements for
avionics education. 

A strong fundamental background in 
mathematics, physics, electronics, chemistry,
computer science, mechanical drawing / 
drafting, and conventional software 
programming is also helpful. 

“Usually candidates carrying bachelors /
masters level engineering degree or aeronauti-
cal engineering or aircraft maintenance and 
engineering can have an edge over others by
specialising in systems engineering and 
instrumentation engineering,” says Retd. Air
Cmde. Raghubir Singh, Director-Training at the
Indian Institute of Aeronautical Engineering
and Information Technology, Pune. 

“Certain universities like Anna University,
VTU and IITs offer a specialisation in avionics. A
career in avionics requires an ability to appreci-
ate and understand systems engineering. In
today’s world where avionics has graduated
from a standalone cluster of systems like FCS,
FMS, and CNS to a level where the latest 
concept is “Integrated Modular Avionics”—it is
important that an aspirant has solid grounding
in electronics and further systems 
engineering,” says Abhishek Vanamali, Group
Manager-Marketing, HCL’s Aerospace Practice,
HCL Technologies Pvt. Ltd., which offers 
specialised expertise for hardware and software
system level solution services.

Many colleges / institutes tie up with foreign
universities to offer specific and specialised
courses. For instance, Sreenidhi Institute of
Science and Technology, Hyderabad (accredited
by AICTE) has tied up with Vaughn College of
Aeronautics and Technology, New York, to 
provide courses for electronics engineering and
technology with specialisation in avionics.

Find Your Way
The procedure of recruiting remains uniform
for this industry—a written aptitude test 
followed by personal interviews. At times, 
private sector companies  have practical
exams to test the hands-on knowledge and
strength of the candidates in their respective
field of specialisation. 

“Understand the
workings and
develop a passion
for Aircraft
instrumentation
and Engineering.
Avionics jobs are
similar to other
engineering jobs,
with the
exception of need
for aircraft
knowledge.”

C.V. Ravi Shankar
Technical Director
Merlinhawk Aerospace
Pvt. Ltd.

IIT-Kharagpur
IIT-Bombay
IIT-Kanpur
IIT-Madras
Indian Institute of Aeronautical
Engineering, Dehradun
Academy of Aerospace & Aviation,
Indore
Bangalore Institute of Aeronautical
Engineering & IT, Bangalore
Hindustan College of Engineering
Kelambakkam (Tamil Nadu)
Hindustan Electronics Academy,
Bangalore
Hindustan Institute of Aeronautics,
Bhopal
Hindustan Institute of Engineering
Technology, Chennai
Indian Institute of Aeronautical
Engineering and Information
Technology, Pune
Indian Institute of Aeronautics, Patna
Institute of Aviation Technology,
Haryana
Madras Institute of Technology, Anna
University, Chennai
National Institute of Aeronautical
Engineering, Dehradun

Nehru College of Aeronautics &
Applied Science, Coimbatore
Park College of Engineering and
Technology, Coimbatore
School of Aviation Science and
Technology, New Delhi
Indian Institute of Aeronautical
Science, Jamshedpur
Institute of Aviation & Technology,
Bhubaneswar
Nehru College of Aeronautics &
Applied Science, Coimbatore
P.A.M.E College, Patiala, (Punjab)
Rajiv Gandhi Memorial College Of
Aeronautics, Jaipur
School of Aviation Science and
Technology, New Delhi
VSM Aerospace, Chelekere, Bangalore
Buddha Institute of Aviation
Technology, New Delhi
Indian Institute of Aeronautical
Engineering, Dehradun
Indraprasth Institute of Aeronautics,
Gurgaon
Academy of Aerospace & Aviation,
Indore
National Defence Academy, Pune

Indicative College List

Payday
Salary 
Per Annum (INR)
10 lakh and above

8—10 lakh

6.4—7.5 lakh

4—6 lakh

Experience
(Years)
10—15

5—10 or more

3—5 or more

0—3

Designation

Higher Technical &
Administrative Positions

Avionics / Aircraft Engineer

Senior Technician / Developer /
Software Tester

Assts. Engineers. / Technicians
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Nimish Chandiramani

When you think “project management”,
you normally think Microsoft Project,
which in turn makes you think that

project management solutions are for software
development companies only. In a sense, this is
true—the first solutions were indeed designed
to make software development easier. They
enabled confusion-free collaboration, and pro-
vided a way to analyse the development team’s
efficiency at the end. If you’re reading this and
thinking, “I need this too!” we won’t blame you.
The benefits of a project management solution
should be available to any organisation whose
business is based on projects from clients, and
more so when deadlines are tight.

Sadly, many project management solu-
tions—both open source and commercial—are
still built with software projects in mind, but
there are a few that can be customised to suit
anyone. One such solution is dotProject, which
is very easy to get used to, and works for
anyone whose work comes as projects.

Prelude
To run dotProject, you’ll need a dedicated 
PC of modest configuration; this is a Web-
based solution meant for the LAMP (Linux-
Apache-MySQL-PHP) platform, so running it on
a Linux-based machine is advisable. If you
prefer Windows, install Wampserver
(http://www.wampserver.com), which automati-
cally installs Apache, MySQL and PHP on your
PC. We’ll use this approach for now. 

The first thing you need to do after
installing Wamp is to fix the most important
security hole—the administrative user for
MySQL (root) has no password. To fix this, start
PHPMyAdmin by clicking on the Wamp icon in
the system tray and choosing PHPMyAdmin.
This lets you administer your database from
within your browser. Click on the Privileges
link, and you’ll see a user overview. Click on
the little icon next to the entry for “root” to
edit it. Scroll down a bit, and you’ll be able to
change the password. Now open C:\wamp\
apps\phpmyadmin2.10.1\config.inc.php,
search for $cfg[‘Servers’][$i][‘pass-
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Getting
On Track

You don’t have
to be a

software
development

company to
worry about

project
management

solutions—
dotProject can
be customised
to your needs

too
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comes the important part—the tasks. Before
you begin with creating tasks, you should have
them charted out on paper.

Under the Projects menu, you can view your
project by clicking on its name. In the View Pro-
ject screen, hit New Task to begin creating
tasks. Under the Details tab, you can select an
owner for the task (the person in charge), and
even create sub-tasks by choosing a parent task.
The Dates tab is where you set the deadline for
your task—you can enter a finish date and have
the program calculate the number of working
hours it’ll take, or vice versa. 

If the starting of one task is dependent on
the finishing of another—for example, editing
an article depends on the completion of its
writing—use the Dependencies tab to add the
task that your current task is dependent on.
Remember to check the box for Set task
start date based on dependency. Finally,
under the Human Resources tab, you can
assign one or more of your team to it. Annoy-
ingly enough, you’ll also have to keep
removing yourself from that list. Add any com-
ments you’d like, and hit Save—the people
assigned to the project will automatically be
informed by e-mail. When you go back to the
View Project screen, you’ll see a list of tasks
at the bottom. Click on a task’s name to view
its details. 

The New Log tab lets the assignee update
the status of the task—progress as a per-
centage, hours worked, and so on, with a
mandatory “worthwhile comment”. If there
are any files associated with the task—Excel
sheets come to mind, they can be uploaded
using the Files tab. 

That’s about all you need to know to start
using the most essential features...

Business As Usual
Apart from tasks, you can add events to proj-
ects—meetings, appointments and so on. You
also have the option to create discussion
forums where your team can discuss ideas,
clarify doubts, and every once in a while, goof
off. When project workers are having trouble
with their tasks, they can raise trouble tickets
under the Tickets menu item—the ticket will
remain open till the issue is resolved. 

Your first few days with dotProject will
likely be a little tough, but once you get used
to it, you’ll find your team working much
smoother than ever before. 

nimish.chandiramani@thinkdigit.com

View a quick summary of your project and its tasks

word’], and enter your new password here.
Save the file and restart your browser.

Once that’s done, you need to create
another user with lesser privileges than root—
this is the user that dotProject will use when
it makes requests to the database. Go back to
the Privileges page and choose Add New User.
Give this user a name (let’s call it projmgr) and
password, and under Global Privileges, give it
all privileges under Data and Structure, but
not under Administration. Your database is
now ready for dotProject.

Setting Up
You can download dotProject from
http://www.dotproject.net/. Extract the
contents of the ZIP file to C:\wamp\www. To
start the installation, go to http://localhost/dot-
project in your browser. 

The first screen gives you a list of require-
ments and whether your PC meets them—you

Before you start anything, change the root password

can safely ignore this and click Start Installa-
tion. In the database settings, enter projmgr
(the name of the user you just created) as the
Database User Name, and use the correspon-
ding password. Leave everything else as is and
click Install db and write cfg. Once that’s
done, use the link given to start working on
your dotProject installation. Like the page says,
it’s a good idea to change your admin password
when you log in.

Getting Started
When you log in, you’re first asked to configure
your dotProject system. You’ll have to change the
currency and company name, naturally. You can
tweak the rest as you please. Under Email Set-
tings, you should choose SMTP and use the
same SMTP server you use for your official e-
mail. Once you’re done here, click Save to get
started with doing some real work.

Let’s say you’re designing a Web site for a
company called DummyCo. The first thing you
do is create the company in your database—this
makes sure that if you get more business from
them, you don’t have to enter it in your data-
base again. Click on Companies in the top
menu to create a new company. 

In the Add Company page, you’ll see a drop-
down menu for Company Owner—this is just
the person who has the right to edit the com-
pany’s details, not the actual owner. This is
usually the administrator (you); it’s best to
leave it at that.

Before you start adding projects, you need
to add the people who’ll be working on them.
Select User Admin from the menu at the top to
start creating users. You should create a user
account for yourself too, and use the adminis-
trator account only for, well, administrative
purposes. When you’re done creating the user
account, check the box to inform the user of
their details, and hit Submit. The next step is
to assign rights to the user you just created;
this, unfortunately, can be quite tedious. To
speed things up, dotProject has a set of User
Roles—Administrator, Anonymous, Guest and
Project Worker—which come with a set of pre-
configured permissions. You can assign these
roles when you create the user, or under the
Roles tab when you’re editing the user’s
details. You’ll likely be using the Project
Worker role most often—these users don’t have
access to administration modules, and have
full access to the non-admin modules. 

You can also set access rights for individual
items—for example, you can restrict users to
one specific company by choosing Companies
under Module, and then the company in ques-
tion under Item. In general, this is a section
you’ll be coming back to a lot—it isn’t exactly
a pleasure to deal with, and will take some
time before you’re comfortable with it.

Your First Project
User the Projects menu, use the New Project
button to get started. The details are quite self-
explanatory; fill them up and hit Submit. Now

Permissions
aren’t exactly a
pleasure to deal
with, and it will
take some time
before you’re
comfortable
with them

Companies can be Clients, Vendors, Government or even yourself
(Internal)
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should be able to complete its transition to Google
Apps in less than twenty minutes. You can also add
more users later. Accept the terms and conditions
and proceed to the next page—the dashboard. This,
as the name suggests, is the panel with all the con-
trols—it is nothing but the administrative page of
your domain.

On the dashboard, are several major services—
the Start Page, Calendar, Chat, Docs, Email, Web
pages and Sites. Before proceeding to these serv-
ices, create a list of users in your organisation. To
create new users, simply click on Create New Users.
For each user, fill the three data fields—name, sur-

Nash David

Organisations have needs—office documentation, e-mail, personal com-
munications (including chat), and scheduling and organising solu-
tions such as calendars. We’ve said plenty about how Google’s

productivity applications can make a difference to you as an individual, so
why must you settle for less just because you can’t use your Gmail ID for
work? Google Apps For Your Domain gives you all that Google goodness and
lets you keep your work ID—what’s better, you don’t have to bear the cost of
a dedicated mail server any more!

The Whole Package
To start with Google Apps, visit www.google.com/a/. Only domain adminis-
trators can sign up for Google Apps services—this is for improved security
and to prevent anonymous users from abusing domains. On the Google Apps
page, enter your official e-mail address and click on Get Started. After this,
Google verifies you as the administrator of the domain, and in a matter of
minutes, your organisation should be registered. On the next page, fill in all
your details and provide a password, with other contact information. With
an initial e-mail user count of 200, practically any small or medium business

name and username. Google Apps provides you—
the administrator—with a password that can be
changed later by the new users. You can also upload
a compiled list of all users in the CSV (Comma Sep-
arated Value) format, and all users can be created
at once. This makes things really easy for you.

Start Page
The Start Page is where you access all Google appli-
cations. You can personalise the start page in the
same way you personalise your iGoogle page—
bring together your content, other Google services,
and interesting applications from the. The URL for
the Start Page is typically http://start.your-
domain.com. The first time you click on the start
page, the typical feeds available are your e-mail—
where you can see a snapshot of the new e-mails
in your inbox as well a shortcut to compose a new
mail. Other useful applications that you find on
the Start Page are Calendar and Sticky notes,
which is an online alternative to the post-it.

Calendars
The calendar is a critical tool in time manage-
ment. Access your calendar at
http://calendar.your-domain.com. Insert an event in
the calendar by clicking on the respective date,
at the start time of your event. In the balloon
that pops up, type your agenda. If you realise
that the event is going to consume more time
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Worried about the cost of setting up servers for
your office needs? Call on Google Apps instead!
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You have to start with creating an account

Google Apps takes care of
most of your IT require-
ments

One window for all your needs
Google Apps takes care of most of your IT needs
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than the default hour, you just have to drag the
lower end of the event box.

You can share calendars with each other, and
know when members of your team are free or
busy—this lets you plan activities around
everyone’s schedule. You can also synchronise your
Google calendar with Outlook (using third-party
software), and even with your Blackberry.

Docs
Google Docs is another interesting tool that’s a
part of Google Apps. With Google Docs, you can
do away with the Office suite altogether. You and
your team can collaborate on documents, spread-
sheets and presentations all in one go! Google
Docs offers you the option to share and publish
your documents in to a unique URL. That apart,
you can save it to a host of other formats too. This
is of immense help to those people who are
always on the move. They can start work while
away from their workspace, without worrying
about any data being lost. To use Google Docs,
visit http://docs.your-domain.com. Once here, you
can click on the New tab to the left. Of the
options for Document, Spreadsheet or Presenta-
tion, choose any depending on your require-
ment. Once you start typing, Google Docs
continuously saves your document as and when
changes are made. 

E-mail
In its basic version, Google Apps provides 6 GB of
storage per user—quite like a personal Gmail
account. The URL for your e-mail will be
http://mail.your-domain.com. In addition, Google
also monitors abuse@yourdomain.com and 
postmaster@yourdomain.com to report spam, abuse
and other technical issues. Configuring the
email addresses of your employees to Google
Apps doesn’t require more than couple of min-
utes. There are two major steps involved in set-
ting up your new mail service. First, you need to
create new user accounts. Second, set up the
email delivery.

To switch your domain to use Google Mail,
you’ll need to change your MX records—you can
do this from the administration page of your
hosting provider. You can find instructions specific
to your provider here: http://www.google.com/sup-
port/a/bin/answer.py?answer=87084. It takes around

two days for MX records to get updated—to avoid
losing e-mails during this time, first create all the
e-mail accounts you need, and only then change
the MX records.  

You can upload the details of existing e-mail
accounts in bulk using the CSV format—user-
name,userid,password. Log in to the control
panel and go to Advanced tools. To upload the list
in bulk, go to User Accounts Bulk Update. Upload
the CSV file, and you’re done. Once you’ve created
the same user accounts in your control panel as
you have in your existing domain, you won’t lose
any new mail.

Another interesting feature that Google Apps
provides is email reforwarding. For example, say
you have an employee named John in your organ-
isation, and his email address is john.smith@ your-
domain.com. If someone sends an e-mail to
johnsmith@your-domain.com, you can set it up so
that the e-mail reaches a “catch all” account like
error@your-domain.com.

Chat
At times, teams in your organisation may reside
at remote locations or even client bases,
making communication back and forth rather
tedious and expensive. To reduce these ancil-
lary costs, Google Talk is a viable option. With
Google Apps, you can configure Google Talk
within the users in your organisation. To con-
trol the use of Google Talk, go to the dashboard
and click Chat—Google Apps gives you the
option to warn your users when they chat with
users outside your domain. You can use this fea-
ture to ensure no sensitive information gets
out, and that your employees aren’t wasting
their time chatting with friends.

Wrapping Up
You get to take charge of all your online needs,
without the hassles a typical system adminis-
trator faces. Google does all the dirty work for
you, while you can focus on improved produc-
tivity and business related issues. Apart from this,
if the Docs application is optimally used, you can
drive the running costs to rock bottom by doing
away with the office suite completely. With large
corporate houses also showing interest in Google
Apps, this is one upcoming trend. 

nash.david@thinkdigit.com

You can set passwords for new users, or let Google auto-generate one
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Agent 001

Even techies need a vacation,
right? I rarely get time off,
and even your beloved

agent is susceptible to stress. It’s
been a long time since I went on
holiday, and my diligence and
hard work this past year was
rewarded with a whole two
weeks off! Two weeks to recharge
my batteries, two weeks of de-
stressing and rejuvenation, all
for the humble goal of serving
you, my beloved reader, a little
better. Sadly I couldn’t afford a
trip abroad having spent all my
spare cash on gadgets (what
else?), and exotic locations and
fast cars are more 007 dominion,
but as 001 I have my standards
too! I wanted something out-
doors, something away from the
hustle and bustle of urbanisa-
tion. I was thinking calm peace-
ful waters, greenery, wildlife, a
little adventure, and mostly iso-
lation. Kerala and its beautiful
backwaters I have seen before,
and having become accustomed

to the warm and cosy environs of
Mumbai, the cold (brrr!) north
was out. After a bit of googling,
and searching through each
state’s official tourism Web site, I
finally decided on the so-called
heart of India—Madhya Pradesh
(MP). I googled quite a bit on the
local people, places of interest,
climatic conditions (my pro-
posed visit is around the begin-
ning of April). So two days into
my holiday and I was all set.

I decided to visit the capital
city Bhopal first—it’s supposed to
be the city of lakes as well as being
steeped in history. I booked my
ticket online courtesy my account
at www.makemytrip.com, and 3,500
bucks off my credit card later I
was on my way. As exciting as a
holiday is, especially when you’re
taking one after more than a year,
I took my time making a list of
the stuff that I would need for the
trip, and took a printout of the
same, which was pasted atop my
fridge for reference.

I needed something to enable
productivity on the go, and I was
torn between notebook and PDA.

Digital Leisure l Touched By Tech

Technology Beyond Work
Leisure
Digital

108 Game on Tabloid Tech98 DVD / DivX
Players Tested 122
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Geek’s
Week Out 

I finally got some much deserved, and much needed
time off from my hectic, do good existence. Two weeks

off!-here’s how it was spent, and with whom…
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I finally decided to take my notebook instead
of my PDA as typing on a small, uncom-
fortable Bluetooth keyboard has never been
my cup of tea. So it was my shiny new Dell
XPS 1330 a gift from my US-based uncle that
got the nod ahead of my PDA. With a 13.3
inch screen, a Core 2 Duo T8100 processor,
2 GB of RAM, a 160 GB hard drive and a
GeForce 8400GS graphics solution the XPS
1330 is compact enough to be lugged
around in my backpack, and powerful
enough to process just about anything. I
installed a spare copy of PhotoShop CS2 (holi-
days mean great photographs right?), and
ensured that I had Office 2003 installed for any
correspondence that might need tackling. Also on
board was a Reliance Data card. Coupled with my
laptop this would ensure that I could receive offi-
cial mails, and be in touch with the guys at office as
long as I was within Reliance’s network area, which
according to online reports is pretty decent in MP. I
would rely on my data card and laptop duo to book
a return ticket to Mumbai as I wasn’t sure of my
exact itinerary. Other than that I wanted to main-
tain a journal of activities, and the sights and
sounds and other interesting facts, and my laptop
would allow me to easily do this. My next craving
would be music, and I included my iPod Touch 16 GB
along with around 45 MP3 albums. The Touch is a
brilliant PMP, with superb quality music, and great
video and photo viewing thanks to its 3.5-inch
screen. Also available (though not of much use in
this case) is wireless connectivity. The best part of
the Touch has got to be its great interface, which
one never tires of. I also packed my Audio Technica
ATH A900 headphones (procured from http://tinyurl.
com/34wktn). Although circumaural and large, these
babies deliver pounding, liquid bass, and blissfully
clear highs, with a strong, emphasised mid range,
just what the doctor ordered for an unashamed
audiophile. My next travel companion would be a
Nokia N95 8GB. I’m a great believer of converged
devices and the convergence is this cell phones
middle name. With Quad band GSM, an ARM 11
processor, 8 GB of internal flash memory, a 5.0
megapixel camera, 2.8 inch 16.7 million colour
screen, inbuilt GPS (Global Positioning System), and
a 1200 mAh battery juicing everything this baby is
one helluva cell phone for the intrepid road warrior.
I downloaded Nokia maps for India, and to my
delight the highways of MP and the larger cities are
basically represented in the
software. I dropped in a
4 GB SanDisk USB
drive and my
t r u s t y
Tech-

Com memory card reader
into my laptop case’s side

pocket, after all if
portable storage isn’t
meant for a holiday
then what is?

Next I packed my
Nikon D40x camera
which is a compact digi-
tal SLR. With a 10.1
megapixel rating, an

ISO range of 100 to 1600, a
very intuitive menu on its

2.5 inch LCD and a large
viewfinder that gives 95 per

cent coverage the D40x is a very
good entry level DSLR and one

which has given me some terrific
results despite my amateurish (at

best) photography talent. With the
DSLR went a couple of multi purpose
lenses an 18-55mm—useful for regular
shooting, and an 18-200mm (borrowed

from a friend), which would come in handy for a
little more distance shooting. I also packed a couple
of 2 GB SanDisk Extreme 3 SD cards.

I threw in a couple of tubes of mosquito repel-
lent, and bought myself a nice pair of hiking boots
courtesy the nearest shoe showroom, and I was
ready. My afternoon flight happened to be an hour
late, and I spent the extra time surfing via GPRS on
my N95 8GB while grooving to some heavy metal on
my iPod Touch. The plane ride itself was unevent-
ful, and I caught a taxi at Bhopal’s Raja Bhoj airport

and checked in to a nearby hotel for the evening.
Incidentally Bhopal is a hilly region with an
average elevation of around 500 metres as
the readout on the Suunto X9i wrist
watch showed. This watch was on loan
from my editor and incorporates GPS,
altimeter, barometer, digital compass
and thermometer and is the ultimate
watch for the outdoors. Here’s a link
from where he ordered it—
http://www.amazon.com/gp/product/
B000EOMVZ4. Evening temperatures
were around 26 degrees (Suunto X9i
again)—not bad. Around 8.30 pm, and
a good bath and shave later I was in
the market place checking out the
local flavours. Dinner was a cheap
affair—a deliciously spicy plate of
chicken biryani. I spent an hour loaf-
ing around, and checked my mail a
little later on my laptop. I’m happy to
report Reliance’s network is good in
this part of the country, and the speed
was decent for a dialup connection.

After breakfast at 10:00 am the
next morning, I was on my way to the
Bhoj Wetlands and what is called the
Upper Lake. A really beautiful spot this, plenty of
greenery and the birdlife on the lake was really
something special. I thanked the 11.1x zoom lens
on my D40x and got a couple of excellent shots of
a flock of cranes fishing near the shore. I also
enjoyed a leisurely boat ride on the lake. I got a
couple of good shots of a large flock of geese that
seemed to think swimming alongside our slow
moving boat was fun. At this point the X9i on my
wrist was reading 35 degrees, hot! After an early
dinner I spent a couple of hours online, replying to
a couple of mails and chatting up a couple of
buddies via Yahoo Messenger. All the while charging
my iPod Touch via USB for a little late night audio-
phile action…It was all so relaxing—a comfortable
bed, a great view of peaceful, scenic old Bhopal, and
my A900 / iPod Touch combo belting out some seri-
ous audiophile sound. 

The next morning I
checked out, and got aboard
a rickety state transport bus
to Jabalpur, my real destina-
tion which I was exactly 312
kilometres away from. Six
bone jarring, back breaking
hours of travel, only relieved
by some scenic ghats ended
at 4.30 pm, in Madan Mahal,
Jabalpur. By now I had a
backache, and checked in to
a nearby hotel, and imme-
diately got online after a hot
bath. To my irritation
Reliance had some issues
with reception in the area—
so my XPS 1330 was basi-
cally useless for browsing.
Luckily Airtel offers very

good service in this part of
the country, and I was able to

get decent speeds, a couple of quick
replies later my aching back was ready

to call it a night. This is where my W-1205
portable back massager earns its bucks-bought

while on an official trip to Taiwan this little relief
package for your entire lumbar region sports six
motors, eight magnets and infra red heat therapy.
Very suitable for sore backs like mine, after 45
minutes I finally feel like a biped again.

The next day was spent at the beautiful Marble
Rocks of Jabalpur which are 200 feet high canyons
of marble, through which weaves the Narmada
River. I got some beautiful photos of Dhua Dhaar
which the famous waterfall that gets its name
from the droplets of water that spray due to the
velocity of the river’s flow. I even bought a couple
of marble mementos. A boat ride on the Narmada
followed by lunch that consisted of delicious dal,
rice, poories and three vegetables well-cooked saw
me content, and slightly lethargic (What? I’m on
holiday, remember?). The next day I made a few
phone calls and set up for a taxi to Kanha Kisli, a
well known wildlife reserve, resplendent with

Digital Leisure l Lead Feature

My N95 8 GB is my Ultimate Converged Device

My Audio Technica
ATH A900—expensive,

and maybe a little
bulky, but worth

every penny

The Dell XPS M1330 is exactly what the doctor
ordered—the keyboard is large enough for my
fingers, and I don’t have to lug a 15.4-inch
behemoth around!

I never step out without the
Suunto X9i—even though it
belongs to my editor!

My trusty Cruzer for my PC, and my Extreme
SD card for my camera—all my Flash memory
needs covered!
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greenery and wildlife, including tiger, leopard and
cheetal (spotted deer). The trip itself was fun,
village roads, a lot of greenery and water bodies,
and a small but scenic ghat section. I took a lot of
photos all along the way including a few clicks of
a family of monkeys that were sunning themselves
along the road. Everything seems so green here,
unfortunately after dark the mosquitoes become a
problem—thanks to the repellent I brought along I
was immune.

Kanha wildlife reserve proved to be the kind of
holiday escapade I was looking for. I booked a small
cottage, and immediately settled in. Thankfully
two plug points meant all my gadgetry was in good
charge. A couple of days of small treks skirting the
reserve, (for safety reasons nobody is allowed on
foot into the wildlife reserve), a lot of rest, and
updating my log, and my photograph collection
with various interesting titbits, and I was ready for
a foray into the park.

We set off early morning, and though I couldn’t
leave the vehicle I could get a lot of shots out of the
window. There is always an armed person onboard
each vehicle and this I got a nice photo of the guy
with his rifle, proudly twirling his moustache. The
winding road into the park was in permanent leaf
shadow, giving the illusion of semi-darkness. About
four kilometres into the park we chanced upon a
bunch of grazing spotted deer, I got a few good shots,
and quickly made a voice note on my cell phone. By
now we were out of cell phone coverage area, and
WiFi is non existent in the region anyways. I felt
different somehow, to be just a couple of hours of
flight away from Mumbai, but yet so disconnected,
so isolated from civilisation, if you’ll pardon the
dramatic way of putting it. My Suunto X9i showed
the temperature at 33 degrees, and we were at an
altitude of 320 metres. I was longing for a photo of
some of the big cats, but the guide told me that
winter (November to February) is the best time to
come across the beasts and when it heats up they
prefer dense foliage-only coming out at night for a
drink of water or a hunt. Twice we came across fami-
lies of monkeys, and the occasional birdcall was the
only disturbance from the otherwise silent jungle.

We had a quick meal on the go (vehicles aren’t
allowed to stop) and another three hours later we
were back this time by another route. My last
evening was spent in front of a campfire, with one
of the drivers, and a couple of security staff. Dinner
consisted of chicken curry, puffy omelettes, and
parathas, after which we talked well into the night.
The following day I joined another group of tourists
for another incursion into the park after which I left
Kanha and boarded one of the many tourist buses
back to Jabalpur. From there I would catch a bus to
Nagpur, and then a flight back to Mumbai.

One week later…
It’s been my second day at work now, and I don’t
know why I wasn’t surprised when our editor came
up and asked me for an account of my travails over
a can of Diet Coke after work. I was surprised when
he informed me that my diary was to become the
subject matter of this article. He wanted to visualise
it as the week spent by a geek away from traditional,
Digit-style technology. 

Well, I’ve given him what he wants. His X9i now
tells me that its time to phone up a friend and fix
dinner plans. But first let me do a little browsing on
my laptop after I get home. For now, I’m going to relax
to some music on my iPod Touch. So was I without
technology? Was I Disconnected? Hah! 

agent001@thinkdigit.com

I’m zooming away thanks to the
lens on my Nikon D40x
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A home entertainment 
system without a good 

DVD player would be 
like a soccer match 
without a football. 

We’ve tested 16  
players, each with 

somthing unique to 
offer in the realm of 

digital entertainment. 
Here’s where you get to 
decide which one is the 

best for you…

playback all your multimedia 
content? Well a good DVD player 
should do the trick. It can’t 
playback all the formats your 
Winamp / VLC + PC combina-
tion can, but it does look a sight 
more at home in your living 
room where aesthetics is every-
thing, and space is a premium 
ill afforded to such eye sores as 
an ugly beige box.

DVD players, as we call them 
for lack of a better term (for 
they are jacks of many formats 
and not just masters of one) are 
in fact one of the hottest selling 
consumer entertainment prod-
ucts, and having a sleek, black 
/ silver box beneath your TV has 
become a de facto standard now, 

up from the status symbol it 
was years ago during the age of 
VCRs. DVD players have become 
the staple of many a movie junk-
ie, and although they can be 
used for music and photo files 
as well, their major use was 
intended as (and is) playback of 
video. The VCD players of yester 
year have given way to DVD 
players—these players play dual 
layer DVD videos, (called DVD 
9), as well as VCDs, as well as the 
more recent DivX and AVI for-
mats. High Definition (HD) reso-
lutions are supported by some 
players which will also generally 
have the designation HD Ready, 
HD Compliant or such. Although 
HD formats like TS, MKV and 
WMV are meant primarily for 
PCs, even DivX and AVI files can 
be encoded at HD resolutions 
like 480p, 720p, 1080i, or 1080p 
which are the most common 
resolutions for HD content.

When buying a DVD player, 
it’s very important to also decide 
on the other components of 
your entertainment setup so as 
to maintain a synergy between 
components. Some DVD players 
come with bundled surround 
speaker systems like the Moser 
Baer MBI AV 780, which had a 
5.1 setup bundled. For others, 
you may have to choose a set 
of speakers (refer to our speak-
er test in this issue). You will 
also have to choose a television, 

while regular 21- and 29-inch 
CRTs work fine for VCDs, they 
are unsuitable for viewing wide-
screen content. Throw in the 
fact that 95 per cent of all video 
sources today are widescreen 
and you have a serious problem 
of thick black bands appearing 
on the top and bottom of your 
CRT TV. Of course, such band-
ing is also common on LCD and 
Plasma TVs, but it’s a lot better 
considering most of these TVs 
have aspect ratios of 16:10.

But that’s another story for 
another time, without further 
ado lets get into the thick of 
our test. Of the 16 DVD players 
we tested this month there were 
two very unique players—the 

LG DP271B and the Moser Baer 
MBI AV 780, both very different 
beasts but their exclusivity was 
enough to warrant them to get 
their own special box.

Non-HDMI Players:
Eleven of our test subjects were 
of the non-HDMI variety and 
we’ll look at them first. Onida’s 
Candy was one of the funki-
est, and definitely the most 
chic looking player across all 
categories. A bright red colour 
theme—candy red, if you will—
extends to the remote control 
unit as well as the top body of 
the player. The unique shape 
like a half cut cake simply adds 
to the overall look that Onida 
has tried hard for—cool, young 

We divided our DivX players into the fol-
lowing categories on the basis of the res-
olution of content playback supported.
1. Native HD resolution players
2. DVD players

Features:
We tested mainly two aspects of features 
for each player:
1. �Connectivity: includes the physical con-

nects present on the player for audio, 
video and miscellaneous connects

2. �Formats supported: includes the codec 
and format support for audio, video 
and image files

Performance:
1. �Video Playback: we played back VCDs, 

DVDs, and HD content (on players 
supporting HD) and checked for video 
quality. We also checked for skipping 
of frames, colour reproduction, as well 
as scanning problems. For HD content 
we used 720p and 1080p clips

2. �Audio Playback: we checked for audio 
quality on MP3 playback. Our Test 
MP3s used were encoded from origi-
nal SACDs at 320 Kbps at high quality 
settings

3. �Image Quality: we used a variety of 
JPEG files, at different resolutions on 
our photo CD

4. �We also checked the video formats 
that each player was capable of, in 
case a format is listed as played, we 
actually tested to validate this claim

We used a 32-inch 1080p supporting 
LCD panel from Vu Technologies. Colour, 
Contrast and Brightness settings on the 
display were kept constant through-
out the test. Progressive Scanning was 
enabled throughout, as was 5.1 audio. 
For the Non-HDMI DVD players we used 
Component as our choice for video, 
while the HDMI port was used on play-
ers supporting it. The Altec Lansing 
MX5021 was used as our reference for 

music, while Logitech’s Z5500D was 
used as while benchmarking videos, 
5.1 surround and Dolby DTS 2 were also 
enabled throughout the video tests.

Audio Test Files:
1. Guns and Roses—November Rain
2. Eagles—Hotel California
3. Eric Clapton—Layla
4. The Corrs—Brid Og Ni Mhaille

Video Test Files (Select Scenes):
1. Transformers (DVD 9 and 720p)
2. �Star Wars Episode 1: The Phantom 

Menace (DivX, 1080p)
3. Sahara (DVD 9)
4. Pitch Black (DVD 9)
5. Underworld (DVD 9)
6. Eragon (VCD)

Images:
Various subjects shot at 7.0 megapix-
els (Canon A710IS) and 10.0 megapixels 
(Nikon D40x)

  How We Tested

RCA 5.1 outputHDMI out

Composite out

Component Video out Digital Audio out

The rear of your DVD player demystified
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Shhh... 

The Show’s Starting
Michael Browne

We at Digit have always 
welcomed the domin-
ion of digital enter-

tainment. It’s a realm where 
hours are spent in blissful lei-
sure, senses tuned in to the 
wonderful sights and sounds 
that only a 50-inch plasma 
screen coupled with a 500W 
RMS surround sound system can 
give you. But wait…besides that 
5000:1 contrast ratio screen and 
that 12-inch subwoofer, aren’t 
you missing something? Unless 
you intend having your PC in 
your designer living room (ugh!) 
you’re stuck for a proper source. 
Simply put—what do you use to 
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and hip. That aside, the Candy 
sports all the hardware under 
its small hood to seriously vie 
for your hard earned cash. What 
we really loved was the option 
for changing country code that 
was available in the menu sys-
tem—boon for playing DVD mov-
ies manufactured for playback 
in a different region. Also avail-
able, and easily accessible on 
the brilliant menu system were 
a lot of settings that are some-
times missing from such player 
setup menus like the ability to 
set and adjust Luma, Gamma, 
Saturation, Dolby compatibility 
settings, and even the filtering 
frequency for sound, individual 
channel volume adjust and chan-
nel delay. The Candy’s remote 
works at very wide angles, and 
functioned flawlessly at a range 
of 12 feet, which is more than we 

can say for some other players. 
Another nifty feature is notice-
able while skipping chapters in 
a DVD—the Candy displays the 
total amount of time elapsed 
and the total duration of the 
video so you have an additional 
indicator—a very small boon, 
but a plus nonetheless.

With very clear DVD play-
back, no blurriness and dis-
tortion noticeable (other than 
what is normal for viewing DVD 
content on a large widescreen 
LCD) the Candy scores big time 
as a DVD player. VCD quality is 
about as good as a 352x240 pixel 
video can look on a 1366x768 
resolution screen. The Candy 
passed our music tests without 
any hiccups, and without dis-
cernable issues. Onida gets their 
picture quality spot-on with the 
Candy, and our high-resolution 

images looked good with accept-
able pixelation. After such a 
good showing on the perfor-
mance figures we’d have loved 
to see some more connectivity 
options like a VGA / DVI connect 
or even USB—a big plus for those 
who want to play movies off 
their portable hard drives and 
thumb drives. With a six-month 
warranty, we figured Onida has 
been a bit stingy—especially 
at a price tag of Rs 3,400—not 
expensive for the performance 
on demand—but we wish it had 
a one-year warranty. Also, this 
player will not look at home in 
a suavely designed living room—
it’s got too much attitude, and 
it shows.

Intex’s N-20VK was one of 
the plain-jane players—just a 
cool blue LED that illuminates 
the drive tray which is made of 
a translucent fibre based com-
pound. We’re thoroughly tired 
of the blue lights on PC cabi-
nets, notebooks, external hard 
drives and now DVD players, 
and we’re hoping some vendors 
are reading this! The Intex N-
20VK sports a good finish and 
acceptable build quality—no 
complaints here. The ¼-inch 
jack means you can sing along 
with your favourite MP3s—a 
neat plus, considering this 
player is no slouch with MP3s. 
The N-20VK didn’t do badly at 
DVDs and we figured that while 
we’d seen better, we certainly 
hadn’t seen worse. However, 
we noticed the this player just 
lagging behind in some of the 
tests, and this added up when 
we looked at the price tag—just 
Rs 2,800—a lot of player for the 
price, to be sure, but definitely 
not the best performance out 
there. That said, the N-20VK has 
one terrific plus—a VGA port, 
meaning you can connect this 
to your PC monitor as well.

Moser Baer had a trio of 
players in this test and by far 
the most striking player was the 
Black Panther—first of all it’s 
half the width of a regular DVD 
player, which may or may not 
be attractive—it does make the 
player look a little bulky from 
the front. To further enhance 
this effect, Moser Baer has pro-
vided this player with high foot 
pegs—a real eyesore considering 
the sleek and wide look is in—is 
different bad? You decide. The 
Black Panther played back DVDs 

of any region somewhat like the 
Onida Candy, but the settings 
were visible, not changeable. 
The pathetic remote control 
unit seemed to have a problem 
at a distance of more than five 
feet, and within this distance, 
even slight angles will obstruct 
functionality. Other than that, 
we had no complaints whatso-
ever—the Black Panther really 
struts its stuff when it comes to 
any kind of video playback—all 
our VCD, DVD and DivX tests 
went off smoothly and without 
a hitch, and with good visual 
quality, minimal pixelation and 
good contrast. A good player, 
compact and feature rich, along 
with great performance—at 
a price of Rs 2,990, the Black 
Panther seems to have clawed 
all the good points into its 
kitty, it’s the second best per-
former too. Just make sure to 
look before you leap...er...buy, 
because the squat, burly look 
may not appeal.

The other two Moser Baer 
players—the MBI 838 and the 
MB-6988S were very different 
lookers, the MB-6988S looks 
slim at first glance, but the 
bottom part of the body pro-
trudes and so do the foot pegs, 
spoiling this effect. Luckily it 
won’t look so bad when placed 
on a flat surface, especially one 
that’s below eye level. The MBI 
838 is slimmer, but both have 
equally tacky buttons that are 
hard to press, a shame, this, 
and annoying too. Once again, 
we had a few remote interface 
issues with these two, but the 
Black Panther has to take the 
cake in this regard. The front 
LCD display on the MB-6988S 
is bright and very readable 
but looks a little garish after 
some time, moreover it doesn’t 
exude that quality look that 
the displays on the Samsung 
and Philips models have. Both 
these models have USB ports—a 
real boon when you have all 
your DivX titles dumped on a  
2.5 inch external drive. Even USB 
drives can be used, although if 
the drive is too slow, the movie 
will lag. In fact, any video files 
VOB (DVD), DAT (VCD), AVI and 
even MPEG4 can be kept on 
a thumb drive / external hard 
drive and watched at your con-
venience—very nifty and ultra 
utilitarian. The MB-6988S also 
supports memory cards like SD 

/ MMC / MS so you can simply 
pop out your digital camera’s 
memory card, slot it into this 
player and enjoy your creations 
immediately. Of the two, the 
cheaper (Rs 2,990) MB-6988S 
impressed us marginally more 
in a few of the video tests, in 
other areas we’ll call it a draw. 
Overall, at the same price as 
the smaller and better perform-
ing Black Panther, the MB-6988S 
doesn’t make much sense to 
purchase, unless the lure of a 
memory card reader and USB 
port attract you.

Besides the excellent Candy, 
Onida had three other models, 
the DFX-5957, DFX-5988 and the 
DFX-5985 priced at Rs 3,100, 
3,300 and 3,000 respectively. So 
the Candy is the most expensive 
model amongst the foursome 
and as our performance tests 
showed, by far the most suited 
for a quality home entertain-

ment system. All three players 
sported a sleek look; no ugly 
protrusions (read foot pegs), 
and while the DFX-5988 was the 
best looking, with a steel sil-
ver / dark grey body, all three 
boasted of similar features. We 
were surprised to see the con-
nectivity options—nothing extra 
it seems Onida meant for these 
to be plain vanilla DVD play-
ers. After the excellent candy 
we’d partaken in earlier, this we 
just couldn’t swallow, no matter 

 LG DP271D—No Idiot Box, This

After last month’s PMP test we thought 
we’d seen it all as far as portable mul-

timedia went. How wrong we were! Enter 
this little box. The DP271D is a compact DVD 
player, small and very cute-looking with 
the same piano-white finish on its lid that 
some of LG’s XNote laptops have. In fact the 
entire device looks like a miniature laptop. 
It’s got an eight-inch LCD screen that swiv-
els much like a tablet PC. Stereo speakers 
provided on the lid are quite powerful but 
the housing does take up precious screen 
space (we figure LG lost an inch in screen 
size with a wide bezel and large speaker 
vents). There are two powerful headphone 
jacks—cosy! The build quality and fit is very 
good, no squeaks or loose joints, although 
the buttons feel a little hard, especially 
the four way navigation button. The menu 
is very linear, well laid out and intuitive, 
and rather feature rich. There’s a USB port 
provided—useful for playing movies off a 
removable drive, while an AV out ensures 
you can plug this in to a larger screen. 
The DP271D has a flip type DVD flap that 
is worked by a robust spring which we feel 
will bear the rigours of daily use well. Juice 
is provided courtesy a 2500 mAh clip on 
battery pack (much like a laptop), and our 
tests reveal battery life is good for two DVD 
movies of 105 minutes each—impressive. 

Although the LCD doesn’t look a very 
quality unit (cost cutting we fear) it seems 
to do a fair if not great job. Our VCD, DVD 
and DivX tests found the DP271D a little 
shy on the full gamut of colours, we con-
clude the panel is a six-bit TN (Twisted 
Nematic) type. Other than that, contrast 
seems OK, although a little smattering of 

colour was noticeable on darker movies 
like Underworld. DVDs like Transformers 
looked very good, and it was easy to tilt the 
screen to orient the player any way to suit 
our convenience. The screen orientation 
can also be changed.

Music quality was pretty good, and the 
volume level surprisingly good—no PMP 
can come close to this on speaker volume, 
the earphone jacks are also adequately  
powered for most low-impedance head-
phones / earplugs. For an MRP of Rs 8,490 
the DP271D is a good bargain, add to that 
the fact that you could probably shave off 
a thousand bucks or so (actual street prices 
will be lower), and this is a good buy. But 
it’s not a device for everyone. If you have 
a PMP and are happy with it, forget this. 
The hassle of carrying optical media with 
you will mean this isn’t suitable for short 
journeys like bus and local rides. However, 
if you’re going for a weeklong tour, and 
want to chill in your hotel room and watch 
a movie before getting some shut-eye, this 
may be just up your alley.

 Moser Baer MBI AV 780—Just Pop In A DVD

We have reviewed complete entertain-
ment systems before. Such systems 

are tailored for people who can’t be has-
sled with component synergy but just want 
something that is built to perform perfectly 
together. The MBI AV 780 is an inexpensive 
attempt at the same—a DVD player plus 
5.1 surround speakers bundled into one. 
The DVD player is the largest amongst all 
our test candidates, courtesy the inbuilt 
amplifier. Nevertheless, it’s a solid unit that 
exudes build quality, and has an attractive 
front, that looks very busy with quite a few 
buttons and a knob, and a lot of small print 
advertising its features. The speakers fol-
low the same grey / black colour tone of 
the player, and the black mesh grilles on 
the satellites looks downright classy. The 
subwoofer felt a little too light to be really 
effective, it also looks like it has a rather 
small driver (four inches). The rear speaker 
cables are long enough for a small hall, 
but if your player is around 20 feet away 
from each speaker you’re going to have 

problems. With auxil-
iary RCA 5.1 outs and 
the 6 channel clip type 
connects for its own 
speakers, audio con-
nectivity is taken care 

of. Optical and coaxial outputs are also pro-
vided. S-Video, Component and Composite 
outs should handle all your video needs 
(no HDMI here). There’s also a jack for an 
FM radio antenna, and with MW support 
added, this player is a full-fledged radio. 
Once again the remote unit although well 
built and with soft buttons just refused to 
work unless operated slap bang in front of 
the player—ridiculous and a very irritating 
problem, especially for couch lovers.

On the performance front, there wasn’t 
anything to complain about in the way of 
video quality and the MBI AV 780 proves 
that price and performance can coexist 
peacefully. The audio was somewhat of an 
issue with the underpowered subwoofer, 
although the satellites are powerful and 
movies feel really good, they aren’t for 
music where their tendency to be piercingly 
bright is immediately apparent. If its mov-
ies you want, the audio will satisfy you, we 
only wish for more power in the lower fre-
quencies. Issues aside, what we have here 
is quite simply excellent value for money  
(Rs 7,490)—a fully ready home theatre. All 
you need is a large screen to go with it. If 
you are looking for a good DVD player and 
5.1 surround speakers, why not kill two 
birds with one stone?

Intex N20VK

A P R I L  2 0 0 8
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how hard we tried. Photo images 
weren’t very good, and looked 
the most aliased and pixelated 
from amongst all the players. 
In terms of performance, all 
three DVD players are similar, 
making the model designations 
hardly significant (considering 
the very similar features), and 
quite simply put, your money is 
better spent elsewhere.

Further down the line, two 
Philips players attracted us with 
their looks. The build quality 
that this brand imparts has to 
be seen to be believed. Smooth, 
brushed metal, attractive steel 
grey powder coating, sleek as a 
wind tunnel-designed thorough-
bred, both the DVP3136 and the 
DVP5150X will draw at least a 
cursory glance, and that’s while 
switched off, although the latter 
is a better looking player. With 
sleek remote units, that look 
as good as they function (Ah, 
the joys of soft, yet firm but-
tons). Philips has got aesthetics 
covered to be sure. What we did 
miss was any sort of PC display 
connectivity (there’s no VGA). A 
new incorporation from Philips 
has been support for DivX Ultra, 
basically a standard for com-
patibility of various DivX stan-
dards as far as subtitles, sound 
channels and even the encoded 
video go. Besides Philips none of 
the brands in this test had sup-
port for this new and emerging 
standard. Both the players have 

no support for USB or memory 
cards, but performed quite well, 
and a few niggles aside, both 
make for good components in 
a home entertainment setup. 
Although the DVP-5150X costs a 
thousand rupees extra, besides 
the outer body finish, this isn’t 
really noticeable in any way once 
both get working. The DVP-3136 
also supports Hindi as a setup 
language—a boon to be sure for 
people who are more comfort-
able with it. The stereo chan-
nels have spring clips, and not 
RCA ports. Both these players 
performed very closely to the 
leaders of the pack—the Candy 
and Black Panther—although 
the difference in quality won’t 
be noticeable unless you have 
both players running and are 
discerning enough. At Rs 3,999 
and 4,999 for the DVP-3136 and 
DVP-5150X respectively, econo-
my you will not get; which is the 
only blemish on an otherwise 
nearly spotless report card.

 

Samsung’s DVD-P172 was the 
only player from the Korean 
giant in this category. The qual-
ity of plastics used is top notch. 
The entire dark grey / black and 
silver tone goes well, this play-
er suits nearly any décor. We 
liked the soft-buttoned remote 
control which Samsung claims 
will work with any of their flat-
screen displays as well. Even 
the DVD tray exudes quality, 
a nice slow action, not a jerky 
motion like most other players. 
The LED panel has a soft light 
that is quite easy on the eyes, 
while retaining legibility. Like 
the Philips players Samsung 
also does without memory card 
and USB connects. In terms of 
performance, Samsung’s DVD 
playback quality was as good 
as we’ve seen in this catego-
ry, while VCD quality wasn’t a 
touch behind what we’d call 
really good. With a good show-
ing on the performance front, a 
good price—Rs 3,400—and unde-
niably good looks, the DVD-P172 
makes for a good buy especial-
ly if both the best performers’ 
looks fail to inspire you.

Our Choice
Our Best Buy award goes to the 
Intex N-20VK. Excellent value for 
money at Rs 2,800, it’s well built, 
reasonably feature-rich and a 
decent performer. If you’re on 
a shoestring, here’s your player. 
Our best performer in this cat-

egory is the Onida Candy. A ster-
ling little performer at Rs 3,400 
with funky looks that will defi-
nitely attract attention (even if 
it’s the wrong kind). Some may 
think it garish, some may think 
the design’s weird, but it puts 
its critics to rest when you fire 
up any sort of compatible movie. 
Moser Baer’s Black Panther also 
deserves mention here. It’s a 
little more sober than the eye 
catching Candy, and marginally 
trails on the performance front. 
For Rs 2,990 the Black Panther 
most definitely deserves to 
prowl our markets and makes 
a very good buy if you should 
decide on something better per-
forming than the N-20VK but 
cheaper than the Candy.

HDMI Players
This category consisted of just 
three players spanning three 
brands. HDMI and HD are big 
buzzwords in the market—every-
body looking for a home enter-
tainment system wants to ride 
the wave. Very little is known, 
however, about HD content, and 
just like any technology in its 
nascent stages of early growth 
HD isn’t without its fair share of 

niggles. On the PC, players like 
VLC make short work of play-
ing any HD video regardless of 
resolution or file format, DVD 
players (even 1080p-supporting 
DVD players) had issues. Sadly, 
HD content on these players 
will only play if the file (mostly 
AVI format) is actually encod-
ed in a supported HD resolu-
tion like 720p (1280x720 pixels, 
progressive scanned) or 1080i 
(1920x1080 pixels, interlaced). If 
the file is encoded at any other 
resolution, however minute the 
difference, the DVD player will 
cough up an error. Since HD 
videos are best enjoyed on a dig-
ital output signal, HDMI is the 
preferred connect when view-
ing any high definition content. 
Note that the HDMI connect will 
also carry audio signals, and 
you have to use your television’s 
audio out to route these to the 
necessary speakers.

Mitashi’s DHD-911 is a rather 
plain looker made a little bet-
ter by the proud brand name 
embossed on to the top metal 
cover. The remote control was 
anything but plain—grey body 
with bright blue buttons—a little 
gaudy but we liked it. Buttons 

are reasonably soft, imparting 
good positive feedback during 
use, and the unit works flaw-
lessly at a distance of 12 feet. 
Connectivity wasn’t on short sup-
ply either with the usual HDMI, 
S-Video, Composite, Component 
and audio RCA being accompa-
nied by both USB and Memory 
card support. This would have 
to be Mitashi’s highlight—the 
sheer connectivity options, and 
the other advantage we see is 
the transparency of settings in 
the setup menu, very similar to 
the Moser Baer Black Panther. 
So what’s the downside here—
performance? No! The DHD-911 
is an excellent performer, and 
is highly recommended for any 
sort of DVD- or HD-viewing—
especially at the bargain price of  
Rs 3,990—it’s a lot of player for 
the money spent.

Philips’ DVP5986K was the 
second HDMI ready player we 
tested and it had quite a few 
tongues hanging out with its 
design. The remote was suitably 
curvaceous and functional for 
all its looks. For once Philips, 
dropped in a USB slot—very 
appreciated. Another nifty fea-
ture is the addition of an audio 
in for karaoke. DivX Ultra sup-
port is another little bonus, 
though it’s not of much use 
right now. We’d have liked sepa-
rate RCA audio outs (useful for 
floor-standing speakers) and an 
optical out—neither was avail-
able. Comparing the DVP5986K 
to the DHD-911 proved inter-
esting—the former is definite-

Decision Maker
If you’re looking for:

A cheap DVD player that performs adequately then look no 
further than our Best Buy award winner, the Intex N-20VK. At 
Rs 2,800 and with a good feature set and performance to boot 
we’d guarantee satisfaction here.

Something that’s connected, and HDMI and digital audio are 
your primary needs, but at the same time the player should per-
form well and equally importantly look good, then Samsung’s 
DVD-1080P7 will easily do the trick. With sleek supermodel 
looks and the performance of a thoroughbred you can’t go wrong with this player. Add to 
that a sweet price of Rs 5,990 and this is your best bet. Did we mention it’s our performance 
winner in the HDMI player category?

No hassles, a DVD player with complete surround setup. 
The Moser Baer MBI AV 780 will surely satisfy. It’s got oodles of 
performance, is reasonably feature rich, and comes complete 
with subwoofer and punchy satellites all for a modest price of Rs 7,490

Something portable that plays DVDs, and not a PMP. We just may have what the doctor 
ordered! LGs DP271D is a very compact fully functional DVD player with a very cute remote, 
and an eight inch LCD screen. Its powerful loudspeaker is much 
better than any PMP and with two headphone jacks it’s a cin-
ematic experience for two. The good battery life is a plus, and 
with a number of settings available and very acceptable per-
formance the DP271D bears our highly recommended moniker. 
The price—Rs 8,490 makes this device an absolute steal. Just 
remember to carry your DVDs safely!
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Brand Intex Moser Baer Moser Baer MoserBaer Onida Onida Onida Philips Philips

Model N-20VK MBI 838 Black Panther MB-6988S Candy DFX-5957 DFX-5988 DVP3136/94 DVP5150X

Price Rs 2,800 Rs 3,290 Rs 2,990 Rs 2,990 Rs 3,400 Rs 3,100 Rs 3,300 Rs 3,999 Rs 4,999

Pros Very affordable, sleek Well built, decent performer Excellent settings, performance Well built, good performer Novelty looks, great performer Sleek, low profile Looks good, built well Looks sleek, good remote Good looking, soft buttons

Cons Tacky buttons Tacky buttons, plain looks Looks a little bulky Plain Looks, Tacky Buttons Styling may not suit everyone Mediocre performance Average performer Lacks S-Video connect Expensive, No S-Video connect

Grand Totals (Out of 100) 64.44 65.79 62.44 67.54 61.38 56.65 56.86 60.14 60.95

Features (Out of 50) 33.00 32.00 26.80 33.00 26.80 26.00 26.00 26.90 27.10

Performance (Out of 45) 29.44 30.29 32.14 31.04 32.58 28.65 28.86 31.24 31.85

Warranty (Out of 5) 2.00 3.50 3.50 3.50 2.00 2.00 2.00 2.00 2.00

Features

Connectivity

Audio Connects (Y/N)

Separate RCA (Stereo) Y Y N N N N N Y Y

5.1 channel Y Y Y Y Y Y Y Y Y

Coaxial (SP/DIF) Y Y Y Y Y Y Y Y Y

Optical Y Y N Y Y Y Y N N

Video Connects (Y/N)

S-Video Out Y Y Y Y Y Y Y N N

Composite Out Y Y Y Y Y Y Y Y Y

Component Out Y Y Y Y Y Y Y Y Y

VGA Out Y N N N N N N N N

DVI Out N N N N N N N N N

HDMI Out N N N N N N N N N

Miscellaneous Connects (Y/N)

USB N Y N Y N N N N N

SD/MMC/MS reader N Y N N N N N

Microphone in (Karaoke) Y (1/4 inch) N N Y (1/4 inch) N N N N N

Tray Loading Type (Cassette/Slot) Cassette Cassette Cassette Cassette Cassette Cassette Cassette Cassette Cassette

DivX Ultra Support (Y/N) N N N N N N N Y Y

Progressive Scanning (Y/N) Y Y Y Y Y Y Y Y Y

Max HD resolution natively supported NA NA NA NA NA NA NA NA NA

Formats Supported

Audio WMA, MP3, MP3, Audio CD WMA, MP3, Audio CD MP3, Audio CD WMA, MP3, Audio CD WMA, MP3, Audio CD WMA, MP3, Audio CD WMA, MP3, Audio CD WMA, MP3, Audio CD

Video AVI, VCD, DVD AVI, VCD, DVD, DivX AVI, MPEG4, VCD, DVD, DivX AVI, VCD, DVD, DivX AVI, MPEG4, VCD, DVD, DivX AVI, MPEG4,  
VCD, DVD

AVI, MPEG4, VCD, DVD AVI, MPEG4, VCD, DVD, DivX AVI, MPEG4, VCD, DVD, DivX

Still Image JPEG JPEG JPG, JPEG JPEG JPG, JPEG JPEG JPEG JPEG JPEG

Bundled Cables Composite + audio Cables Composite + audio Cables Composite + audio cables Composite + audio Cables Composite + audio cables Composite +  
audio cables

Composite + audio cables Composite + audio Cables Composite + audio Cables

Performance (Scale of 10)

Video Performance

VCD quality (Avg Score) 6 6.5 6.75 6.5 7 6.5 6.5 6.5 6.75

DVD quality (Avg Score) 6.75 7 7.5 7.25 7.5 6.75 6.75 7.25 7.5

DivX Quality 6.25 6.25 6.5 6.25 6.75 6 6.25 6.5 6.5

HD 720p quality NA NA NA NA NA NA NA NA NA

Audio Quality

MP3 (320 kbps) 6.5 7 7.25 7 7.25 6.75 6.75 7.25 7.25

Test Clip 1 (5.1 channel AC3) 6.5 6.75 7.5 7.5 7.5 6.5 6.5 7.25 7.25

Test Clip 2 (5.1 channel AC3) 6.75 7.25 7.5 7.25 7.5 6.25 6.25 7.25 7.5

Photo Quality (JPEG) 6 6 6.75 6 7 5 5 6.25 6.25

Warranty 6 months 1 year 1 year 1 year 6 months 6 months 6 months 6 months 6 months

                                                     Non-HDMI DVD Players
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Brand Samsung Mitashi Philips Samsung

Model DVD-P172 DHD-911 DVP5986K DVD-1080P7

Price (Rs Rs 3,400 Rs 3,990 Rs 5,999 Rs 5,990

Plus (+) Very good build and Looks Good connectivity Sleek, quality looks Great looks and performance

Minus (-) Slight issues with VCD quality Looks boxy, clicky buttons No S-Video connects No 5.1 channel RCA

Grand Totals (Out of 100) 60.95 70.44 66.25 65.40

Features (Out of 50) 25.50 35.85 30.25 27.40

Performance (Out of 45) 31.95 32.09 33.50 34.00

Warranty (Out of 5) 3.50 2.50 2.50 4.00

Features

Connectivity

Audio Connects (Y/N)

Separate RCA (Stereo) Y Y N Y

5.1 channel Y Y Y N

Coaxial (SP/DIF) Y Y Y Y

Optical N N N Y

Video Connects (Y/N)

S-Video Out N Y N Y

Composite Out Y Y Y Y

Component Out Y Y Y Y

VGA Out N N N N

DVI Out N N N N

HDMI Out N Y Y Y

Miscellaneous Connects (Y/N)

USB N Y Y N

SD/MMC/MS reader N Y N N

Microphone in (Karaoke) N N Y N

Tray Loading Type (Cassette/Slot) Cassette Cassette Cassette Cassette

DivX Ultra Support (Y/N) N N Y N

Progressive Scanning (Y/N) Y Y Y Y

Max HD resolution natively supported NA 1080p 1080p 1080p

Formats Supported

Audio WMA, MP3, Audio CD MP3, WMA, Audio CD MP3 WMA, MP3, Audio CD

Video AVI, MPEG4, VCD, DVD AVI, MPEG4, VCD, DVD, DivX AVI, MPEG4, VCD, DVD, DivX AVI, MPEG4, VCD, DVD

Still Image JPG, JPEG JPG, JPEG JPEG JPG, JPEG

Bundled Cables Composite + audio Cables Composite + audio Cables Composite + audio Cables Composite + audio cables, HDMI 
cable

Performance (Scale of 10)

Video Performance

VCD quality (Avg Score) 6.5 6.5 7 7.25

DVD quality (Avg Score) 7.5 7.5 7.75 7.75

Divx Quality 6.75 7 7.25 7.25

HD 720p quality NA 7 7.75 8

Audio Quality

MP3 (320 kbps) 7.25 7.25 7.25 7.5

Test Clip 1 (5.1 channel AC3) 7.5 7.25 7.25 NA

Test Clip 2 (5.1 channel AC3) 7.25 7.5 7.5 NA

Photo Quality (JPEG) 6.5 6 7 7

Warranty 1 year 6 months 6 months 1 year

 Non-HDMI DVD Players HDMI DVD Players
A P R I L  2 0 0 8

ly superior in nearly all the 
tests, and the margin of victory 
ranges from hairline to runaway 
victory. Rs 5,999 isn’t cheap, 
but neither is the product you 
acquire for the price. It’s the 
perfect companion for all your 
movie entertainment escapades, 
but read on to finally decide.

On to the final contender 
and an even better looking 
player (if that is possible). 
Samsung’s DVD-1080P7 is an 
example of metal machined to 
perfection. Although opinions 
were divided about the over-
all winner for the best look-
ing player, the DVP5986K and 
DVD-1080P7 are both very good 
looking, and deserve a living 
room makeover. With a similar 
remote to its cheaper sibling 
DVD-P172 (which isn’t a bad 
thing) the DVD-1080P7 makes 
no bones about its purpose. A 
1080p ready player with HDMI, 
Samsung forgot to include sur-
round sound RCA connects, so 
you’ll have to make do with 
stereo or use 5.1 channel via 
HDMI—not very convenient, 
but we’ll reserve judgement 
for now. This was the only 
player without USB support; 

memory card reading facilities 
were also absent—we’re still 
being lenient but our patience 
is being tested now. The remote 
control was a pleasure to use, 
but after Mitashi’s transparent 
menu system, the menus on 
the Philips and Samsung play-
ers do leave a lot to be desired. 
Oh, they’re well laid out, intui-
tive even, but they haven’t got 
the options...

Performance was by far this 
player’s forte—with brilliant 
image, video and sound qual-
ity the DVD-1080P7 makes an 
ideal companion for a high-end 
home theatre setup. For DVDs 
and HD content, we haven’t 
seen anything better—and the 
HDMI output does really propel 
the display quality beyond the 
realms of what Component con-
nects are capable of. At Rs 5,990 
this player makes a sensible buy, 
and we don’t feel cost should be 
a restraint in this case—given 
the quality you get. Although 
the difference in performance 
between this player and the pre-
vious Philips model (DVP5986K) 
is less than 10 per cent, the 
price is nearly the same making 
your decision a no-brainer.

Our Choice:
Our Best Buy award goes to the 
Mitashi DHD-911—unbeatable 
at Rs 3,990. It’s got connectivi-
ty, features, lots of available 
settings and great performance 
to boot. The slightly costly 
Samsung DVD-1080P7 is all 
about exclamations when it 
comes to describing its perfor-
mance. It’s quite simply the 
best performer on show here, 
trailed closely by the Philips 
DVP5986K. We’re awarding Best 
Performer to the, well, best per-
former—the DVD-1080P7 gets 
its just reward. 

michael.browne@thinkdigit.comSamsung DVD-1080P7

Brand Company Phone No Website
Intex Intex Technologies (India) Ltd +919313441213 www.intextechnologies.com 
LG LG Electronics India Pvt Ltd 0120-2560900 www.lgindia.com
Mitashi Mitashi Edutainment Pvt Ltd 022-25006661 www.mitashi.com
Moser Baer Moser Baer India Ltd. 1-800-111-113 /  

011-40594512 / 13
http://moserbaer.com/consumer_
overview.asp

Onida MIRC Electronics Ltd.( Onida) 022-28200435 / 66975777 http://www.truthatonida.com/
beta/home/home.asp

Philips Philips Electronics India Ltd 1800 180 1111 / 011 66001111 www.philips.com 
Samsung Samsung India Electronics 

Pvt. Ltd.
011-41511234 www.samsung.com/in

 Contact Sheet	          DVD Players
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Bullet dinging armour plating and fearsome face
masks…two gung ho stereotypes with big guns and
attitudes the size of Texas. Their mission—to kill

everything else that moves, their motives—money, money,
and sometimes a favour for an old friend. Army of Two is a
whole ammo belt full of violent, tactical fun. You play as
either of the two protagonists Salem and Rios, two highly
trained mercenaries for hire, who fight terror, for cash,
some of which will be used to buy bigger guns.

Although the story has its own share of twists, its
nothing in the way of path breaking, so you better forget
about the subject matter of the game and focus on the way
it plays instead. Game mechanics are good, if a little
unbalanced. While your weapon recoil and the slightly
screwy aiming system will ensure that you’re highly
inaccurate (at best)—especially while moving around—your
enemies can hit you accurately from a hundred metres away.
They’ll duck frequently too, and use flush out tactics like
flanking and even lob the odd grenade at you. For your
tactics, Army of Two employs a system called aggro found in
a few MMORPG games, where enemies focus on the person
doing the most damage and ignore the other person totally.
Suppose you put your partner in aggro mode, he will draw
all the fire, leaving you to flank the enemy virtually unseen
and pop ‘em off rather easily. You can also draw aggro,
leaving your partner to move around undetected and the
system works rather well here. There’s also an overkill mode
that’s activated if one of you draw sufficient amounts of
aggro—everything moves in slow motion, the aggressive one
gets double damage, and the other one becomes invisible
for the entire duration of the overkill mode—which is
fourteen seconds.

One of the highlights for me was the weapon purchase
system—I love guns—and from the Desert Eagle to the
Dragunov SVD to the M134 Gatling gun, you can buy them
all…the only shortage being cash. Weapons sound ultra-real
too, and you get to mod your weapons, adding silencers,
bigger barrels, larger magazines, etc. Such mods alter
statistics like accuracy, damage, ammunition, and aggro.
There’s also a gold plated “pimped” upgrade to each weapon
that increases your aggro and little else—the man with the
golden gun, anyone?

I’ll admit that the storyline screws up on the execution
of some good subject matter, but the intense action, good
use of tactics, brilliant weapons and great co-op mode make
this game a good way to spend half a day. 

michael.browne@thinkdigit.com

Army Of Two
It’s all about hunting in pairs...

Rating: 7.5/10
Developer: EA Montreal 

Publisher: EA Games

XFX GeForce 8800 Ultra,
Intel Core 2 Duo E6600,

4 GB DDR2 RAM

GAMING PC
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Two men, enemy by circumstances, bound together
by fate, Kane and Lynch the two anti-heroes are
indeed Dead Men. One is fighting against time to

save his family from the wrath of the league of seven
(basically a group of mob bosses), while the other is there
to ensure that the former sticks to the plan while fighting
frequent psychopathic urges. With the body count on the
rise, one must find a way to free his family, while the
other will accompany himm—ensuring his cooperation
throughout, while battling his inner demons. Kane must
protect Lynch, without whose daily calls to an unknown
number his family will be killed. Lynch must protect Kane

because he’s the only one who can recover the missing
contraband that the mob bosses so desire. They’ll battle
through cops, the Japanese mafia, the army, and ulti-
mately time for the big show down.

A good story with some hair-raising turns and twists,
and an excellent, deep plot, Kane & Lynch is let down by
very mediocre graphics, and sometimes uninspiring
gameplay. It’s not that the action is bad, but mediocrity
isn’t something I expected from such a good storyline.
The story, the locales (at times) and the action make it
something that shouldn’t be missed. 

michael.browne@thinkdigit.com
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Rating:
8/10

Developer:
Eidos Interactive

Developer:
Io Interactive
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Digital Leisure l Game On

Soulstorm continues the franchise in the
Warhammer 40000 universe, and is
the third expansion pack after fol-

lowing Winter Assault and Dark Crusade.
The turn-based strategic map from Dark
Crusade makes another appearance, this
time round, there are four planets and a
couple of moons to take over. Once again,
this fast paced franchise has an important
value add for veterans—the addition of two
playable races and the inclusion of new air
combat units. A warp storm erupts next to
the Imperial Guard occupied planet of
Kuarav, and kicks off an insurgency from the
rogue Orks in the area. Also disturbed from
their blissful slumber are the undead
Necrons, who rise from their ancient tombs
with a vengeance. This storm also forces a
landing from a legion of Chaos Marines, who
quickly join the fray, sensing more slaughter
and glory for their dark lord. The presence
of Chaos summons their mortal enemies the
mighty Space Marines. The awakened
Necrons in turn attract the Tau forces. Using

their respective webways the Eldar and
Dark Eldar forces (non allied factions) slip
in. The presence of the evil elf like Dark
Eldar spurs a visit from the Sisters of Battle,
who sense the taint of perversion.

Phew!-That’s quite a mix… 
The Dark Eldar and the Sisters of Battle

join Warhammer’s (now) substantial list of
races—the Imperial Guard, Space Marines,
Orks, Chaos, Eldar, Tau and Necrons. The Dark
Eldar are a twisted, demonic version of the
evil battling Eldar, and bring dark magic to
the battlefield much like the forces of Chaos.
They’re a balanced, highly mobile race, with
a very good set of vehicles including a number
of flying vehicles. They also have a third
resource called Soul Essence, which is the
most difficult to gather—you’ll need to har-
vest tortured souls for this purpose. When you
have sufficient Soul Essence you can fire off
special abilities like Piercing Vision, Corrosion
or Soulstorm (no spoilers, sorry). The other
new race—the Sisters of Battle blend elite
combat capabilities with strong religious ele-

ments—zealous warriors. Although their units
and heroes are alike, one can’t help com-
paring them to their male counterparts the
Space Marines—there are many functional
(not visual) similarities especially with their
basic infantry and siege units.

With nine civilisations in the mix, and a
number of planets consisting of areas that
grant special benefits Soulstorm is suitably
epic. The addition of air units to each civilisa-
tion makes for an interesting element of
strategy. The entire element of war gear
upgrades for your commander from Dark Cru-
sade also makes its way into Soulstorm, and
adds a near-RPG-ish depth.

Soulstorm is definitely is game you can
spend a whole lot of time with, courtesy its
immense replayability. Graphically it’s the
same as its predecessors, which isn’t a bad
thing at all, but a little sprucing up may be
in order if there is yet another expansion
pack. A good rounded game this, and unless
you hate the genre, don’t miss it. 

michael.browne@thinkdigit.com

Warhammer 40000: Soulstorm 

Rating: 8/10, Developer: Relic, Publisher: THQ

A dreadnought hooks and cooks a Slugga Boy Assault terminators can be deadly Lock...Load...terminate!

The planet system you’ll fight to conquer The Sister Of Battle whips Imperial butt A flame turret in action
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What is so special of
September 7, 1998?

(a) Google is founded
(b) YouTube is founded
(c) Ebay is founded
(d) Amazon is founded

What is Nichi-Doku Shashinki
Sh?ten?

(a) An outlet serving delicious
Japanese food

(b) A forthcoming Hollywood sci-fi
feature film

(c) The original name for Minolta Co.
Ltd

(d) National Electronics was earlier
known by this name

Which of these started as a
computer repair shop

developing boards for Apple?
(a) Pixar
(b) Creative
(c) Transcend
(d) Yes

What is a Gerber file?

(a) A file format indicating paint
colour

(b) It is a file format used by
printed circuit board fabrication
houses

(c) Latest Google application
(d) An outdated file format

What does WiMax stand for?

(a) Wireless Maximum Access
(b) Wireless Medium Access

eXchange
(c) Worldwide Interoperability for

Microwave Access
(d) Wireless for Maximum Fidelity

What is Allegro library?

(a) An online community dealing
with resources on allergy.

(b) A library application for
colleges and universities

(c) A host of files
(d) Open source platform for video

game development

What is Onion routing?

(a) A method for anonymous
communication over a computer
network

(b) A Cisco trademark
(c) Low grade routing
(d) Faster routing method

What is special about
GLONASS—Russian

alternative to GPS?
(a) It is cheaper
(b) It is more accurate
(c) India is a partner in it
(d) Is widely used

What is the Mallock
machine?

(a) An electrical analogue
computer

(b) A system that computes a
device malfunction

(c) A fictional computer
(d) A work of art

10

9

8

7

6

5

4

3

2

ACROSS
7. A way of establishing an outbound connection
through a firewall so that it is not blocked or
monitored (6)
8. Text file containing information about a
software program (4,2)
9. ATtention Dial Tone(abbr) (4)
10. Japanese company specializing in cameras,
photocopiers and computer printers (5)
11. Makers of the Macintosh line of computers
and the Macintosh operating system (5)
13. Web pages that serve as gateways to the Internet (7)
16. A COBOL statement used for executing ‘paragraphs’ (7)
17. An object-oriented programming language for Microsoft
Windows written by Charles Duff (5)
20. Sound Navigation and Ranging(abbr) (5)
21. Unique number assigned to a book title
by its publisher for tracking and ordering purposes (4)
22. A set of symbols that represent assigned, possibly secret
meanings (4)
23. ------ or bulletin board (6)

DOWN
1. More than one server (8)
2. One of something, usually a byte designation (4)
3. Clip art on the computer (5)
4. Computer worm that affects computers running Microsoft
Windows (7)
5. Electro------- device- relating to the interrelation of electric
currents or fields (8)
6. The four basic design inks used to create
a full spectrum of colour on a printed page (4)

12. An alternative user interface for use with any
Windows operating system (8)
14. Test signal sent to a network destination
that is returned as received to the originator in
telephone systems (8)
15. ‘Virgin’ founder Richard------(7)
18. To transfer data to an output device for producing
copies of text or graphics (5)
19. Personal online journal that is frequently
updated and intended for general public (4)
21. Internet Protocol Television(abbr) (4)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
TQ@thinkdigit.com
Mark “TQ” in the
subject area.

A History Of Computing
Who developed the original
Apple I?

(a) Steve Jobs
(b) Steve Ballmer
(c) Steve Wozniak
(d) Steve Morris

1

Initially named Oak,
the name for Java

was decided at a local
coffee shop frequented by
many in the team, to prevent
copyright issues.

Did You
Know?

Answers

1. c
2. a
3. c
4. b
5. b

6. c
7. d
8. a
9. c
10. a

Crossword by Nitta Jaggi

Last month’s Winner
Iftekhar Shaikh 
Thane

Send in your entries to
TQ@thinkdigit.com on
or by 20th of this
month. One lucky
participant 
will win 
3ds Max 9 Bible
By Murdock
Published by

Win!

March’s Solution
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are killed, and they enjoy
the different and convoluted
ways in which their
character dies. While we
don’t want to believe that,
the elaborate set up rigged
by the Niklas Ravajas leaves
no room for ambiguity.
Thirty-six gamers were wired
up sensors while they were
doing what they did best.
Based on the readings of the
sensors, Ravajas found that
gamers cringe involuntary
when they shoot their
enemies while gloat when
they get killed. Well, not
exactly gloat but more like
breathe easier. This is
because the paper reasons
that games have become
more stressful as levels
become tougher and the
players have to fight more to
save their skin. At one point
of time this caper gets too
much to handle and
subconsciously the players
start to think, enough is
enough and run into a wall
of hot lead or lasers and get
blasted to Kingdom Come.     

In fact, some game
designers have taken the
trouble to craft death
sequences which make it
worthwhile to die. Games
like Halo 3 switch the

camera angle as you die so
it’s like an out of body
experience as you see
yourself zapped by lasers or
blasted by grenades, falling
down in slow motion. 

Admit it—you always
wanted to do that after
seeing how Tom Hanks died
in Saving Private Ryan, or how
Ken Watanabe and company
went down in that final
charge in The Last Samurai.

FOAM AND FONE TOGETHER!

Bath
Connected

Q uick: connect
anime, high-tech
gizmos, green tea

and luxurious public baths.
Well the anime part was a
dead giveaway. The Japanese,
we hear, are compulsive
gadget freaks and have a
need to keep changing their
mobile phones with a little
less frequency than they
change clothes. But it turns
out that even in that short
period of time they are
incredibly attached to their
phones. So attached that
they can’t pry those phones

off even when they have to
go bathing!

This habit has been
helped by the fact that the
Japanese don’t take showers
like the rest of us. No sir,
their idea of bathing is a
huge hall with a tub the size
of an Olympic swimming
pool. Hundreds maybe would
congregate together and
enjoy a refreshing (?) dip in
the waters while catching up
with politics. At least that’s
what used to happen during
the good old days. In the
mobile phone age everyone
and their cousin are seen
waist downwards in water
and a mobile phone stuck to
their ears. Statisticians, after
a glance at their charts and
graphs tell us that young
people do most of the
talking. They also helpfully
inform us that writing
emails and listening to music
are also hot favourites.

In case you are
wondering what happens
when water enters the
mobile phones, hold your
horses. Japanese
manufacturers had already
forseen this and sell their
phones as bath-safe,
presumably for an extra
thousand yen.
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Now this is what
classifies as starting
over from a clean

slate. This is a scenario that
all of us (yep, even
billionaires and star kids)
face at least once in our
lives. Namely, could we not
forget every thing bad that
happened to us during the
course of our sorry
existence and start over
new, like virgin plastic? Or,

a shiny new coin fresh out
from the mint.

Apparently you can, if
you have an eBay account.
Because this was what a
bloke from Down Under
planned to achieve. Ian
Usher was so heartbroken by
a messy divorce that he
could not bear to look at his
house, his friends, his job
and even his parachuting
equipment because all of
them reminded him of his
ex. He therefore decided to
sell all of them to the
highest bidder on the
Internet. Well actually only
the house, with friends and
the job thrown in as
sweetener. So if you have
about $390,000 or
thereabouts you can live in
his house, hang out at the
pub with his mates, have a
crack at his job and also
jump out of airplanes
strapped to his parachute.
He has actually settled up

with his friends and boss, so
that the hanging out part
need not start with
awkward introductions. As
for the man himself, he has
decided that he will take the
cash and go to far off lands. 

We hope he would not
have to run another such ad
seven years down the line in
some other part of the world.
Oh, and we concur with
Obelix—the Internet is crazy.

HOW MANY WAYS?

Mercy Killing

We know that
eggheads
sometimes get

crazy and pick up the
unlikeliest topics to write a
research paper. One such
paper is about the different
types of video game deaths,
and their co relation with
the rush of hormones that
bring forth a giddy rush. 

At first glance, the
conclusions seem to be
totally counter-intuitive.
Gamers like it when they

One man is the reason
you’re able to transfer
gigabytes of data over your
local network. That one
man’s name is Bob
Metcalfe, and he’s the
father of the Ethernet—the
reason you can connect to
another PC for work, and
for play. 

In March 1973,
Metcalfe, along with his
colleague David Boggs at
the Xerox Palo Alto
Research Centre (PARC),
developed the system
which we now fondly call
the LAN. The official “day
the Ethernet was born”
was May 22, 1973, though
November 11—the day it
actually worked—would be
more accurate. He was
awarded the IEEE Medal of
Honor in 1996 for the
development,
standardising and
commercialisation of
Ethernet.

Metcalfe studied
Electrical Engineering at
MIT, and followed it up
with another from MIT’s
Sloan School of
Management. 

After leaving PARC,
Metcalfe founded 3Com
Corp—specialists in
networking hardware. In
1990, he left 3Com to
become a columnist for
InfoWorld, before becoming
a venture capitalist in 2001.
Today, he’s the director of
Pop!Tech—a technology
conference he co-founded.

Bitangsha Ray, Kolkata
How he did it:
1. Create a new page in FrontPage 2003
2. Go to Insert > Web Component, choose Photo

Slideshow. Locate all your photos. Choose a
size for the enlarged photo

3. Save this page and set it as the desktop
4. Change your wallpaper by clicking the

photograph

People Who
Changed

Computing

Remote Service
Undertakers and funeral parlours are embracing the Internet
with gusto. They make money—lots of it—by webcasting funeral
services for families whose members might be scattered all over
the globe. For a fee of £75 (about Rs 5,974) you can watch a
funeral live (with 20 seconds delay) or up to 7 days later. DVD’s
of the funeral can be obtained for £50 (about Rs 3,982). 

BORNE IDENTITY

Life’s Labour Lost

Robert “Bob” M.
Metcalfe

My Desktop

Whatever 
Happened To…

I
t’s odd that an Internet
protocol should be
named after a rodent. If

you look through your
browser’s proxy settings,
you’ll find it listed right
there—where did it come
from, and where did it go?

The Gopher protocol is
supposed to be a souped-up
version of Anonymous FTP—
souped up because of the
search capabilities it
provided. It organises
information in a strict
hierarchy, and no-nonsense
text menus would ensure
that Gopher servers don’t
suffer with slow
connections. All that
promise...what happened?

It all began with greed—
the University of Minnesota
(the developers) decided
one day that it would
charge a licensing fee for
the Gopher server. “The hell
you are”, said the world,
and HTTP climbed the
popularity charts. The
protocol’s since been
released under the GPL, but
the damage’s been done. 

Moreover, HTML offered
much more flexibility and
prettiness when it came to
content, and the marketing
guys loved it. 

There are less than a
hundred Gopher servers
alive today, if you can really
call them “alive”—they’re
just...well...there. One such
site is Gopher Jewels
(gopher://home.jumpjet.info
/1%5CGopher_Jewels_2),
which is something of a “the
best of Gopher” collection.
Visit, and enjoy.

Whose Country?
Facebook is now yet another cause of angst in West Asia.
Jewish settlers in West Bank were pissed off when
Facebook auto completed their country as Palestine. After
angry protests it now offers Israel as another option, even
though West Bank is not part of Israel. Well, as they say
you can’t please all.

Asking for trouble

WIN!
Send in your entry and you could win an exciting gift by sharing an amusing picture
with a tech angle to it. The picture should have been shot by you, and should not
have been published anywhere earlier. 
E-mail your picture with “DigiPick” in the subject line, mentioning your postal
address, oonn oorr bbeeffoorree tthhee 2200tthh ooff tthhiiss mmoonntthh to digipick@thinkdigit.com. One
prize-winning picture will be published each month.

Send us your desktop  with a description of how you
made it to mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm with the subject
““MMyy DDeesskkttoopp””,, and tell us your postal address, too.

Participate in this contest
and win next month

.net Interview 
Questions
by Nagaraju B

Published by

Participate and 
win next month:
Beginning Ruby on Rails
by Steve Holzner

Published byGopher

Last month’s winner:
Rajarajan P
Kanchipuram

Corrigendum—February’s Winner:
Debiprasad Sahoo
Chennai

Robert “Bob” M. Metcalfe

n  Internet addiction should be recognised as disorder: psychiatrists n  Study says seeing the Apple logo makes people more creative n  Live Journal users threaten to stop blogging until their platform improvement demands are met n  Woman accuses RIAA of “killing dolphins”  n 
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KEEP AWAY FROM CHILDREN

Magneto!

Once in a while, we get
to read of strange
phenomena

somewhere in the world.
Sometimes it’s radio
broadcasts being heard
from dental implants,
sometimes it’s the bizarre
UFOs being spotted all over
the place. The latest to
make news is Joe Falciatano
III, a 12-year-old boy from
Pulaski, New York.
Apparently, when he just
touches the computers he
comes in contact with, they
come to a standstill. The boy
has become popular as
“Magneto Man” and has
found that every system he
touches goes out of control.
He was later suggested by
his teacher to wear an anti-
static belt at all times. His
teachers are convinced that
he has a static charge
problem. According to
Marie Yerdon, a teacher at
Lura Sharp Elementary
school in Pulaski, NY,
whenever other students
use the computers, they
work perfectly fine. But as
soon as Joe steps into the

scene, weird things happen.
In fact, this static problem
nearly failed him in his
fifth-grade social studies
class last year because his
PowerPoint presentation
was affected. While other
students in the lab
continued with their
presentations, Joe and his
teacher Yerdon spent time
troubleshooting his PC. As
Yerdon describes it, Joe
would be in Microsoft
Word, and suddenly be

unable to change the font. If
he highlights a particular
text, he may not be able to
un-highlight it. He even gets
upper case text without
using the shift key! Worse
still, he would save
something, but then not be
able to recover it! Finally,
Yerdon put a grounding pad
under the computer, which
she connected to the anti-
static wrist strap that Joe
was wearing. The teacher
said that the school has

purchased the equipment to
protect students with
pacemakers from electronic
surges. However, in Joe’s
case, they had to protect the
computer from him. Joe
also faced similar problems
with his Xbox at home. His
parents have now replaced
it with the wireless Xbox
360, which he enjoys as
long as he is across the
room away from the
gaming console. Some
magnetic personality, Joe! 

Shattered Realities
We have a large container (50 litres, to be
precise) of liquid nitrogen in our offices.
No, this isn’t the twilight zone—it didn’t
pop out of nowhere. There is a purpose to
this. If only we knew what...

It’s summer, and a rather
uncomfortable one, at that. Perhaps this
blessed fluid is here to make up for our
perpetually malfunctioning air-
conditioning system. Then again, perhaps
it’s for our entertainment.

It was love at first sight. The minute
Badri (aka Badjag, aka SKOAR! Overlord)
saw the tank, his face lit up. He vanished
for a second, came back with his
lunchbox, and poured the nitrogen into it:
“Let’s see what happens.”

A few minutes later, we
find Nimish (aka FatBeing)

entering the container’s vicinity, all alight
with a satanic grin that could bode only
evil. Many experiments followed, and for
those of you who aren’t fortunate enough
to encounter liquid nitrogen at such
proximity, we present our findings:

1. Frozen roses shatter—like in the
movies and the Discovery channel shows. 

2. Frozen fruit is perfectly edible after
un-freezing. Nutritional value unknown.

3. Frozen cloth crunches a bit, but
returns to old state rather quick.

4. Liquid nitrogen makes for an
effective, if expensive, floor cleaner.

5. Sanket does not approve of shattered
flowers in the test centre. 

If you have any ideas, or items / relatives
you’d like shattered, do write in—offer

valid only while stocks last!

Marshall Kirkpatrick
http://tinyurl.com/3apoyg
http://www.readwriteweb.com/archives/safari_on_win
dows_scam.php
Apple Takes the Spyware-Style Low Road, Pushing
Safari on Windows
Debate is raging over the news that Steve Jobs has
made good on his summertime promise and is now
sending Apple’s browser Safari along for the ride when
Windows users are prompted to update iTunes or
Quicktime. Users can deselect the additional software
download, but let’s be realistic—there must be millions
of people unwittingly downloading Safari onto their
computers right now....How many ways can you think of
that Apple could grow its market share through
innovation, instead of lowdown tactics like this?

Nate Anderson
http://tinyurl.com/2ah4d9
http://arstechnica.com/articles/culture/nbc-media-
moguls.ars
P2P is for piracy... and we’re going to use it
Apparently, media moguls do not breakfast on a diet of
puppies and children, as some consumers seem to
think; bagels, toast, and oatmeal are the order of the
day. George Kliavkoff, NBC’s first “Chief Digital Officer,”
has also joined us to talk policy. 

“I’m curious if you necessarily equate peer-to-peer
protocols like BitTorrent with piracy?” I ask after the
orange juice arrives...

Ryan Block
http://tinyurl.com/37q46h
http://www.engadget.com/2008/03/26/motorola-
insider-tells-all-about-the-fall-of-a-technology-icon/
Motorola insider tells all about the fall of a
technology icon
Like many (ourselves included), over the years Numair
has become increasingly disenfranchised with the
company’s direction—enough so that he compelled us
to publish his letter to Motorola, its board of directors,
and MOT investors everywhere regarding the
company’s egregious missteps and mismanagement.
In researching the myriad claims raised in this letter—
which we believe to be true—we also discovered a
number of other unsettling things about Motorola’s
corporate past in the last five years, such as certain
gross corporate excesses demanded by Zander.

There’s no doubt in our minds that Motorola is in
dire straits. But today’s news of the company’s broken-
off mobile division only serves to cement the fact that
the company no longer knows how to conduct its core
consumer business, and is squandering time and money
as it flounders in a market that long since passed it by.

Google’s cold
shoulder towards
Microsoft’s proposal
to buyout Yahoo!, a
MacBook Air user’s
experiences and
Torrent sites being
shut by media hype
are part of this
month’s blog watch

MAIL ORDER ADVICE
Bride taken for a ride

The mail order bride
phenomenon is nothing

new. Most of these brides
are selected based on
Internet ads and they come
to developed countries like
Canada from countries in
Asia and Africa. These
women don’t often get what
they were promised and
they are quite often
unaware of their rights.
They are duped to live in
remote villages, and maybe
even pushed into
prostitution.

If these brides blame the
Internet for getting them
into this mess, they could

also look at the Internet for
succour. A Web site,
www.lawforforeign brides.ca
has been launched for these
women by an organisation
devoted to helping such
people.  There is nothing
comic about this Web site
which features information
useful for new immigrants.
However, we are sure you
would see the irony in the
whole situation. Of course
there are a number of
similar parallels: you install
something dumb from the
Internet which messes up
your system and where do
you turn for help ? Why,
another part of the Internet,
of course.

CYBER CANINES
It’s a dog’s blog

Dogs have joined humans in
blogging. At maxthe

goldenretriever.com, a blog
chronicles the life of a golden
retriever named Max. It’s
written in first person and talks
of life from the point of view of
a dog. Apparently Max is
addicted to popcorn, talks
about experiences with vets
and annoyances with dry
tennis balls.

His favourite channels are
Animal Planet (expected) and
Fox News (unexpected). His
fave treat is ice cubes and his
real name is Sir Maxwell
Jones (a noble dog?). He is
also allergic to cats.

OOPS! WRONG WAY!

GPS-enabled
Idiots

With GPS navigation
systems making
their mark among

the roadies, also comes
their way of getting into the
limelight. Well, for good or
bad depends on the eye of
the beholder! These days,
people in urban areas use
GPS devices to guide
themselves across their
routes. However, at times,
lessons are learnt the hard
way—this is what Norman
Sussman of New Mexico
found out. Sussman asked
his GPS unit for alternate
directions after driving
continually in heavy traffic.

Delighted on getting an
alternate route, he ascended
up a winding mountain
road, hoping to join the
interstate at another point.
After nearly half an hour of
turnings, Sussman came to
a halt. He had just reached
a 200-foot cliff! 

Well, this is certainly not
an isolated case, as
commercials these days have
started airing incidences of
errors arising out of the use
of GPS devices. In a popular

commercial for Nationwide
Insurance, a man is seen
crashing his car straight into
a restaurant after following
navigational instructions
from his GPS device. Steve
Schreibman, the firm’s Vice
President of advertising says
the idea came from his own
weird experiences with GPS.
In a recent episode of the
popular sitcom The Office, the
character Michael drives
straight into a lake, again
due to faulty GPS navigation.
Driving in the wrong
direction and then realising
it later would surely result
in loads of swearing!

TALK STRAIGHT

Spin
Detector

Aprofessor from
Queen’s University has
developed software

that detects the political
hoopla that candidates add
into their speeches. David
Skillicorn from the School of
Computing at Queen’s has
some interesting findings
from the election campaigns
of the United States
Presidential candidates. This
software analyses the
political speeches that the
candidates deliver in each

round of campaigning. The
methodology used by
Skillicorn involves
significant data mining and
mathematical concepts. Over
weeks of analyses, the
software has found that John
McCain emerges as the most
honest in his speech. Barack
Obama twists the most and
Hillary Clinton comes in
between the two. According
to Skillicorn, there is a
significant difference in the
usage of terms like “we” and
“I” in public speech. He
added that people who tend
to use “I” more often tend to
be more responsible and
honest in their outlook as
compared to those who use
“we”. In general thought, it
is quite unclear who the
“we” is composed of! In
addition, the software also
uses terms like “but” and
“or” in its calculation. This
program uses the frequency
of 86 key words to calculate a
“spin” score for each speech.
The higher the score, the
lesser is the spin in the
speech. Accordingly, McCain
scored a healthy 2, Hillary a
0.6 and Obama was trailing
with -1.3. We wonder what
this software would
conclude if tried out in
India. Our netas would
definitely score very high.
Just which side of the scale is
quite uncertain! Any takes?
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P2P
Torrent: This is a small meta-
data file and ends with .tor-
rent. This torrent file con-
tains all the information
about those files (movies,
music, etc) that you so
eagerly want to download.
When you try to initiate a
P2P download, this file is
sent to your computer.

Peer: A peer is another user
just like you on the network
or the Internet, who is inter-
ested in downloading stuff. A
peer doesn’t have the com-
plete file on his/her system.

Seed: As the word goes, a
seed is the originator of the
file. The seed has the com-
plete file on his/her system.
There can be multiple seeds
for the same file on the
Internet, which is what makes
P2P sharing so useful.

Swarm: A swarm is the whole
bunch of people associated with
a particular file. This includes
the source of the file (or seed)
and the peers downloading the
file (others like you).

Tracker: The tracker is the
server of the torrent site that
monitors (or tracks) the
progress of your download.
When you initialise the agent,
all it does is it communicates
with the tracker and acquires
a list of peers to contact. It
tells you of the progress in
file transfer.

DHT: This is an abbreviation for
Distributed Hash Table. The
tracker uses this table to com-
pile a list of peers that host a
particular file.

Usage: Last week, I used P2P
file sharing to get that copy of
Titanic. I got the torrent for it
immediately. The tracker
referred to the DHT and
showed me 14 seeds and 50
peers. The whole swarm has
grown tremendously this week.

Wild Wild Web

n  MS wipes out signatures from an Xbox after repairing it, replaces with Bill Gates’ signature  n  Fake Craigslist giveaway causes man to lose All n  Austrian monks sign record deal with Universal Music after hit YouTube video  n New camera “sees” through clothing (for weapons)

Escape April_08.qxp  5/13/2008  12:13 PM  Page 114



DIGIT APRIL 2008 121DIGIT APRIL 2008

Suggested Reading
I am a BCA second year student. I
started to read Digit when my first year
C language teacher suggested that we
do so in order to keep ourselves updated
about IT, and to get a wider view of the
technology industry. I must admit that I
am not a regular reader, but I do buy it
when I feel I am losing touch with
technology, or when I feel the need to
learn about emerging technologies.  

I want to suggest that you provide
more full-version software in your
magazine. Your competitor Chip does
this, and although I think the software
on your discs are better and more
varied, that is the only place that they
are beating you. Still, I attach more
importance to the magazine, and in this
regard, you are miles ahead. So I urge
you to provide at least 4 or 5 full version
software, across your DVD categories,
and fix this tiny chink in your armour.

Honey Chawla

Wow. It’s so nice to hear that we’re being
recommended by teachers, who we have a
great deal of respect for. Please thank your
teacher on our behalf, for recommending us to
the entire class!

Thanks for not mincing your words, we
appreciate your suggestion, and we’ll try and
give you no reason for complaint from here-
on. We do however give preference to open
source and freeware, and you will always find
an abundance of such software on our DVD/CD
every month.

Team Digit

11 On 10
I love your magazine, and anxiously
wait for it in the beginning of every
month. I have already recommended it
to everyone in my school, and hopefully
you will get a few dozen more regular
readers. Please provide the Starry Night
Backyard in your CD/DVD, and also
some articles on MS-Access, JAVA and
C++, as it is part of our school
curriculum. I love the Fast Track, but it
would be a lot better if it were in colour.
As for the magazine, 11 on 10!

Rishav Mukherjee

Thanks for playing your part in popularising
Digit in your school. We will try and make sure
all your wishes are fulfilled over the coming
months. As for the Fast Track in colour, a lot of
people in the polls and surveys we conducted
told us to leave it the way it is. Still, that’s not

Inbox

Thanks For Listening
Though I am new to the Digit world, I
must tell you that it’s been a fantastic
beginning. I love the concept of giving
out software along with each issue of
your magazine. I have virtually become
a tech geek amongst my friends, all
thanks to Digit. And I like the fact that
you actually give your readers’ opinions
the highest priority. It’s wonderful.

However, there is one thing that I
would like you to add sooner. I don’t
know whether it has already been
published or not, but I want to know
about the audio/video formats, and
what players are required to play them,
and what goes into creating a format? I
once again congratulate Team Digit for
the wonderful progress. Great Going!

Ankush Gupta
New Delhi

Thank you for your appreciation, and believe
us, it means a lot when readers like yourself
notice and write in to us. Yes we do give our
readers’ opinions the highest priority, and
honestly, it would be quite idiotic if we didn’t!
After all, it’s you our readers who have made
this magazine what it is, and will help us
consistently improve and innovate, so that we
can scale new heights.

As for your query about audio and video
formats, we have done a Know More About as
well as Fast Tracks to Digital Audio, and
Digital Video. You will find the PDF copies of
such articles and Fast Track books in our
December 2007 DVDs.

As for what goes into creating a format,
it’s not something we can explain here, or
pehaps even in an entire Fast Track! It takes
years of research, coding and tonnes of
money to come up with codecs, containers,
colour systems, and more to build a new
audio/video format.

Team Digit

Fast Track In Demand
I recently discovered Digit, and I soon
realised that the Fast Track was very
handy and helpful for a computer
novice like me. I was wondering
whether copies of some of the old issues
of Fast Track (e.g., PowerPoint, Web
Design, Photoshop, Digital Photography,
Virus Proof Your PC, etc.) are still
available (in print, or as PDFs). If they
are still available, please let me know
how I can get my hands on them.

Hemanta Sarkar
Ranchi 

Almost every special issue of Digit carries the
PDF versions of previous magazines. In fact, in
our December 2007 issue, we included PDFs of
every single Digit issue and Fast track that was
made before December 2007. Unfortunately, we
cannot make you a CD, because if we did, we’d
probably be inundated with thousands of
requests to do the same for other readers. We
promise to include all the previous issues in PDF
format in upcoming special issues, and perhaps
we can work out something to satiate the
thousands of requests we get for a “Fast Track
Compendium”. For now, please wait for the June
2008 issue, and keep your fingers crossed.

Team Digit

I Love You Digit
This is my first letter to you, and I must
say I am proud to be a reader of your
beautiful magazine! I love Digit more
than the Kohinoor diamond, and the
words printed in it are like pearls spread
over velvet. Your review sections and the
comparisons areas are the best among
all the other magazines. I love the Take A
Crack and the other competitions,
amongst other things. Still, since you
seem to value suggestions from us, I
would like to make a few: 

1. Improve the packaging, it’s way
too big and bulky for stands and
horrible for subscribers

2. Increase the number of articles
that teach us the basics of technology

I also want to make my brother
tech-savvy, how do I do that? Anyway,
thanks for everything, and keep up the
good work.

Rohit Shivnani

We’ll try and change the packaging, but it’s not
as simple as we all would wish. Still, we are
always working to improve and innovate with
the look, feel and content of Digit, and you
should be pleasantly surprised soon enough.

We also get a lot of requests to increase
the number of articles and pages, and reduce
the number of ads, etc. We will try our best to
give you as much as possible, but with paper
and printing costs skyrocketing, and inflation
to boot, it’s always increasingly difficult for all
magazines to print an added number of pages,
without passing on the costs to the readers.
Still, you can rest assured that we will always
give our all to ensure that you get the most
from Digit for your hard earned money.

As for your brother, why not ask him to
read Digit, and also register for our forum at
www.thinkdigit.com/forum, where he might
find a lot of similar-minded people, and make
a few friends, whilst making him tech-savvy.

Team Digit

Aladdin's Lamp
I am a fan of this superb magazine since
July 2006, and this is the first time I’m
writing to you. One of my good friends
told me about this magazine, and I was
really blown away by it. After reading the
March edition, I couldn’t resist writing to
congratulate you guys. Digit has become
my one-stop for all Tech-queries. It is like
Aladdin's Lamp for me—make a wish and
it will be fulfilled. The two things I love
most about Digit is that it covers all
aspects of technology, all the people who
work directly or indirectly with
technology, and there’s always
something that everyone will find useful.
How do you do it? 

However, I still have just one
complaint: You keep everyone but
software developers happy. The CD and
DVD contain a lot of useful things for
developers, but you need to show us
how to use those wonderful software. I
know it is hard for you to try and please
everyone, but we developers would
settle for a small section every month
dedicated to us. If you feel that the
section will not be popular in the
magazine, why not provide it to us on
the DVD in the PDF format. That way
you can keep us happy and also not
waste space in the magazine. I hope you
will consider my request. Keep up the
good job. 

Anurag Srivastava

You ask us how we manage to give our readers
what they want before they ask for it? We
would like to know how our readers always
seem to ask for things we’re already working
on? Look for more developer-friendly content
on the DVD in the upcoming issues!

Team Digit

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, KPT House, Plot 41/13, Sector 30, 
Vashi, Navi Mumbai 400 703

Digit will publish the best letters on these pages. Letters may be edited for clarity.
PPlleeaassee iinncclluuddee yyoouurr ccoommpplleettee aaddddrreessss iinn aallll ccoommmmuunniiccaattiioonn.. 

For subscription queries 
send an e-mail to help@thinkdigit.com

120

a definitive “No!”, and we’re doing our
market research. You can rest assured that
you will see some pleasant changes in Digit,
ThinkDigit.com, the Fast Track, as well as
the DVD/CD in the months to come.

Team Digit

You Rock!
You guys rock the country with your
software, and I like the Fast Track
series a lot. I have a few suggestions:

1) Please add more pages in the
magazine. I am not bothered about
the advertisements as they are your
lifeline.

2) The pages of the Fast Track
series can be more colourful and of
better quality.

3) Please do justice for the caption
“Your Technology Navigator” by
introducing free gadgets for
subscription offers, instead of free
issues. Personally, I did not subscribe
Digit for this reason.

4) More gaming reviews and news,
a look into the new games for the
hardcore gamers (like me!) with the
required minimum and
recommended configurations.

Last but not least, I am supporting
your anti-piracy campaign, but the
bottom-line is that software
developers need to revise prices for
India.

Finally, you rock man! Keep up
the good work!

A. Vigneshwar
Chennai

Wow, that’s a lot of points you make. We
have already answered your first two points
in other letters, and they seem to be
popular suggestions. As for the subscription
offers, we will try and add more of them as
quickly as possible. Though you should
know that the most popular offers involve
an increased number of magazines! Seems
people would rather have a longer
subscription than gadgets.

As for game reviews, you have to
remember that Digit is, and never will be,
focused on just one topic. We try our best to
cover all aspects of technology, and so it’s
only natural that we can provide you with no
more than three or four game reviews every
month. Still, we understand the need for
gamers to satiate their desires, and that’s
why we have SKOAR!, India’s largest selling
gaming magazine. You can visit them at
www.skoar.com to find out how to subscribe.

Team Digit

Age No Bar
You have been my
technology navigator for
the past 2 years. I am a
student, 13 years old, and
some tell me, too young to be
reading Digit. Still, I enjoy reading
your magazine, and I go through all the
content on your CD and DVD as well. The
Fast Track series is my favourite, and is
fantastic. Keep up the good work. I also
have a few suggestions to make.

1. You could make Fast Track a
standalone book with colour pictures and
better paper. You could also include more
content. This would be good for students
like me who like the Fast Track a lot. That
way we could have the option of buying
only the Fast Track if we had less money
in a particular month.

2. You need to improve your customer
care. Some of my December 2007 DVDs
were damaged. I sent a mail to
help@thinkdigit.com, and still have not
received a response. 

3. Please increase the amount of
freeware on the discs. 

4. Although I realise the importance of
Ads, I still feel there are more Ads than
necessary.

5. You need more/better copy editors,
because over the past 1 year, the amount
of errors and spelling mistakes has
increased.

Still, don’t get me wrong. Whatever
happens, your mag is THE best. All the
other magazines I have read pale in
comparison. Due to Digit I have become
tech-savvy, and have even managed to
make my parents tech savvy by making
them read it. For that, I thank you Digit.

Shishir Upadhya

Some interesting suggestions indeed Shishir.
Digit readers have always been varied, and as
far as we know, the youngest Digit reader who
wrote to us was just 8 years old; the eldest who
has contacted us is 84 years old. So tell the
people who think you’re too young that
technology has no age or gender boundaries!

We get so many suggestions for the Fast
Track, that honestly, we have way too many
options at the moment. Rest assured that we will
evaluate them all and have some interesting new
offers for you soon enough. As for the other
complaints / suggestions, the Help Desk
promises to look into your case immediately and
the copy editors promise to try their best not to
disappoint you again.

Team Digit
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of the
Month
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People And Events That Grabbed The Headlines—For Better Or For Worse

Couples break up all the
time. Some use letters,
some do so by phone while

others use SMS. But Jimmy Wales
didn’t use any of these ordinary
methods. Rather, in the interests
of transparency he decided to
dump his girlfriend by announc-
ing it first on Wikipedia!

Wales, who styles himself
the “benevolent dictator” and
“spiritual leader” of Wikipedia,
the free encyclopaedia that any-
one can edit has decided to sever
all ties with Rachel Marsden, a
conservative journalist. This was
the ending of a pretty knotty
relationship, whose aftermath
caused a lot of raised eyebrows
all over the blogosphere.

Rachel Marsden was a
Canadian media personality
who didn’t like her biography on
Wikipedia. It apparently harped
too much on some unpleasant
incidents of her past life which
she didn’t want people to know.
Being a go-getter she went for
the source, petitioning the
benevolent dictator to correct
the “mistakes”. Wales put in a
suggestion to his editing team
and they carried out his orders.
This led to quite a few dates and
everything seemed hunky dory.
However, something—which we
will never know—came between
the two lovebirds, and this led to
a pretty ugly spat, with the lady
leaking their salacious chat
records to a gossip blog. The lady
seems so determined to remove
any association with Wales that
she put his clothes—which he
had left behind in her apart-
ment—up for sale on eBay. 

While the entries about
their plans for the night might
make interesting reading what’s
troubling to many is how
Wikipedia has been used for fur-
thering the interests of a person,
or a circle. For instance, Wales
attempted to bill $650 (about 

Rs 27,000) for two bottles of wine
as expenses to the Wikimedia
foundation. That money is actu-
ally coming from the donations
for more server space and more
features. There are many other
indiscretions which are probably
okay if an office worker had com-
mitted them, but definitely not
okay when you are virtually in
charge of one of the most visited
Web sites on the Internet.
Somebody should tell him to
grow up. Oh, and in case you did-
n’t get it, take everything on
Wikipedia with a pinch of salt.

Mark Cuban is a man who is the owner of
an online media company and also the
owner of a basketball team. He is pretty

Net savvy and he knows what a blog is. So eye-

brows were raised when he banned all blogs
from publishing inside scoops from the locker
room in response to blistering comments about
the performance of his team in a blog. Which
means that no more tidbits and first hand infor-
mation: everything had to be picked off from the
traditional media.

After getting plastered all over the Internet
for a decision that at best can be described as
childish, Cuban decided that he hadn’t done
enough to prevent the spread of misinformation
by new age media. In a next salvo he pontificat-
ed that newspapers should stop calling their
blogs as blogs. He seems to think that blogs are
associated with hasty and inaccurate reporting
and newspapers ought to know better than to
encourage this brand of journalism. In fact he
sees a branding opportunity and says that blog-
ging should be renamed as Real Time Reporting,
probably because he assumes all blogs are hur-
riedly written without the cross checking of
facts which traditional newspaper reporters do.
While many blogs out there are lousy and slap-
dash there are an equal number of newspaper
articles which are written minutes before going
to press. We only assume that Cuban did not
have the grace enough to admit he was wrong
the first time and tried to play with words and
semantics to fool people.

Sorry Mark, you just have to admit you are
wrong and stop being obnoxious. Is it that hard?

Everyone agrees that
despite the many short-
comings of the Internet,

there are plenty of things which
you can do online. Among the
things that are counted as good
is e-voting where you needn’t
queue up in a polling booth to
exercise your democratic rights.
You get the vote even if it’s rain-
ing, democracy wins and every
one is happy.

Except for a former Polish
prime minister. Jaroslaw
Kaczynski apparently thinks
that the Internet is Satan’s
workshop and people should
not be allowed to vote online. In
fact he seemed to be worried
about the youth population
and felt that predominance of
porn, along with beer would
cloud their judgement and they
would mistakenly hit the
wrong button. He thinks that
manipulating people online is
easier than, say, in a public
meeting where you run the risk
of getting rotten things thrown
at your face. 

Ironically these remarks
were published not in a news-
paper or reported in a TV show

but in a Web page. Besides it’s
not that Kaczynski, is a techno-
phobe. In December he had set
up a video blog so that he could
connect with people. So what
could be made of the latest
bout of Internet bashing?
Maybe, like other politicians, he
is just playing to the gallery,
which in this case consists of a
cult which has sworn off the
Internet and whose votes he is
coveting. Crazier things have
happened in politics.

Internet-bashing

Out In The Open
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